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CrystalClear User’s Manual (Abridged) 
 

Or 
What To Do After You’ve Started Your Data Collection 

 
INDEX 1.  Use the reciprocal space lattice spacing ruler to see what the maximum "cell" 

length is...use 1.5-2x for max.  Remember that this is for the primitive cell.  
  

FIND, INDEX, REFINE 2. Find and index off one image, then find and refine off several images  throughout 
phi space. 

  

REFINE 3. Although refinement from a single image is okay, sometimes better results can be 
obtained with one of the following strategies for indexing and refining:  two images 
90 degrees apart;  a 5 to 10 degree wedge of data;  2 or 3 images at three different 
areas of space 

  

REFINE, INTEGRATION 4.  RMS values  on a few images should be close to zero (values around a few pixels 
and half the image rotation width are to be expected when the mosaicity is not well 
known).  During integration, 3-dimensional data should lead to better determinations 
of crystal parameters and the RMS values should drop.  The RMS for mm should be 
about 1/10 to 1/5 the spot width; the RMS on phi depends on the image width and 
mosaicity, in general being between 1/2 the image width and 1/2 the true mosaicity.  
With 3-dimensional data, RMS degree should be 1/10 to 1/5 the spot size in phi. 

  

REFINE 5.   If the refinement does not use most of the spots found in the Find step, it is 
usually because too many peaks are excluded (the resolution limits are too restrictive 
or the sigma cutoff is too high); rejecting criteria are too strict (x and y max 
difference too low, phi too small); or there is an incorrect unit cell.  Split crystals 
should have rejected spots not matching the predicted positions.  Prediction of spot 
positions should confirm or deny the choice of unit cell. 

  

REFINE, INTEGRATION 6.  By default, any parameters turned on during refinement at the refine step will be 
used in the refinement during integration.  It is possible, and likely, that the 
mosaicity is turned on during the refinement of the cell after indexing, but it is not 
refined--this is because you may not have enough rocking curves determined from 
contiguous images to do a proper calculation of the mosaicity (not necessary, but 
may be conducted at this step). 

  

INTEGRATION 7.  Look in the find log file for the average peaks size and calculate 6 to 10 times 
this size as a good starting integration box size.  Then confirm that there is not any 
critical overlap of adjacent spots using a test prediction and changing the size of the 
circle.  By increasing/decreasing the circle size using the set reflection size button, 
see that a circle includes no more than half of an adjacent reflection (maximum 
size).  The minimum size of the box cannot be smaller than including all of the area 
of the peak and considering all regions of the image  (although setting it this small is 
not recommended). 

  

INTEGRATION 8.  Images per batch is the number of images used in obtaining a refinement and 
scaling "batch" of reflections--10 or more is typical for small molecule data sets, 
while 2 to 4 may be used for macromolecular crystals.  This is to allow for enough 
reflections to be available for proper treatment of refinement and scaling...too few 
will result in poor refinement or refinement crashing, too many will increase 
memory use beyond installed resources (causing swapping and slowing the 
calculation). 

  

INTEGRATION 9.  Padding is the number of images before and after the extent of the reflection 
(including calculated center and mosaicity) in which some of the background of a 
particular reflection is determined.  In wide slice data, a value of zero may be 
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particular reflection is determined.  In wide slice data, a value of zero may be 
appropriate, otherwise values of one or two are typical. 

  

INTEGRATION 10.  At the start of integration, always have the processing updates turned on and 
carefully observe the agreement between the predicted and observed spot positions. 

  

INTEGRATION 11.  During integration, refinement shifts  for each parameter should be zero.  
Otherwise you may have crystal movement (sliding, precession, mount instability, 
etc), too small a batch, or a wrong cell refinement altogether. 

  

INTEGRATION 12.  Check to see that the profile fitting correlations are good in the integration log 
file...both in number and in intensity.  Reflections of 9 sigma and higher should have 
greater than 90% correlation, but may show lower correlation! 

  

SCALING 13.  When scaling the data, absorption correction should be run in the every 
attempt. The new algorithm needs fresh information from the absorption calculation.  
The calculation is relatively fast. 

  

SCALING 14.  A good subsequent approximation for the Weight Addend is the Rmerge of 
your current result.  Consider using Auto-Rmerge. 

  

SCALING 15.  A good subsequent approximation for the Weight Multiplier is  the square root 
of the Chi Square multiplied by the current Weight Multiplier.  Consider using 
Auto-Intelligent. 
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CrystalClear User’s Manual (Abridged) 
 

Or 
What To Do After You’ve Started Your Data Collection 

 
 
ASSIGN UNIT CELL: 
 
1. FINDS SPOTS – Select the images on which you want to find spots.  Adjust sigma higher or lower 
depending on the crystal.  Typically the 4 screen images are enough to get a good unit cell, again adjust the number 
of images based on the crystal.  For poorly diffracting crystals it is not unusual to find on all images of the first scan. 
 
 ADVANCED – Lower peak filter to increase the number of spots found.   Increase the filter to find any 
large size spots.  The box size can be set to 0 x 0, if necessary, which lets the program pick the best box size, so do 
not be afraid to try this and work from there. 
 
2. INDEX – You should always check the USER CHOOSES SOLUTION.  This allows you to choose an 
appropriate Laue group. 
 
 ADVANCED – Gives some brute force options.  Most are self-explanatory.  Setting the Max-Residual to 
100 will cause indexing to show all Laue classes.  1D-FFT, without difference vectors is currently the preferred 
method for unit-cell determination. 
 
3. REFINE – A typical starting point is “All”, which refines all parameters except the wavelength and is 
currently the best option.  Resolution can be set here if you wish, this can be used to eliminate outliers at high 
resolution, etc.  I/σ can be set to the value you used to find spots.  RMS Residuals should be low (ie. Less than 0.5 
mm and 0.3 degrees).  You want to have most of your reflections accepted.  Not using a large percentage of your 
reflections may indicate problems with the unit-cell, split or twinned crystal, etc. 
 
 ADVANCED – Not too much to do here.  You can edit your refinement procedure and save it to your user 
profile.  Recommended only for the experienced user or the site administrator. 
 
4. PREDICT – The most powerful tool in the assign unit cell menu for determining crystal quality and 
confirming the unit cell.  I recommend using this very early on if you have any questions about the crystal’s quality. 
 

1. Choose about 20 images to predict on and set the mosaicity to 1 (or so).  Run. 
2. After the first image is displayed, choose the overlay option on the image toolbar (labeled MAX, to the 

right of the right arrow). 
a. At the bottom of the pop-up menu set the sequence start number to the number of the first image 

you used in the predict spots menu.  Set the number of images to equal the number of images you 
predicted.  Run.  A new image will be displayed that has all the images on top of each other. 

b. Set your reflection circle size (the button with the bubbles) to a small number so that you can see 
where the predicted reflection is. 

c. Adjust you mosaicity if it looks like you have too many or too few reflections and re-run predict. 
d. Look very closely and make sure that the prediction matches the reflections you see.  If it does not, 

there is a good chance the unit cell is wrong or there are problems with the crystal, as mentioned 
above in the REFINE section. 
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5. INTEGRATE REFLECTIONS 
 
1. Resolution: Set maximum and minimum resolution to 0, the program will automatically set the 

resolution to include the entire image window during integration. 
2. Box: Box sizes should be set to a similar size as was used for FIND SPOTS, if you set it to 0, it will 

automatically be set to 6X the size of the spots found in the FIND SPOTS process. 
3. The rest can be left at the defaults values from installation. 

 
6. .SCALE AND AVERAGE 

 
 Main: 

1. Reflection list: Select dtintegrate.ref. 
2. Exclude Sigma:  The default value of 3 will exclude reflections which have about a 99% chance of 

being an outlier. 
3. Rejection Sigma:  The default value of 10 will normally suffice, however it can be raised to any value 

if you are rejecting a large number of reflections. 
4. Algorithms: 

a. Batch scaling uses simple batch scaling to model all incident beam absorption, decay, etc. 
b. B-factor applies temperature dependent scale factors to the data. 
c. Absorption correction:  Currently 3 methods exist, Spherical 4,3 tends to apply a better correction 

to small molecule data the others.  If it fails, choose another method and see if it succeeds.  If none 
work, your sample may not have required an absorption correction. 

5. Error Model:  This is probably the hardest part to get down to a simple explanation.  There is no 
“canned” method for doing this. 
a. Weight Multiplier:  This multiplies the standard deviations by the value set. 
b. Weight Addend:  This adds a systematic value to the standard deviations. 

       The idea here is to adjust these parameters to get a relatively flat χ2 value between 0.8 and 1.2 
over all the resolution regions of data.  Experience has shown that the Weight Multiplier is 
specifically dependent on the instrument.  Typically between 2 and 3.  The Weight Addend can 
normally be set to the R-merge of the data. 
 

Advanced: 
1. Absorption Correction Outlier Sigma:  The default value of 125 tends to suffice.  In the event that the 

absorption correction fails, this number can be raised for very strong absorbers to see if it allows a 
successful absorption correction. 

2. Resolution:  These can be left at 0 unless you want to cut off poor data at high angles. 
3. Scaling Constraints  Only available when absorption is not checked.  The default values should suffice. 
4. Optional Output:  Uncorrected, Unaveraged Reflections with Correction Factors should be selected, 

with an output file name of f2plus.dat, to be imported into teXsan or CrystalStructure.  When an 
absorption correction is not applied or fails, the Corrected, Unaveraged Reflections should be selected, 
with an output file name of f2.dat and the Output hkl, I, SigI, No Header box checked, to be imported 
into teXsan or CrystalStructure.   
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1 About this Manual 
 

What You Should Know  
This manual is a user guide for CrystalClear, the instrument control and processing software that is a 
companion to the Rigaku R-AXIS and Rigaku Mercury and Jupiter CCD Automated X-ray Imaging 
Systems.  

To effectively use this software, you should be familiar with: 

• Your detector equipment and how it operates 

• Crystallography techniques and terminology 

• Windows NT or Windows 95/98 

 

How This Manual Is Organized  
The manual includes the following sections: 

About this Manual: This is the section you are reading now. It gives an overview of this manual.  

Installation: This section details how to install the CrystalClear software. 

Introduction to CrystalClear: This section gives an overview of CrystalClear's user interface. 

Running CrystalClear for the First Time : This section discusses how to log in to CrystalClear for the 
first time, and how to set up your initial project and sample.  

Common CrytalClear Tasks: This section gives brief overviews of the common scenarios of collecting 
data and processing data.   

Data Collection and Processing: This section covers the process of collecting and processing data in 
more detail.  

Command Reference:  This section gives information about peripheral features of CrystalClear such as 
managing projects and samples, displaying the processing state, etc.  

Additional Processing:  This section covers how to create macros, new collection schedules, and merge 
reflections. 

Images: This section gives an overview of the Image window and how to use it.  

Appendix: The Appendix includes information about CrystalClear's directory structure, administrative 
functions, and log file information. It also includes a troubleshooting section that lists common 
problems you may encounter in CrystalClear, and how to correct them.  

 

 Notation Conventions   
Throughout this manual, we will use consistent notation conventions:  

• Product and program names are set in Initial Cap Italic type. 

• Directory names and filenames are set in monospace type.  



About This Manual 

 
Page 12  CrystalClear User Manual 

• Code listings are set in monospace type.  

• Menu options, dialog options and field names are set in bold.  

• Instructions for choosing menu items will include a > between items.  

For example: Choose File > New. 

• Keystrokes are displayed in parentheses. For example: Press (Enter).  

• A plus sign between keys indicates that the keys should be pressed at the same time. 

  For example: Press (Ctrl+C) to copy the selected text. 

• Instructions for using the mouse to select dialog buttons or toolbar buttons, or to select items in a 
graphical display will read:   

 Click the Start button. 

  or 

 Click and drag the mouse pointer to select the desired spot.  

 

Reflection Lists  
CrystalClear reflections lists are saved as ASCII files.  The first line consists of 3 fields telling the number 
of integer, float and string values for each reflection.  The next lines are the field labels as character 
strings for each integer, float or string value: the first three fields are H, K, and L (integers); the next two 
are intensity and sigma (floats); the rest are optional.  Field labels cannot contain white spaces (spaces, 
tabs, etc.) and should begin with n (for integer), f (for float), or s (for string).  After the field labels are 
listed the reflections, one per line in free format. 

For example, the first lines of a reflection file follows: 

4 7 1 
nH 
nK 
nL 
fIntensity 
fSigmaI 
fObs_rot_mid 
fObs_rot_width 
fResolution 
fLPfactor 
fCorrelation 
sBatch 
   22   -1   16 3566.77 121.549 … 1001 
 

4 integers, 7 floats, 1 string 
 
3 integer field labels 
 
 
 
 
7 float field labels 
 
 
 
1 string label 
actual reflection file with 3 integers, 7 
floats (2 shown), and one string 
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CrystalClear/d*TREK Coordinate System 
 
The d*TREK default laboratory coordinate system shown in the next figure is defined as follows: 
 
1. The origin of the laboratory is at the crystal. 
2. The X axis goes from the crystal toward the goniometer baseplate.  This may be horizontal, 

vertical or neither. 
3. The Z axis goes from the crystal toward the source. 
4. The Y axis make a right-handed system after  X and Z are chosen. 
5. All positive hardware rotations are right-handed. 
6. The crystal to detector distance is positive even though it is usually at a negative Z value. 
7. The direct beam position on the detector in pixels is specified when the detector is perpendicular 

to the source (rotations are at zero) AND the detector translations in X and Y are zero.  In the 
actual experiment, the detector may be rotated or translated away from this position. 

 
The following text lists the 19 different properties that can be refined or fixed. 
 
Crystal        
 All crystal Crystal cell (lengths and angles),orientation and mosaicity 
 All cell Cell lengths and angles   
  All lengths  Cell lengths a*, b*, c* 
   a* Cell length a* 
   b* Cell length b* 
   c* Cell length c* 
  All angles Cell angles  α*, β*, γ* 
   alpha* Cell angle  α* 
   beta* Cell angle  β* 
   gamma*  Cell angle  γ* 
  All rots Crystal orientation angles 
   Rot1 Crystal orientation angle around X 
   Rot2 Crystal orientation angle around Y 
   Rot3 Crystal orientation angle around Z 
  Mosaicity Crystal mosaicity 
 
Detector 

 

X 

Detector 

Z 

Y 
Source 

Goniometer baseplate 
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 All detector All detector translations and rotations 
 All trans  Detector translations along X, Y, Z 
  X/Trans1 Detector translation along X 
  Y /Trans2 Detector translation along Y 
  Dist/Trans3 Detector translation along Z 
 All rots Detector rotation around Z, X, Y 
  Rot1 Detector rotation around Z 
  Swing/Rot2 Detector rotation around X 
  Rot3 Detector rotation around Y 
 
Source 
 Wavelength Source wavelength 
 All rots Source vector rotations around X & Y 
  Rot1 Source vector rotations around X 
  Rot2 Source vector rotations around Y 
 
 

Related Documentation 
For more information on the image collection device that you will be using with CrystalClear, see the 
user guide that came with the device.  Currently, CrystalClear collection tasks support the Rigaku R-
Axis, and Rigaku Mercury and Jupiter CCD Automated X-ray Imaging Systems.  CrystalClear 
processing supports the Rigaku R-Axis, and Rigaku Mercury and Jupiter CCD Automated X-ray Imaging 
Systems.  In addition, CrystalClear processing supports Bruker, MAR CCD, MAR IP, ADSC CCD, 
MacScience, Brandeis CCD, and MedOptics images. 

 

You can also check the Molecular Structure Corporation web site for product information, application 
notes, service bulletins, and on-line documentation. Set your browser to http://www.msc.com.  
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2 Installation 
 

System requirements  
To run CrystalClear you will need the following:  

Imaging System Rigaku R-AXIS IV or Rigaku Mercury or Jupiter CCD Automated 
X-ray Imaging Systems 

Computer System Pentium 450 MHz or better (500 MHz recommended) 

Memory Minimum 384 Mb RAM  (512 Mb recommended) for R-AXIS 
Minimum 256 Mb RAM (512 Mb recommended) for CCD 

Available hard drive space Minimum 50 meg hard drive space for the CrystalClear program, 
plus additional space as needed for your data storage 

Pointing Device Mouse 

Video System 1280 by 1024, 256 color capability or better 

19 inch monitor  (21 inch recommended) 

Operating System Windows NT 4.0 with Service Pack 3 (recommended), or Windows 
95/98 

Drive CDROM Drive 

Parallel (LPT) port A parallel (DB25) port to accommodate the Crypto-Box dongle 

 

Installing the Crypto-Box Dongle 
 
CrystalClear comes with a Crypto-Box dongle.  This Crypto-Box must be installed on the same computer 
where CrystalClear is installed. The Crypto-Box works transparently with CrystalClear to prevent 
unauthorized use and distribution of CrystalClear.  

To install the dongle,   

1. Detach printer (if any) from the parallel port. 

The parallel port is a DB 25 port that is normally located on the back of the computer.  It is a female 
connector with 25 holes that match up with pins in the male end of the dongle. 

2. Plug the male end of the dongle into the parallel port and tighten the screws. 

 If the computer has more than one working parallel port, you may attach the dongle to either one.  

3. If needed, reattach the printer to the female end of the dongle.  

 

Installing CrystalClear  
 
To install CrystalClear,  
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1.  Place the CrystalClear CD in your CDROM drive.  

2.  Click the Start button, then click Run. 

3.  Enter d:\setup, where d is the drive letter of your CDROM drive, then press (Enter). 

 The Welcome  dialog will appear.  

 
 

4. Click Next to continue. 

5. The license agreement will be displayed. Read the license agreement and click Yes to continue with 
the installation.  

6. The INFOLIST.TXT file will be displayed. This document includes important information about 
CrystalClear, including release notes for the current version, and other information that may not be 
included in the user manual. Click Next after reading the material.  

7. In the Select Destination Location dialog, select the location where you want the CrystalClear files 
installed. The default location is C:\PROGRAM FILES\RIGAKU MSC\CRYSTALCLEAR. We suggest 
using the default location, but if you prefer to install CrystalClear in a different location, modify the 
path and click Next.  

 Follow the remaining prompts until the CrystalClear installation program is completed.  See 
Appendix A: Files and Directory Structure on page135 for information on the files that are installed, 
and the directory structure that is created during the installation.  

 

After installation  
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After you have installed CrystalClear, log on as "administrator" and set up the users and system 
configuration.  See Appendix B:  Administration on page 141 for detailed information on administrative 
functions. You should also make sure that the Rigaku R-AXIS or Rigaku Mercury or Jupiter CCD 
Automated X-ray Imaging System that CrystalClear will be working with is set up correctly.  

 

Uninstalling CrystalClear 
To uninstall CrystalClear,  

1. Click the Start button on the Windows Task Bar. 

2. Select Settings > Control Panel.  

3. In the Control Panel, click Add/Remove Programs . 

 The Add/Remove Programs Properties dialog will appear.  

4. Locate Rigaku/MSC CrystalClear in the list and double-click. 

 CrystalClear and all its components will be removed.  Any image files you may have, and data files 
that were created or processed by CrystalClear will not be removed from your system. 
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3 Introduction to CrystalClear 
 

What is CrystalClear?  
CrystalClear is a software program designed to work with the Rigaku R-AXIS or Rigaku Mercury or 
Jupiter CCD Automated X-ray Imaging Systems for the collection and processing of crystal data.  
CrystalClear interfaces with the X-ray imaging system to collect data, then will process that data.  
 
CrystalClear can be used to process data that may have been collected previously.  It can support .IMG 
(CCD), .OSC (RAXIS), and .STL (RAXIS) image files.  CrystalClear  can also support Bruker, MAR 
CCD, MAR IP, ADSC CCD, MacScience, Brandeis CCD, and MedOptics images. 
 

Overview of the CrystalClear Interface 
 
The CrystalClear interface, pictured above, contains several elements that let you control collection and 
processing.  The items below refer to the numbers in the display above.  
 
1 Task drop down list  
2  Current sample  
3 Run mode 
4 Flow bar 
5 Step within the selected task 
6 Substeps of a step 
7 Toolbar 
8 Image window 
9 Command Bar 
10 Message Window 
11 Status Bar 
 
Task Drop-down List 
 
The Task drop-down List displays the currently selected task. Display the list by clicking the drop-down 
button. Specific tasks will be discussed in later sections of this manual.  Tasks include:  Screen Collect 
and Process, Collect and Process, Collect, Process, Combine Reflections  
 
Current Sample 
 
CrystalClear allows one open or current sample at a time.  After Login, the sample most recently opened 
is automatically displayed in an Open Sample dialog.   The user may wish to open this sample or create a 
New Project or New Sample .  Alternately, to open a current sample, click File > Open Sample . To 
start a new sample, click File > New Sample .  If a new sample is created when sample is current, 
CrystalClear automatically saves and closes the existing.  Upon exiting CrystalClear, the current sample 
is automatically saved and closed  
 
Run Mode 

 
The Run Mode  buttons allow you to choose whether you want to process your data in automatic mode 
or manual mode. The Auto will allow CrystalClear to process the data with current settings, without 
user intervention. Click Abort to stop the Auto feature if you wish to manually process your data step by 
step.  
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Flow Bar 
 
The CrystalClear interface is designed to help the user complete the tasks of collecting and processing 
crystal data by following the steps displayed on the Flow Bar. The Flow Bar displays the current task, 
and all the steps required to complete that task. As you move through the steps in the task, the current 
step button will change to yellow.  Note that the steps in the Flow Bar change depending on the Task 
selected from the drop-down List. 
 
Step Button 

 
A button represents each step in the task. When you click the button, a dialog will be displayed with 
information pertinent to that step. You can make adjustments to the settings, then click the Run button 
on the dialog to continue. 
 

 
 
When a step is running, the button will be yellow.  
 

 
 
 
Steps with Substeps 

 
Step buttons that have a small arrow to the left of the button label include substeps. Click the button to 
display the substeps. Clicking the step button again will collapse the list, so the substeps are no longer 
displayed.  
 

 
 
Toolbar 

 
The Toolbar includes buttons needed to complete common activities.  Some of these include:  selecting a 
processing algorithm, toggling display items, moving through images, etc.  
 
As you move your mouse cursor over each button, a Tool Tip will appear that describes the button's 
function. Note that these functions are also available on the menu. 
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New Sample  

 
Open a Sample  

 
Save Sample  

 
Use d*TREK as the processing module  

 

Use TwinSolve as the processing module. When you choose this option, CrystalClear 
automatically uses a mix of processing modules.  TwinSolve is selected for the Index 
algorithm, while d*TREK is selected as the Integrate and Scale algorithms. (available only 
with CCD) 

 

View Image Collection updates. When toggled on, image updates will be displayed during 
collection.     

 
View Image Processing Updates. When toggled on, processing results will be displayed 
during processing. 

 
View Image 

 
Show Processing State Display. A dialog displaying the processing state will be displayed. 

 
Show Scan State Display.  A dialog displaying the scan state will be displayed. 

 
Show Instrument State Display. A dialog displaying the instrument state will be displayed. 

 
Show Manual Instrument Control 

 

View Log File.  The Open dialog appears, allowing you to select the .LOG file to view. 
That file is then opened in the Log File Editor 

 
Set Resolution 

 

The RAX Shape crystal viewer will be displayed.  This is available for CCD instruments 
only. 

 
Previous Window.  The previous window will be displayed. 

 
Next Window. The next window will be displayed. 

 
About. The About dialog will be displayed. 

 

Toggle Task List. The task List on the toolbar will be toggled on and off as you click this 
button. 
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Toggle Standard Tools.  The standard tools on the toolbar will be toggled on and off as 
you click this button. 

 

Toggle Flow Bar. The Flow Bar display will be toggled on and off as you click this 
button. 

 

Toggle Command Bar. The Command Line display will be toggled on and off as you click 
this button. 

 

Toggle Message Bar. The Message Bar display will be toggled on and off as you click this 
button.  

 

Toggle Status Bar. The Status Bar display will be toggled on and off as you click this 
button. 

 

Toggle Script Tools.  The Script Tool button display will be toggled on and off as you 
click this button. The Script tool buttons are:  

  Play 
 Record 

  Pause 
  Stop 

 
Scripting is not fully implemented in CrystalClear.  

 
Shutter Status (open or closed) 

 Close the shutter and shut down the device driver or processing server immediately. 

 
Processing and Collection Status. The cube rotates when data is being collected or 
processed. 

 

Execute Step Button     
 

You can immediately execute a particular step by clicking its Execute  Step button. This is the small 
button on the right of the large button with the Lightening icon.  

 

 
 

Normally, when you click a step button, a dialog is displayed, allowing you to change parameters, then 
you click the Run button to start the process. Clicking the Execute Step button starts the process 
without displaying the associated dialog. The current values are used for the processing.   

 
When the process for a particular step is running, the Execute Step button is displayed with a red X. 
You can click this button to stop the process.  
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Next Step arrows  
 

The Next Step arrows indicate the next step in the task. This arrow will change to a Decision Point or 
Stop Sign when further action is required. You can also click the Next Step arrow to change it to a 
Decision Point or Stop Sign.  You can pause the current processing by changing the Next Step arrow to a 
stop sign.  

Decision Points  
 
Whenever you must make a decision on what direction to go next, a decision point icon will appear 
below the current step.  Arrows leading from the decision point icon will point to the next step for each 
possible choice. Click the decision point icon to open the decision dialog, then select the next step.  
Alternatively, you can click one of the buttons to which the Decision arrows points.  

 

Stop Signs  
 
You can click the Next Step arrow until it becomes a Stop Sign. When a Stop Sign icon appears below a 
step button, CrystalClear is paused at that step and is awaiting the user to click again to resume 
processing.  

 
You may want to set a stop sign after a specific sub-step in the Flow Bar, so that processing pauses after 
that step.   
 

Image window 
 
In the Image window, the data images will appear as they are processed.  See Section 9  Images on page 
131 for more information about this window.  
 

Command Bar 
 
The Command Bar displays the commands sent to the compute server (d*TREK). In a future release 
you will be able to enter commands on the Command Bar directly, allowing you to bypass the graphical 
user interface if you desire.  
 

Message Window 
 

In the Message Window, CrystalClear will display various messages informing you of the progress of 
the current process.  
 

Status Bar 
 
As you scroll through menu items, a brief description of the selected menu item is displayed on the status 
bar.  
 

Log File window 
 
The log file window (not pictured above) displays the contents of a log file. Log files are created with 
each process in CrystalClear.  You can display the log file by clicking the View Log File button on the 
tool bar, or by selecting View > Log File from the menu.  See Appendix C: Sample Log Files on page 
161 for more information on log files.   
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4 Running CrystalClear for the First Time 
 

Starting CrystalClear and Logging in 
Once CrystalClear is installed and your administrator has created a user account, you can start 
CrystalClear and Log in to begin working on your crystal samples.   
 
Before you are able to log in to CrystalClear, your administrator must create a user account for you. You 
will receive a Login Name  and a Password. For convenience, your Login Name  could be the same 
name used for your system login. If you do not know your user name and password, see your 
CrystalClear administrator. 
 
Important:  CrystalClear will not run without the Crypto-Box (dongle) installed on the parallel port of 
the computer.  Before starting CrystalClear, make sure the dongle (Crypto-Box) is installed.   
 
To start CrystalClear,  
 
1.  Click Start on the Windows task bar, then select Programs > Rigaku MSC > CrystalClear.  
 

The CrystalClear program will start, and the Login dialog will be displayed. The current system 
login user name will automatically be displayed in the Login Name  edit field. 

 
 If CrystalClear is not on your Start menu, see your CrystalClear administrator.  

 

 
 

2. Enter Login Name , then press (Tab). 
 
 User names and passwords are not case-sensitive.  
 
3. Enter the password, then click OK.  
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Creating Your First Project and Sample 
When you log into CrystalClear for the first time, the Project Wizard will lead you through the creation 
of a new project and sample.  

A Project is a collection of related samples.  For example, you may grow ten myoglobin crystals, which 
you plan on processing as individual samples. You can create a project called Myoglobin, then create ten 
samples in that project, one for each crystal.  
 
A Sample is roughly equivalent to the data collected and processed from one individual crystal.  

 

1. In the Project Name  field, enter a name for your new project, then click Next.   

  

 

2. In the Sample Name Wizard dialog, enter a name for your new sample in the Sample Name  field, 
then click Next.   

  
 

3. In the Task Selection Wizard dialog, select a task from the Task drop down list, then click Next.  
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 This chart shows the tasks on the dropdown menu by clicking the Task down arrow.. 

 
Screen Collect 
and Process 

This task allows you to screen crystals by collecting 
initial images, decide to collect a data set on a 
crystal, help determine a data collection strategy, 
collect the data, and process the images. The 
software is designed to have one data set per 
“sample.”  

Collect and 
Process  

This task allows you to go directly to data collection 
and process the images once they are available. 

Collect  This task allows you to only collect data.  This option 
is used when the intention is to process the images at 
a later time.  

Process This task allows you to process already-collected 
images. 

Combine 
Reflections 

This task allows you to combine reflection files from 
different data sets.  

 

Next, the Image Files dialog appears.  If you are using existing image files to Process a sample, you 
may specify one image file in the Image File  path. CrystalClear will include all image files in the 
same location for the sample. If you Collect images for this sample, specify the path to store images 
upon collection. Collected images may be stored in a separate location as the Project and Sample 
data. 

Note:  Each time a New Project or New Sample  is created, CrystalClear creates new folders on your 
system, located in the assigned path.  For example, when a New Project named  Myoglobin and a 
New Sample  named Myo1 is created, CrystalClear creates a folder called Myo1 nested within a 
folder called Myoglobin (project).  Each time a New Sample  (i.e. Myo2, Myo3, Myo4, etc.) is 
created within the Myoglobin Project, a new folder for each sample is nested within the Myoglobin 
folder.  
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Note:  CrystalClear automatically stores Project and Sample data to the default location C:\Program 
Files\RigakuMSC\CrystalClear\data\(Login Name).  During user set-up, your administrator may 
assign a unique path for each user to store Project and Sample data.  It is not recommended that 
administrators use this directory for user base directories!  Additionally, it is not recommended that 
the same directory be used by different users. 

 

  
4. Click Finish. The project and sample will be created. Later, you can add more samples to the same 

project, or you can create additional projects as needed. 

Each Project Name  is unique for a Login Name . To access a specific Project, a user must use the 
same Login Name  as was used when the Project was created.  

5. Now that you have logged in and created your first project and sample, you can begin collecting 
and/or processing data. 

 
At your next Login, the Open Sample  dialog will display the most current sample. CrystalClear 
allows only one open or current sample at a time in each CrystalClear window. The user may wish 
to open this sample or create a New Project or New Sample .  Alternately, to open a current sample, 
click File > Open Sample .  

To begin a new sample, click File > New Sample .  If a new sample is created when sample is 
current, CrystalClear automatically saves and closes the existing current sample.   

Upon exiting CrystalClear, the current sample is automatically saved and closed.  See Section 7  
Tool Reference on page 93 of this manual for more information on adding new samples. 
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5 Common CrystalClear Tasks 
 

This section gives a brief overview of several common CrystalClear tasks.  In later sections, each task is 
discussed in more detail with explanations of parameters, preferred procedures, etc.  

 

Collect Images 
 
CrystalClear can be used to collect images of your crystals on the Rigaku R-AXIS IV, or Rigaku 
Mercury or Jupiter CCD Automated X-ray Imaging Systems.  
 
To collect images,  
 
1. Start CrystalClear and enter Login Name  and Password.  
 

When a Login Name  is used for the first time, the Project Wizard will lead the user through the 
creation of a new project and sample. See Section 4 Running CrystalClear for the First Time on 
page 27, if you need assistance. 
 
When a Login Name  is repeated, the Open Sample dialog allows the user to open an existing 
Project, or begin a new Project.  The last project and sample used (for the Login Name) will be 
listed as default. 
 

2. At the Open Sample  dialog, select the Project and Sample . 
 
3. Select Collect and Process from the Task drop down list, then click OK.  
 

 
 

The Open Sample  dialog allows the user to begin a New Project or a New Sample  by clicking the 
appropriate buttons.  
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 The Setup dialog will appear.  
 

 
 

4. Check the values on each tab of the Setup dialog box, adjusting any values as desired, then click 
OK. 

 
5. When prompted to Initialize  the device, click OK. 
 
6. Mount your crystal. At the Mount Crystal prompt, click OK when ready.  
 
7. If you are using the Mercury CCD, the shape program will open.  Draw the faces of the crystal to be 

used in the Numerical Absorption Correction.   
 
8. When the Collect Images dialog box appears, choose a collection schedule and then click Run. 
 

To watch the progress of the collection, click the Show Instrument State Display button on the 
toolbar.  

 

Process Images 
 
Once images have been collected, you can use CrystalClear to process them. If you selected Screen 
Collect and Process or Collect and Process as your task, the CrystalClear Flow Bar will automatically 
begin the Process steps when collection is complete. If you have previously collected the images to 
Process, continue with the following steps.  
 
Setup 

 
The first step in the CrystalClear Flow Bar is Setup.  

 
1. Start CrystalClear. Enter Login Name  and Password 
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When a Login Name  is used for the first time, the Project Wizard will lead the user through the 
creation of a new project and sample. See Section 4 Running CrystalClear for the First Time on 
page 27, if you need assistance.  
 
When a Login Name  is repeated, the Open Sample dialog allows the user to open an existing 
Project, or begin a new Project.  The last project and sample used (for the Login Name) will be 
listed as default. 

 
2. At the Open Sample  dialog, select the Project and Sample .  
 

 
 
3. Select Collect and Process from the Task dropdown menu, then click OK.  
 

The Open Sample  dialog allows the user to begin a New Project or a New Sample by clicking the 
appropriate buttons.  

 
 The Setup dialog will appear.  
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4. Check the values on the different tabs of the Setup dialog box, change any values that are not correct 

and then click OK. In particular, pay close attention to the necessary parameters X and Y Direct 
Beam positions, Crystal To Detector Distance, Detector 2θ , and Source Wavelength. 

 
 The CrystalClear Flow Bar will automatically begin the next step, Assign Unit Cell. The Find Spots 

dialog will appear.  
 
Assign Unit Cell 
 
The next step in the Flow Bar is Assign Unit Cell.  This step in the Process assists the CrystalClear user 
in procedures Find Spots, Index Spots, Refine Cell, and Predict Spots. The purpose of this section is to 
determine and confirm the unit cell and mis-setting angles.  
 

Find Spots  
 

1. The Find Spots dialog allows the user to select images. Image numbers may be entered manually or 
selected from a list. 

 
When entering image numbers manually, be sure to use a dash (-) to separate consecutive image 
entries or use a comma (,) to separate non-consecutive images entries. Before clicking the Run 
button to Find Spots, de-select (un-highlight) the To Use entry field to verify the selected image 
entries. 
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Right-click an entry field for further menu options as follows: 
 

  View Images List   Displays a list of image files  
  Select Scan   Allows user to select images of a scan 
  Clear Scan   Clears selected images of a scan 
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In the View Images List, all images available are listed with a selection box in front of the image name 
and the type of rotation/oscillation with its beginning and end angles following. Click on the box to 
select/deselect the image. The sequence field dynamically changes with the selections. 
 

 
 
View Images List menu option (right click on entry field) allows the user to select image files. Before 

clicking the Run button to Find Spots, de-select (un-highlight) the To Use entry field to verify the 
selected image entries. 
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2. If desired, change other parameters in the Find Spots dialog box.  
 
3. When satisfied with the settings, click Run.  
 

CrystalClear finds the spots in each image file selected, creating a reflection and log file called 
dtfind.ref and dtfind.log, respectively. Each image appears in the image window as it is processed.   
 
Index Spots  

 
The CrystalClear Flow Bar will show the next step of Assign Unit Cell. Click Index Spots  on the Flow 
Bar. The Index Spots  dialog will appear.  
 

The Index Spots  dialog allows the user to index the spots from a reflection file, and thus assign the 
unit cell.  This can be done either automatically with judicious setting of the parameters or 
interactively with the “User Chooses Solution” option. 

 
1. The Index Spots  dialog allows the user to index the spots from a reflection file, and thus assign the 

unit cell.  This can be done either automatically with judicious setting of the parameters or 
interactively with the “User Chooses Solution” option.  

 

 
 
2. If desired, change parameters in the Index Spots  dialog box.  
 
3. When satisfied with the settings, click Run.  
 

CrystalClear indexes the spots from the reflection file selected, updates the database for this sample, 
and generates a log file called dtindex.log. If “User Chooses Solution” is checked, the user must 
choose one of the crystal lattice solutions displayed by double clicking on the row in an Index 
Results Window. 
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4. Look over the Index Results  to identify the cell in question.  Least Squares Residuals (LSR) 

represent the residual between the current cell and the triclinic cell (lower is better).  Depending 
upon the degree of accuracy of your detector geometric parameters, the LSR will vary (very small is 
well known.) 

 
Select a solution, if it is not already selected. 

 
5. Click OK 

 
The Processing State Display may appear. It shows the current parameters for the sample.  For 
more information on the Processing State see page 98 of Section 7  Tool Reference. 
 

For more information, see Index Spots on page 63 of Section 6 Data Collection and Processing. 
 

 
Refine Cell 
 

The CrystalClear Flow Bar will automatically begin the next step within Assign Unit Cell. The Refine  
Cell dialog will appear.  

 
1. The Refine Cell dialog allows the user to refine the crystal, detector, and source parameters. 
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2. Select the desired Macro to use for refinement.  
 

 Macro is initially set to Single Step Refine. The user may use an alternate Macro, however, this 
setting returns to the default, Single Step Refine following each Run. To create custom macros, 
click Advanced button..  See Section 8 Additional Processing on page 119 for information on 
creating your own macros. 
 

3. Consider adjusting the resolution in the Resolution Min and Max fields.  Adjusting the value in the 
peak intensity inclusion criterion in the I/σ (I) field will allow more reflections in the refinement; or 
consider adjusting the rejection tolerances in the X, Y and Rot fields.   

 
4. Click Run to refine with current settings.  
 

When the refinement is finished, the fields in the dialog will be populated with values.  
 
5. Make any desired changes in the Refine  dialog.  Selecting boxes will include a parameter in a 

refinement.  Deselecting boxes will withdraw a parameter from the refinement. 
Click Run to repeat the refinement, if desired. 
 

 Remember, Macro resets to the default, Single Step Refine , following each Run. 
 
6. If View Image Processing Updates icon is toggled on, the reflection in the reflection file will be 

represented on each image using one of the following colors: included blue circles, excluded green 
circles, and rejected red circles.  Adjusting Resolution Range  fields, and I/σ will include/exclude 
reflections.  Adjusting the rejection limit, (X and Y in mm, Rot in Degrees) will include/reject 
peaks).  Also displayed on each peak is a vector representing the difference between the peak top on 
the image and the center of the predicted reflection related to the current values of the orientation 
matrix. 
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7. Click Close when you are satisfied with the Refine results.  
 

Predict Spots 
 
The CrystalClear Flow Bar will show the next step within Assign Unit Cell. Click Predict Spots on the 
Flow Bar and the Predict Spots dialog will appear.  
 

 
  
1. The Predict Spots dialog allows the user to select images to predict reflections. Image numbers may 

be entered manually or selected from a list. 
 

When entering image numbers manually, be sure to use a dash (-) to separate consecutive image 
entries or use a comma (,) to separate non-consecutive images entries. For example, you can enter 
images such as 2-5, 7, 9-12.  Before clicking the Run button to Predict Spots, de-select (un-
highlight) the To Use entry field to verify the selected image entries. 

 
Right-click the “To Use” field for further menu options as follows: 

 
  View Images List   Displays a list of image files  
  Select Scan   Allows user to select images of a scan 
  Clear Scan   Clears selected images of a scan 

 
In the View Images List, all images available are listed with a selection box in front of the image 
name and the type of rotation/oscillation with its beginning and end angles following. Click on the 
box to select/deselect the image. The sequence field dynamically changes with the selections. 
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2. Make other adjustments to desired settings.  
 
3. Click Run to predict spots.  
 

CrystalClear predicts the spots in each image file selected, creating a log file called dtpredict.log. If 
the view Image Processing Updates icon is toggled on, predicted spots are represented by colored 
circles on the image(s).  The predicted pattern should closely match the observed pattern. 

 
For more information, see Index Spots on page 63 of Section 6 Data Collection and Processing. 

 
 

Strategy 
For detailed help, see Strategy on page 80 of Section 6 Data Collection and Processing. 

 
Strategy can be used to automatically generate a collection schedule so you don’t have to.  
 
1. Click Strategy on the flow bar.  
 The Strategy dialog will appear. 
 

 
 
2. Make changes in setting, if desired.  
 
3. Click Run. 
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Integrate Reflections 
For detailed help, see Integration on page 83 of Section 6 Data Collection and Processing. 

 
Once the reflections can be accurately predicted, they can be integrated.  
 
1. Click Integrate Reflections  on the flow bar.  
 The Integrate Reflections  dialog will appear.  
 

 
 

2. The Integrate Reflections  dialog allows the user to select images. Image numbers may be entered 
manually or selected from a list. 

 
When entering image numbers manually, be sure to use a dash (-) to separate consecutive image 
entries or use a comma (,) to separate non-consecutive images entries. For example, you can enter 
images such as 2-5, 7, 9-12.  Before clicking the Run button to Integrate Reflections, de-select (un-
highlight) the To Use entry field to verify the selected image entries. 

 
Right-click the “To Use” field for further menu options as follows: 

 
  View Images List   Displays a list of image files  
  Select Scan   Allows user to select images of a scan 
  Clear Scan   Clears selected images of a scan 

 
In the View Images List, all images available are listed with a selection box in front of the image 
name and the type of rotation/oscillation with its beginning and end angles following.  Click on the 
box to select/deselect the image. The sequence field dynamically changes with the selections. 
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3. Make other adjustments to desired settings such as Box Width and Height (6 to 10 times the spots 
size without overlapping onto adjacent spots more than half way), Images Per Batch (2 to 4 times the 
mosaicity for macromolecules and 10 to 30 times for small molecules).  

 
5. Click Run.  
 

A CrystalClear message may appear.  This reminds the user to create a mask file to exclude areas of 
the detector from consideration in integration due to uncertain intensities resulting from shadows, 
bad pixels, or detector flaws. Although it is not necessary to use a mask, it is advisable. See Non-
uniformity Type  on page 54, a sub-section of Setup in Section 6 Data Collection and Processing 

 

 
 
CrystalClear integrates the reflections for each image file selected, creating a log file called 
dtintegrate.log. The Integrate Reflections step can take considerable time depending upon: 1) the 
number of images to be integrated,2) the number of reflections per image, 3) the computer’s 
available memory, and 4) the computer’s processing speed 
 

 

Analyzing the Data 
Once integration is comple ted, data may be analyzed to determine Laue symmetry, centricity, and 
spacegroup.  See Section 6 Data Collection and Processing on page 49for detailed help. 
  
Laue Symmetry 

 
1. Click Laue  on the flow bar. 

The Laue dialog will appear. 
 

 
 
2. Select the Reflection List file to use (generally dtprofit.ref).  
 
3. Make other adjustments to settings as follows: 
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Max R-merge Tolerance for considering a Laue class present 
Highest Laue Symmetry Limits the highest Laue class to be checked. 
Only check Laue groups compatible with 
current cell 

Unchecked, examines all Laue classes 
compatible with current cell 

Average Bijvoets (Assume 1+ = 1-) Unchecked examines Laue classes desired 
 

 
4. Click Run.  
 

 
 
5. Look over the Laue groups and R-merges for the Laue equivalent reflections.   

Select the Laue class, if it is not already selected. 
 
6. Click OK 
 
 
Centricity 

 
1. Click Centricity on the Flow Bar. 

The Centricity dialog will appear. 
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2. Select the Reflection List file to use (generally dtprofit.ref).  
 
3. Click Run. 
 

 
 
4. Check the evaluation of centricity  

Select the correct centricity if it is not already selected 
 

5. Click OK  
 
 
Spacegroup 

 
1. Click Spacegroup on the Flow Bar. 

The Spacegroup dialog will appear. 
 

 
 
2. Select the Reflection List file to use (generally dtprofit.ref).  
 
3. Make other adjustments to settings including the average intensity <I/Sig> Tolerance for the parity 

groups. 
 
4. Click Run. 
 
5. Evaluate the suggested space group(s). 

Crystal 2 tab of the Set Up dialog to enter the space group. 
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Scale and Average  
 
Once integration is completed, you should scale the reflections. 
 
1. Click Scale and Average on the flow bar.  
 The Scale and Average dialog will appear.  
 

 
 
2. Select the Reflection List file to use (generally dtprofit.ref).  
 
2. Make any other adjustments to the settings that you desire.  Some items to consider are the level at 

which you exclude reflections from the refinement (Exclude Sigma) but include in R-merge, the 
level of which to reject outliers either by the standard deviation (Rejection sigma) or by the Chi 
Square deviation (based on Maximum or on percentage rejected), the way in which to determine the 
error model, batch scaling, absorption algorithm (and hence the method of correction), and output of 
the reflection file. 

 
3. Click Run. 
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 A CrystalClear message appears. 
 

 
 

The Scale and Average Results window will appear with the results of the scaling displayed as 
graphs, generating a log file, and writing the reflection file to the sample directory. 

 
. 
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6 Data Collection and Processing  
 
There are five basic steps to collecting and processing data with CrystalClear.  The Flow Bar leads you 
through each of these basic steps, with some variations based on the processing algorithm that is 
selected.  
 
Setup This step allows you to set default parameters for the data collection and processing.  

The CrystalClear administrator can specify many setup values as default values for your 
entire site.  See Appendix B:  Administration on page 141 for information on setting site 
default values. Users can also override site defaults for a specific project.  This step is 
not dependent on the selected processing algorithm.  

 
Collect ImagesIn this step, the data is collected using CrystalClear on your R-AXIS or CCD X-ray 

detector. This step is not dependent on the selected processing algorithm.  
 
Index Indexing determines the unit cell parameters and orientation of the crystal.  
 
Integrate This step integrates the reflections on the collected images.  In this step, the operation 

required, and the results are dependent on the selected processing algorithm.  
 
Analysis This step helps to determine the Laue class, centricity and space group. 
 
Scale  This step performs post-processing analysis and normalization of the collected data. In 

this step, the processes required, and the results are dependent on the selected processing 
algorithm. 

 
 

Select a processing algorithm  
CrystalClear is designed with two processing modules, allowing you to choose the way your data is 
processed.  
 
The processing modules supported by CrystalClear are:  
 

d*TREK 
TwinSolve 

 
 
To select a processing module,  
 
1. Click the toolbar button representing the processing modules you wish to use:  
 

  Use d*TREK 

  Use TwinSolve (available only when processing CCD images) 
 

• Alternatively, the processing module options are available on the CrystalClear menu.  
Click Sample>, then select the processing module you wish to use. 

 
TwinSolve includes only an indexing algorithm.  You should use the solution found in TwinSolve to 
index a known cell in indexing. If you select TwinSolve, d*TREK will automatically be selected as 
the algorithm for Integrate and Scale . 
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Setup 
The first step in collecting or processing data is to set the parameters to be used in the Setup dialog.  
Once you have selected the sample, the Setup dialog will appear. . For processing, it is necessary only to 
have the following five fields correct: X and Y Direct Beam positions, Crystal To Detector Distance, 
Detector 2θ , and Source Wavelength.   All other parameters are kept inside CrystalClear for your use. 
 
Many of the values on the Setup tabs are set as site defaults assigned by your CrystalClear administrator, 
or by the user as Project defaults. 
 

• Alternatively, Setup dialog can be accessed by clicking the Setup button on the Flow Bar. 
• The Setup dialog can also be accessed on the CrystalClear menu.  Click Sample > Setup.  

 
The Main Tab 

 
The Main tab in the Setup dialog includes the basic settings that are most often adjusted during 
collection and processing of data. A few of the items found on the Main tab are also found on the other 
Setup tabs, along with additional settings that normally do not change.  
 
Project and Sample: The names of the current project and sample are listed for your reference.  
 
Crystal ID: The Crystal ID is a name or number you can give to your crystal for your personal reference. 

This value is not used in collection or processing. 
 
Temperature (º C): The temperature of the crystal sample at the time of collection, in Celsius.  
 
Crystal to Detector Distance (mm): The distance from the crystal to the detector when collecting images. 

If you are processing existing images, the value specified when the images were collected will be 
displayed.  

 
Detector 2θ ( º ):  Swing angle of the goniometer. If you are processing existing images, the value 

specified when the images were collected will be displayed. 
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Note:  Crystal To Detector Distance (mm) and Detector 2θ  (°) fields show the hardware or unrefined 

values.  If  “per scan” is displayed in the Crystal To Detector Distance (mm) field, different scans 
will have different values.  In this case, refer to the Scan State Display window to see the values for 
each scanned image. 

 
The Crystal1 Tab 

 
The Crystal1 and Crystal2 tabs include information about the crystal.  
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Unit Cell Parameters:  The unit cell parameters for the cell.   
 

a (D) default = 50.000000 
b (D) default = 100.000000 
c (D) default = 150.000000 
α (°) default = 90.000000 

  β (°) default = 90.000000 
γ (°) default = 90.000000 

 
Size: The size of the crystal in millimeters.  
 

X (mm)  default = 0.2 
Y (mm)  default = 0.2 
Z (mm)  default = 0.2 

 
Mosaicity: Specify the starting value to use for crystal mosiacity. The default starting value is 0.6. 
 
Color:  Specify the color of the crystal.  You can choose from a drop down list of predefined colors, or 

enter a different color name in this field. The predefined choices are: blue, colorless, gray, green, 
orange, red, white, and yellow. 

 
Mount: Specify the mounting type used for the crystal.  You can choose from a drop down list of 

predefined mount types, or enter a different mounting type name in this field. The predefined 
choices are Loop, Capillary, and Fiber. 

 
Morphology: Specify the morphology of the crystal.  You can choose from a drop down list of 

predefined morphologies, or enter another name in this field.  The predefined morphology types 
are:  Block, Chip, Chunk, Platelet, and Prism. 

 
 

The Crystal2 Tab 
 
The Crystal2 tab contains additional information about the crystal as a continuation of the Crystal1 tab. 
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Spacegroup:  Specify the spacegroup of the crystal, if known.  

 
Unknown vs. Known Spacegroup: If you know the spacegroup, select Known Spacegroup.  If you 

do not know the spacegroup, select Unknown Spacegroup.  
 

Specifying a known spacegroup may save time later on as the crystal is processed.  
 
Crystal System: If you selected Known Spacegroup, this option will become enabled. You can 

select from the drop down list of predefined Crystal Systems  and then scroll through the 
available spacegroups from the list under Number and Name , or alternately, type either the 
number or name in the appropriate Number or Name  field.  

 
Number and Name: To enter a known spacegroup, type either the number or the name in the 

appropriate field.  Alternately, if you know the Crystal System and need to be reminded of the 
possible Space Groups, select the Crystal System, then scroll and choose the Space Group 
from the list under Number and Name .  

 
Orientation Angles: These values will be calculated later on by CrystalClear. Leave them as 

0.000000 when starting a new sample.  
 
 
Molecular formula: Specify the molecular formula for the crystal. You may enter the formula as it 

appears in your compound.  CrystalClear will determine the empirical formula for you. 
  

 
The Detector Tab 
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The Direct Beam settings on the Detector tab are based on the type of X-ray detector.  Normally, the 
values are set as site defaults by your CrystalClear administrator.  The Crystal to Detector Distance  
may be changed on the Main tab of the Setup dialog, as well as on the Detector tab.  The Rot2/ 2θ  (°) 
can also be set on the Main tab. The other Direct Beam settings on this tab are generally not changed.  
 
The Non-uniformity Type   group box offers the user several options.  The user may choose to create a 
mask file to exclude areas of the detector from consideration in integration.  Mask are used due to 
uncertain intensities resulting from shadows, bad pixels, or detector flaws. Although it is not necessary 
to use a mask during processing, it is advisable.  
 

• None 
• Simple Mask 

Simple Scale 
• Dark and Mask 

Dark, DC, and Mask 
 
Select the desired radio button; then specify the mask filename and/or dark filename. Usually, the 
software will set these as the occasion permits, such as the creation of a simple mask for integration. 
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The X-Ray Source Tab 
 
The X-Ray Source tab allows you to specify the X-ray source that your system uses. Normally this 
information is set as site defaults by your CrystalClear administrator. 
 

  
 
kV:  Specify the kV of your X-ray source. 
 
mA:  Specify the mA of your X-ray source.  
 
Element: Select the element type of your X-ray source from the predefined drop down list.  The 

possible predefined choices are Chromium, Copper, Gold, Iron, Molybdenum, Silver, and 
Tungsten. 

 
Wavelength:  Specify the wavelength of your X-ray source.  The wavelength is based on the Element 

type. When you select an Element, a valid wavelength will automatically be selected for 
you. 

 
Source Type:  Select the source type of the X-ray source from the predefined drop down list.  The 

predefined choices are Rotating Anode, Sealed Tube, and Synchrotron. 
 
Optics:   In this section of the tab, specify the following attributes of your detector: 
 

Type:    Select from list: Mirrors, Confocal, Graphite Monochromator, or Multilayer  
Focus:   Select from a predefined list:  0.1, 0.15, 0.2, 0.3, or 0.5 
Slit Size:     Specify the slit size 
Collimation Type: Specify the Collimation type 
 

Note:  Many of the fields contain pulldown menus.  Although there are several common items in each 
list, the user can enter text strings if an option is not present for their experiment. 
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The Notes Tab 
 
The Notes tab provides a small notepad to record notes about a sample.  Notes can be stored as site level 
data (if you are a CrystalClear administrator), or as Project, User or Sample level data. Notes can be 
accessed at any time by opening the associated project and sample, open the Setup dialog, click the 
Notes tab.  

  
 

Save the Setup 
 
Settings in the Setup dialog are automatically saved with the current sample.  Some values may change 
as the data is processed.   
 
Setup data can also be saved to the project level data file, or site level data file (if you are a CrystalClear 
administrator).  To save Setup data to the project or site data files,  
 
1. Click Save.   
 The Default Manager dialog will appear. 
 

• For assistance using the Default Manager, see page 209 in Appendix F: Defaults in 
CrystalClear. 
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2. Check the desired level to save. 
 
3. Click OK. 

 
 Note : Site-level defaults are saved to CrystalClearSiteDefaults.ho in the \DATA directory. 

  User-level defaults are saved to CrystalClearUserDefaults.ho in the \user directory. 
  Project-level defaults are saved to CrystalClearProjectDefaults.ho in the \user\project directory. 
  A Sample-level default is saved to samplename.ho in the \user\project\sample directory. 
 

 Site level rights are enabled by the CrystalClear administrator only.  
 
 

Collect Images with an Imaging Plate System (R-Axis IV) 
 

The Collect Images dialog prepares a schedule for the collection of data with an Imaging Plate System, 
R-Axis IV. 

 
To schedule a collection run: 
 
1. Click the Collect Images button on the Flow Bar 
 
 The Collect Images dialog will appear.  
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Pixel Size  (µ): Select appropriate value. 
 
Readout Area: Select desired entry:  Full, Middle, Bottom Half, Custom.  Grayed-out 

options will appear as required:  Start Line, Number Lines 
 

Collect Schedules: Assign a schedule in the Collect Schedules edit box. 
(right click down-arrow) Several common schedules are: 

One: 0  (collects one image at φ   = 0°) 
Two: 0,30 (collects one image at φ  0°, and one at 30°) 
Four: 0,30,60,90  (collects images at φ  = 0°, 30°, 60°, and 90°) 
Default Screen Schedule  

 
Scan Table: The Scan Table contains contains information about scans in columns 

with headings which can be manipulated.  Users are able to Add 
Scan(s) and Remove Scan(s), then make changes to scan settings, as 
desired.   

 
For assistance in manipulating the Scan Table  columns, headings or 
other settings, see Using the Scan Table  on page 103 of Section 7  Tool 
Reference.  

 
Time Estimate:   Calculated based on supplied values and number of images. 
 
Required disk space:  The amount of disk space required to complete the scheduled collection request.  
 
Total disk space (drive):  The amount of disk space currently available.  
 
Completeness : Completeness of data in the scan. 
 
 Note:  If insufficient disk space is available to complete the scheduled image collection request, a 
CrystalClear warning dialog will appear.  The collection request may be cancelled to allow the user to 
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free more disk space on the system before continuing. 
 
See Create a Collect Schedule  on page 126 in Section 8 Additional Processing for more information 
about adding your own collection schedule. 
 
2. Use the Scan Table to alter the scans, you may: 
 

• Use the Add Scan button to increase the number of scans at a different crystal orientation.  
Adjust settings as desired. 

 
• Use the Remove Scan button to remove undesired scans.   

 
For assistance in manipulating the Scan Table  columns, headings or other settings, see Using 
the Scan Table  on page 103 of Section 7  Tool Reference.  

 
3. Make adjustments to the settings as required.   
 
4. Click Run to start the scheduled collection scan. 
  The Double -Check Settings  dialog will appear. 
 

 
 
5. Review the specified settings on the detector. 
 
6. Click Start Image Collection, or Cancel Image Collection if an error is found.  
 
In the event CrystalClear detects insufficient disk space available for the entire data collection, a dialog 
will appear to guide you through selecting a new collection directory.  You may need to “cancel” the 
data collection and free up space on the hard drive.  If you wish to delete the images and processing 
from an old sample (presumably with all necessary file archived), see Delete Projects and Samples on 
page 97 of Section 7  Tool Reference 
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Collect Images with CCD System (Mercury CCD) 

 

The Collect Images dialog prepares a schedule for the collection of data with a CCD system, the 
Mercury CCD. 
 
To schedule a collection run: 
 
1. Click the Collect Images button on the Flow Bar. 
 The Collect Images dialog will appear. 
 

 
  
Dezingered Exposure:   Check this option if desired.  See the Mercury or Jupiter CCD manual 

for more information on the Dezinger Exposure feature.  
 

Bin Mode:   Select the Bin Mode. See your Mercury or Jupiter CCD manual for 
more information on the Bin Mode feature.  

 
Collect Schedules (right click down-arrow):  Assign a schedule in the Collect Schedules edit box. 
 
Scan Table : User may Add Scan or Remove Scan on the Scan Table , then make 

changes to scan settings, as desired.   
 

For assistance in manipulating the Scan Table  columns, headings or other settings, see Using 
the Scan Table  on page 103 of Section 7  Tool Reference.  

  
Right-click on any column heading for All Columns  menu.  This allows the user to select (or 
de-select) individual columns to be displayed (or hidden).  Column headings are as follows: 

 
Scan ID: Scan identification number.  
 
Template: Base name of the image.  
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Detector Distance(mm):Crystal to Detector distance.  
 
2-Theta(deg) 2θ  offset of the detector.  
 
Max Resolution: Specify maximum resolution in degrees.  
 
Wavelength:(λ)  Specify the wavelength of your X-ray source.  The wavelength is based 

on the Element type.  When you selected an Element, a valid 
wavelength will be selected automatically.  

 
Omega: (ω)  The rotation axis on an AFC8 or 9 
 
Phi:  (φ)  Specify the position of the crystal goniometer in degrees, or the rotation 

axis on the AFC7. 
 
Rotation Axis:   Specify Omega (ω), or Phi (φ). Omega (ω) used for AFC8 or 9.  Omega 

(ω) and Phi (φ), one normally used for the AFC7.) 
 
Start Angle:   The angle in degrees of the start position. 
 
End Angle:   The angle in degrees of the ending position. 
 
Width:   The width of one image, in degrees.  
 
Step:   The angular distance between the start angles of two consecutive images 

in the scan. 
 
Number Images:   The number of images to be collected in the scan. 
 
Completeness: The percent completeness of the data in that scan. 

 
Start Number: The start number to assign to the first image of the scan.  

 
Exp Time: Specify exposure time in minutes. 

 
Total Images: Specify total number of images. 

 
Images Collected:   Images already collected, if any. 
 
Images Scheduled:   Images currently scheduled for collected during next collection run. 
 
Scheduled Start Angle:  The angle in degrees of the start position for currently scheduled 

images. 
 
Scheduled End Angle:  The angle in degrees of the ending position for currently scheduled 

images. 
 

1. Make adjustments to the settings as required.   
 
For example, if you wish to scan 90° of the crystal with a 0.5° image width, and scan every 0.5°, 
your settings may be:  
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  Start   
   Angle  

   End  
  Angle  

 
Width 

 
   Step 

       # 
   Images 

Complete- 
     ness 

 Start 
    # 

0.00 90.0 0.50 0.50 180 --- 1 
 
Right-click on column entries to Propagate (Down, Up, All).  This feature is helpful in setting the same 
parameter for several different scans. 
 
Time Estimate:   Calculated based on supplied values and number of images. 
 
Required disk space:   Amount of disk space required to complete the scheduled collection request.  
 
Total disk space (drive):   Amount of disk space currently available.  
 
Completeness : Completeness of data in the scan. 
 
 Note:  If insuffic ient disk space is available to complete the scheduled image collection request, 
a CrystalClear warning dialog will appear.  The collection request may be cancelled to allow the user to 
free more disk space on the system before continuing. 
 
See Create a Collect Schedule  on page 126 of Section 8 Additional Processing for more information 
about adding your own collection schedule. 
 
3. Click Run to start the scheduled collection scan. 
 The Double -Check Settings  dialog will appear. 
 

 
 
4. Review the specified settings on the detector. 
 
5. Click Start Image Collection.  
 
In the event CC detects that the available disk space is insufficient for the entire data collection, a dialog 
will appear to guide you through selecting a new collection directory.  You may need to “cancel” the 
data collection and free up space on the hard drive.  If you wish to delete the images and processing 
from an old sample (presumably with all necessary file archived), see Delete Projects and Samples on 
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page 97 in Section 7  Tool Reference  
 

Index Spots 
 
During the Index phase of processing your crystal data, CrystalClear will determine the unit cell 
parameters.  The settings specified in the Setup phase are used as a starting point in indexing the data. 
Indexing consists of finding spots, auto-indexing and refinement. 
  
Index with d*TREK (RAXIS or CCD) 

 
Find Spots  

 
The Find Spots step finds reflection centroids in a single image or a collection of images.  The reflection 
centroids are written to a file called the dtfind.ref file by default.  The found reflection centroids are 
subsequently used in an autoindexing or refinement step.  
 
In order for autoindexing and refinement to function properly, you should find 50-70 reflection 
centroids.  The exact number needed can vary depending on the centroid accuracy and location in 
reciprocal space.  The prerequisite for finding reflection centroids is knowledge of the properties of the 
images from which you are finding reflections.   
 
To find spots,  
 
1. Click the Find Spots button in the Flow Bar.  
 The Find Spots dialog will appear.  
 
Select images to be processed.  The Find Spots dialog allows the user to enter image numbers manually 
or select images numbers from a list.  Right-click on the To Use entry field to view menu options.  
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To enter image numbers manually in the To Use entry field, be sure to use a dash (-) to separate 
consecutive image entries and use a comma (,) to separate non-consecutive images entries. For example, 
you can enter images such as 2-5, 7, 9-12. Before clicking the Run button to Find Spots, de-select (un-
highlight) the To Use entry field to verify the selected image entries 
 
Right-click an entry field for further menu options as follows:  
 

  View Images List   Displays a list of image files  
  Select Scan   Allows user to select images of a scan 
  Clear Scan   Clears selected images of a scan 

 

 
 
View Images List menu option (right click on entry field) allows selection of image files. Before clicking 
the Run button, de-select (un-highlight) the To Use entry field to verify the selected image entries. 
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Column 1:  Image identification (Check in box denotes image selected) 
Column 2:  Axis of Rotation -  P = phi,  C = chi,  O = omega 
Column 3:  Start angle of the image. 
Column 4:  End angle of the image. 
 
 The sequence field changes with the selections. 
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2. Specify a Sigma level above the average background for a pixel to be considered a peak.   
 
If Sigma is 0, Find Spots processes faster because it does not calculate average background and its 
standard deviation.   
 
3. Click the Advanced tab to set display options. 
 

 
 
 
4. Specify a Minimum Pixel Value  for a pixel to be considered a peak.  
 
The Minimum Pixel Value is compared to non-uniformity corrected pixel values.  The actual threshold 
used is the maximum of Minimum and Sigma above the average background. 
 
5. Specify the Peak filter. 
 
The Peak size filter is specified as the number of pixels in a 3x3 area that must be above the threshold 
(Sigma, Minimum Pixel Value) for a peak to be considered a reflection.  If spots are large, you might 
want to make this 9. If the spots are small, you might make this 4.  Peak filter helps distinguish between 
true spots and noise in the images. 
 
6. Select 3D check box to perform a 3D search to determine peak widths for mosaicity refinement. 
 
 By default, a 2D search is automatically performed.  
 
7. Specify the Padding to be added.  
 
The padding is the number of images for 3D shoeboxes (in 3D search mode only) at the start and end in 
the rotation angle direction.  In order to completely contain a 3D peak with a 3D shoebox or volume, 
pad by 2-4 images and have a Box width and height large enough to encompass the reflections.  If any 
significant peak intensity is on the edge of a shoebox, CrystalClear rejects the centroid determined for 
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that peak.  Thus Padding is important to ensure that the peak goes down to background in the rotation 
angle direction. 
 
8. Specify the Box Width and Height, in pixels, of the box that appears around each spot in the 
display.  
 
In either search mode, if these are both set to 0, then CrystalClear will try to determine the box size for 
each spot automatically.  Of course, this will take extra computational power and time.  A good box size 
is 6 to 10 times larger than the biggest spot, but without intruding more than half way into neighboring 
spots. 
 
9. Specify the minimum and maximum resolution. 
 
10. When satisfied with your settings, click Run to find spots.  
 
The Find Spots feature will create the reflection file “dtfind.ref,” which will be used in the Index 
Spots step, and the log file dtfind.log. 
 

 
Index Spots  

 
The Index Spots feature indexes reflection centroids in the selected reflection list to elucidate the 
crystal unit cell dimensions, the crystal orientation, and the Bravais Lattice type.  
 
To index spots, 
 

1. Click the Index Spots button in the Flow Bar.  
The Index Spots dialog will appear.  
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2. If you know the Spacegroup, select the Known Spacegroup button, then select the Crystal System 
from the drop down list.  

 
A Spacegroup number of 0 indicates no user preference. In this case, the output header will have 
the lowest symmetry spacegroup consistent with the selected lattice type. 
 

3. The Reflection Lists  box displays the available reflection files. Select the file you wish to use for the 
Index Spots  procedure.  

 
4. Specify the desired Resolution range.  If you wish to change the default resolution, click Set.  See 

Set Resolution on page 119 of Section 8 Additional Processing for more information on the Set 
Resolution function.  

 
5. If you wish to select a solution manually, check the User Chooses Solution check box.  You will be 

prompted to select the desired solution from a list of solutions. If not set, the program will 
automatically select a solution.  The number of Bravais Lattices in the list will depend on the value 
set for Max Residual in the Advanced Tab (see below). 

 
6. If you wish to set all the values back to the defaults, click the Defaults button.  You will be 

prompted to select whether you wish to use Project level defaults or Site level defaults.  
 
7. Click the Advanced tab to set additional values.  
 

 
 
8. In the Max Cell Length field, specify the maximum cell length in Ångstroms to search.   
 

If this is 0, then CrystalClear tries to determine a maximum cell length on its own, which is subject 
to errors. 

 
9. In the Max Residual field, specify the maximum allowed least squares residual for a solution to be 
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listed.  
 
The program fits the reduced primitive cell to 44 lattice characters. Only those solutions with a 
residual less than or equal to Max Residual are displayed. Typically, residuals greater than 2.5 are 
not valid solutions.  The maximum residual is 100. The default of 2.5 reduces output and helps make 
it easier to choose the correct solution. If using the Rossman method, a residual of 1 or higher 
indicates either the wrong solution or misaligned hardware.  

 
10. In the Max Vectors field, specify the maximum number of difference vectors to use in the 

calculations.   
 
 With more difference vectors the calculations take more time and the residuals will be larger.  With 

fewer difference vectors, the calculations take less time and the correct solution may be missed.  If 0, 
CrystalClear picks a suitable number. 

 
11. In the Grid Size  field, specify the grid size in Ångstroms for the direct space Fourier map.   
 

This is not used if Use Fourier Method is not selected.  If 0, then the program selects an appropriate 
grid size. 

 
12. In the I/SigI field, specify the desired value. 
 
13.  From the Method drop down box, select a method.  The choices are:  
 

1D FFT: The DPS indexing algorithm of Steller, Bolotovsky, & Rossmann1 is used. About 7300 
different directions are examined by an 1D FFT algorithm for whether a principal cell axes is 
parallel to that vector.  Three of the vectors with the most order are selected for cell reduction. 

 
 3D Fourier: A 3D cosine Fourier is calculated over a real unit cell volume with grid points x. 
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where d*(i) is the reciprocal lattice vector for refln_i.  Peaks will appear in the Fourier function 
at the end points of the real cell axes a, b, c and linear combinations of these axes2. 

 
 Reciprocal Space: The reciprocal space method of Sparks is used3. 
  
 Cell reduction used as published by Andrews & Bernstein and Paciorek & Bonin4. 
 
14. If indexing fails, and you know the correct cell, select the Use known cell check box to force the 

program to look at vectors that match a known unit cell. 
 

Selecting this check box forces the program to look at vectors that match a known unit cell. The unit 
cell in the header is converted to a reduced primitive cell based on the Spacegroup.   The program 
will search for this reduced primitive cell. 

 
15. Check the Diffs  check box if desired. 

                                                 
1 Steller, Bolotovsky, and Rossmann (1997)  J. Appl. Cryst. 30, 1036-1040. 
2 Bricogne Proc. EEC Cooperative Workshop on Position-Sensitive Detector Software(1986) 3, 28. 
3 Pflugrath, J. (1997) Method of Enzymology v 276. 
4 Andrews & Bernstein (1988) Acta Cryst. A44, 1009-1018. 
  Paciorek & Bonin (1992) J. Appl. Cryst. 25, 632-637. 
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CrystalClear can use the vectors calculated from the reflection centroids (e.g. d(i)), or it can use 
difference vectors calculated from these vectors: d(i)-d(j). 
 
Difference vectors are useful if the detector position is not well established.  Difference vectors can 
be bad to use if the crystal is twinned or split 
  

16. If Use Known Cell is set, select whether to use Percent Error or Absolute Error within the 
Known Cell Parameters/Errors  group box.  

 
 The Use Known Cell is set, and the cell errors are specified here.  If these are 0, then a 3% error  is 

used. 
 
17. When satisfied with your settings, click Run to index the reflections.  
 
 

Overcome perceived problems 
 
If there are problems indexing, try the following: 
 
1. Make sure the detector, source and scan properties in the setup dialog are accurate.  In particular, 

make sure the detector translations (i.e. direct beam position on detector, crystal to detector distance) 
and the scan rotation axis are correct.  Make sure the calculated or input Max cell length is large 
enough. 

 
2. Make sure the crystal is not outrageously split, cracked, or twinned.  Expose images 90° and 45° 

away from the original image to double check this. 
 
3. Use a different image or set of images in Find to get reflection centroids. 
 
4. Use reflections from more than one image as input to indexing.  These images could be 10° or more 

separated in rotation angle.  Generally, the fewer images used, the better.  If the rotation axis is 
specified incorrectly (i.e. it has a slight tilt not specified in the input header), this could lead to 
problems.  However, small tilts in the rotation axis can be refined in the Refine module. 

 
5. Use 3D reflection centroids from a single wedge (a contiguous set of images) or from more than one 

wedge. 
 
6. Use a higher Sigma and/or Minimum cutoff in Find, or select reflections with the Combine 

Reflections task. 
 
7. Use a different number of Max diffs .  Both smaller and larger numbers could be tried. 
 
8. Use a different method of autoindexing. 
 
9. Try Use known cell if you know the unit cell dimensions. 
 
10. Accept a triclinic cell and refine the detector position, then re-index. 
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Refine Cell 
 
The Refine Cell feature refines the crystal, crystal goniometer, detector goniometer and source 
properties in order to reduce the differences between observed and calculated reflection centroids.  
CrystalClear can display the observed and calculated reflection centroids, so the progress and validity of 
refinement can be judged. 
 
A header file such as dtindex.head or dtrefine.head with complete information about the 
crystal, detector, source, and scan properties is required in order to refine cells (this is created by 
CrystalClear).  A reflection list with spot centroids such as dtfind.ref  (from the Find Spots 
procedure) is also required. 

 
A header file called dtrefine.head with refined crystal, detector, and source properties is created 
by the Refine Cell procedure.  A scratch reflection list with observed and calculated reflection centroids 
that can be plotted by CrystalClear will also be created, as well as a script file and an output log file 
(dtrefine.log). 
 
To refine parameters, 
 
1. Click the Refine Cell button on the Flow Bar.  
 The Refine  dialog will appear.  
 

 
 
2.  Specify any settings changes, as desired.  With the new refinement algorithms, it is recommended 
that all crystal, detector and source parameters except wavelength be refined initially.  It is rare that 
anything other than this is necessary.  
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3.  If desired, click the Advanced button to go to the Macro Editor which will allow the user to create 
a series of refinement steps varying the parameters refined for each step.  This is seldom used and if used 
is for extreme cases.  We leave it in the software for the exceptional case.  

 

 
 
4. Create a new macro by clicking the New Macro button.  
 
5. Click OK when done. 
 The Refine dialog will return. The Macro  you created will be in the list of Macros. 
 
5. Click Run to begin the Refine step.  

 
 The refinement process is complete when the number of cycles are completed.  If the delta/error, 

further refinement is needed.   
 
 
2D vs. 3D reflection centroids in refinement 
 
The size and pixel coordinates of reflections will change as they pass through the Ewald sphere due to 
crystal mosaicity, source divergence, and source bandwidth (∆λ/λ).  Thus, the reflection centroids will 
be different for 2D data and 3D data.  This is illustrated in Figure 1, which shows an 80 by 80 pixel 
portion of 3 adjacent images of 0.25° rotation width along with an overlay of these images (i.e. 0.75° 
width).  Each image was searched for spots, then ellipses were drawn centered on the observed spot 
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positions.  The overlay shows the shifts in the spot centroids.  Thus, the rms errors (lines 80-81 in the 
output, found in Appendix C, Refine Spots Log) from 2D data will be larger than from 3D data.  Also, if a 
2D reference profile is applied to a partial reflection while integrating with a profile-fitting method, the 
reference profile must be oriented properly. 
  
 
Refinement strategy 
 

The radius of convergence of the refinement algorithm is small so the starting properties should be very 
close before trying a refinement. This is usually the case if indexing has given a solution.  If the starting 
crystal and detector properties are not close to the true values, one might increase the Rejection Limits 
so more reflections are included in the refinement.  However, there is a danger they will be increased too 
much and refinement will proceed to a false minimum. It is sometimes better to use only low-resolution 
reflections at first because the radius of convergence with them is larger.  Then use high-resolution 
reflections to get the more accurate results.  With good reflection centroids, it is best to use all 
reflections. 
 
The refinement algorithm should be used to refine all parameters from the first.  If this is not successful, 
it is useful to fix or not refine a property.  In the Refine Window a checked box means a property is 
refined, so uncheck the check box to fix the property.  Some properties are not refined because of the 
choice of spacegroup.  For example, in orthorhombic cells α, β, and γ are not refined.  With input 
reflections found in a single image, the crystal rotation around the source and the detector rotation 
around the source are correlated, so one of them should be fixed (unchecked). The same is true for the 

 
Overlay of above 3 images. 

Figure 1.  2D vs. 3D spot considerations 

0.25° - 0.50° 
 

0.50° - 0.75° 

 

 
0.00° - 0.25° 
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detector translation along Y and the detector rotation around X (the swing angle).  It is a good idea to fix 
one of them.  With input reflections from widely spaced rotation values, these correlations should not be 
a problem. The crystal to detector distance can be refined even with reflections from a single image, 
especially with a tetragonal or higher spacegroup.   
 
Sometimes refinement works better if you fix most properties and refine only a few at a time.  Common 
sense should dictate the order of properties that are fixed and refined.  For example, if you know the unit 
cell parameters from previous work, then a, b, c and  α, β, γ can be initially fixed.  If the detector has just 
been moved, refine the detector translations first, then the crystal orientation angles, then the unit cell 
parameters, then everything.  The detector distance should be fixed if there are reflections from a narrow 
rotation range and a crystal principal axis is nearly parallel to the source. For any changed settings to 
take effect, you must click RUN or SAVE.  
 
The refinement scheme used is stored in an output header and is also used during integration.  Every few 
images (specified by the Integrate dialog Batch option), the integrated reflection centroids are used to 
refine the crystal and detector properties.  Thus, the settings of the Refine window are important for 
integration, too.  
 

 
Predict Spots 

 
The Predict Spots feature predicts the reflections that would appear on a range of images.  It is typically 
used to confirm the results of the refinement step and to better estimate the crystal mosaicity if it was not 
refined previously, as would occur if 2D data were used for indexing.  Predicted reflections are written to 
a file, dtpredict.ref. 
 
The Predict Spots feature creates a reflection list file with calculated reflection centroids that can be 
plotted and displayed.   
 
To predict spots, 
 
1. Click the Predict Spots button on the Flow Bar.  
 The Predict Spots dialog will appear. 
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2. Specify the image or images to be processed. To specify a sequence of images, select Use Sequence .  

Then select the desired images in the To Use entry field.   
 
The Predict Spots dialog allows the user to enter image numbers manually or select images 
numbers from a list.  Right-click on the To Use entry field to view menu options. 

 
To enter image numbers manually in the To Use entry field, be sure to use a dash (-) to separate 
consecutive image entries and use a comma (,) to separate non-consecutive images entries. For 
example, you can enter images such as 2-5, 7, 9-12. Before clicking the Run button to Predict 
Spots, de-select (un-highlight) the To Use entry field to verify the selected image entries 

 
Right-click an entry field for further menu options as follows: 

 
  View Images List   Displays a list of image files  
  Select Scan   Allows user to select images of a scan 
  Clear Scan   Clears selected images of a scan 

 
3. Set the Resolution range in Ångstroms.  If you wish to change the default resolution, click Set.  See 

Set Resolution on page 119 of Section 8 Additional Processing for more information on the Set 
Resolution function. If resolution is set to 0.0 and 0.0, the resolution is set to be the entire resolution 
possible on the image. 

 
Only reflections that will appear on the detector are predicted, but the resolution range may be 
restricted further with this option.  
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4. Specify the desired Crystal mosaicity. 
 
 If not 0, the specified crystal mosaicity overrides the value found in the input header.  In addition, a 

new header will be written with the updated value for crystal mosaicity. 
 
1. To use a mask, click the Advanced tab. 
 

 
 
3. Click the Apply Mask check box, if desired.  
 
4. Click Run to predict spots. 
 

For information on masking, see the erasure tools in  Small Image Window Toolbar on page 134 of 
Section 9  Images 

 
 
Index with TwinSolve (Mercury CCD) 

 
Twinned crystals require special processing to be resolved. CrystalClear includes the TwinSolve 
processing module, which can be use to process twinned crystals.   
 

Find Spots 
 
To find spots,  
 
1. Click Find Spots on the Flow Bar. 
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 The Find Spots dialog will appear.  
 

 
 
2. Select the images to be used to find spots.  

 
You can either select the desired images from the Image List, or specify a single range of image 
sequence numbers in the Sequence  edit box.  
 
We recommend that you perform a find on all the images from the first scan of data, then repeat the 
find step using all the images from each subsequent scan of data checking the “Append spots to the 
current spot list” box.  This will use all of the reflections resulting in better determination of the twin 
components. 
 

3. Specify the Neighbor Distances.   
 
 The neighbor Distance is the distance between spots in pixels.  Specify the distance for the X, Y and 

Z axes. The default values of 7, 7, and 3 are sufficient for most samples.  
 
4. Specify the size of spot to find in the Spot Size  edit box.  
 
 The default value of 15 is sufficient for most samples. 
 
5. Specify the Peak Threshold, analogous to I/sig in D*TREK Find Spots. 
 
6. Click Run when satisfied with your selections. 
 
 

Index Spots 
 
To index spots,  
 
1. Click Index Spots  on the Flow Bar.  
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 The Index Spots  dialog will appear.  
 

 
 
2. Specify the reflections by selecting the appropriate radio-button.  
 

3. If desired, check the Use Known Unit Cell check box, then specify the unit cell values. 
 
4. Make any desired changes in Vector  and/or Deviation. 
 
4. Click Run when satisfied with your settings.  
 
 

Refine Cell 
 

The Refine Cell feature refines the crystal, crystal goniometer, detector goniometer and source 
properties in order to reduce the differences between observed and calculated reflection centroids.  
CrystalClear can display the observed and calculated reflection centroids, so the progress and validity of 
refinement can be judged. 
 
To refine cells, 
 
1. Click Refine Cell on the Flow Bar.  
 The Refine  dialog will appear. 
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2. Click Run.  
 
 

Save Twin 
 
1.  Click Save Twin to save the current component.  Return to Index Spots to index the remaining 
reflections and repeat the above steps until you are satisfied that you have found all of the twin 
components. 
 
 

Get Twin Relationship 
 
When you are satisfied that you have found all of the twin components click the Get Twin Relationship 
on the Flow Bar.  This will print the rotation angle and the orientation matrix between all the 
components. 
 
 

Predict Spots 
 

To predict spots,  
 
1. Click Predict Spots on the Flow Bar.  
 The Predict dialog will appear.  
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2. Select the images to be processed.  

You can either select the desired images from the Image List, or specify a single range of image 
sequence numbers in the Sequence  edit box.  
 

3. Specify the Expected Spot Size  for the Z axis, in degrees, 0.9 should be used as a default value. 
 
4. If desired, check the All twins  check box. 
 
5. If desired, check the Alpha2 spots check box. 
 
6. Click Run.  
 
If you are satisfied that you have a rotationally twinned sample, please contact Rigaku/MSC for the latest 
command line version of the TwinSolve module and further instructions on integrating your sample. 
 

Strategy 
Strategy can be used to automatically generate a collection schedule so you don’t have to. Results are 
written to the file dtstrategy.log and are readily displayed within CrystalClear. 
 
To process Strategy, 
 
1. Click Strategy on the flow bar.  
 The Strategy dialog will appear. 
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2. In Search Resolution group box, make changes to setting by clicking Set button. 

The Set Resolution dialog appears:  
 

 
 
For assistance in using the Set Resolution dialog, see page 119 in Section 8 Additional Processing. 

 
3. Click the Advanced tab. 
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4. In Speed/Accuracy group box, make appropriate selections: 
 

• Very Fast 0.3 
• Fast  0.6 
• Accurate 1.0 
• Custom  Set by user 

 
5. If desired, make changes in Result Limit and/or Search Rotation group boxes. 
 
6. If you wish to Use Previous Reflections , check the box.  Select the Previous Reflection by using 

the down-arrow. 
 
7. If you with to use defaults from other projects, click the Defaults… button. 

The Get Defaults dialog appears. 
 

 
 
8. If you wish to Save, click the Save button. 

The Default Manager dialog appears. 
 

• For assistance using the Default Manager, see page 209 in Appendix F: Defaults in 
CrystalClear. 
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9. When all desired settings are selected, Click Run. 
 
 

Integration 
The Integrate function predicts the reflections which would appear on a range of images. This process 
may produce several reflection files.  These files are merged as part of the Integrate function.  
 
Integrate with d*TREK (RAXIS or Mercury CCD) 
 
Integrated reflections are written to the file dtintegrate.ref and are readily displayed within 
CrystalClear. 
 
To integrate images,  
 
1. Click the Integrate Reflections  button on the Flow Bar.  
 The Integrate Reflections dialog will appear. 
 

 
 
2. Specify the images to be integrated. To specify a sequence of images. Then select the desired images 

in the To Use entry field.   
 
The Integrate Reflections  dialog allows the user to enter image numbers manually or select images 
numbers from a list.  Right-click on the To Use entry field to view menu options. 

 
To enter image numbers manually in the To Use entry field, be sure to use a dash (-) to separate 
consecutive image entries and use a comma (,) to separate non-consecutive images entries. For 
example, you can enter images such as 2-5, 7, 9-12. Before clicking the Run button to Integrate 
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Reflections , de-select (un-highlight) the To Use entry field to verify the selected image entries 
 

Right-click an entry field for further menu options as follows: 
 

  View Images List   Displays a list of image files  
  Select Scan   Allows user to select images of a scan 
  Clear Scan   Clears selected images of a scan 

 
3.  Set the desired Resolution. If you wish to change the default resolution, click Set. If you specify 0.0 

for both the minimum and maximum values, all reflections on the detector are predicted and 
integrated. See Set Resolution on page 119of Section 8 Additional Processing for more information 
on the Set Resolution function. 

 
Resolution sets the resolution range of reflections to predict and integrate.  Remember that low 
resolution reflections may be blocked by the beam stop, while high resolution reflections may be 
limited by the detector swing or edges. 

 
4.  In the Box Width and Height fields, set the integration box size in pixels. 
 

Be sure to choose a Box size that completely encloses the Bragg reflection and allows for changing 
spot shape and shifting spot positions due to misalignment of the hardware and/or a slipping crystal. 
A typical box size will be 6 to 10 times the spot dimensions. The larger the values of Width and 
Height, the more memory CrystalClear will use. It is normal and OK if neighboring reflections 
intrude into this box  this will be predicted and excluded, but it should not intrude by more than 
one-half through the image. 
 

5. In the Padding field, specify the number of images to include in a three-dimensional integration 
volume (a shoebox) both before and after the predicted rotation width of a Bragg peak.  

 
Padding allows for (1) a shift of the predicted peak position, (2)  a change in crystal mosaicity, and 
(3) background pixels before and after the Bragg peak that lie on the Ewald sphere.  The larger the 
value of Padding, the more memory CrystalClear will use. 

 
6. Specify the Images Per Batch. 
 

This value is the number of images that are treated as a batch.  Refinement is done after every batch 
of images with the centroids of strong reflections found in the images.  Reflections in the batch of 
images will all have the same Batch field in the dtintegrate.ref and dtprofit.ref files.  
The larger the value of Images Per Batch, the more memory CrystalClear will use.  You may wish to 
strive to have 100-1000 reflections per batch, so for crystals with large unit cells, you may set 
Images Per Batch to 2 or 3, while for crystals with small unit cells, you may set Images Per Batch 
to 10-20. 

 
7. In the Peak Radius  field, specify the minimum and maximum reflection radius to use.  
 

This is a measure of the minimum radius of a reflection in pixels.  Since spot shape is automatically 
determined, this minimum radius should be smaller than the actual spot, so that the algorithm can 
use it is as a seed from which to grow the spot shape.  The maximum radius should be larger than 
the biggest peak but smaller than one-half the box size. The shape of weak reflections is determined 
from nearby strong reflections. 

 
8. Specify a Batch prefix to use for batch IDs or names given to reflections in the output reflection 
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lists.   
 

Use this option to distinctly label reflections from different scans and/or crystals. The prefix should 
not be longer than 4 characters. If no prefix is specified here, a batch prefix may be added to any 
reflection list at a later time 
 

9. Click the Advanced tab. 
 

 
 
10. In the Profile Analysis group box, select whether you want CrystalClear to automatically pick a 

profile size, use no profile size (None), or define your own profile size.  
 
 If you select User-Defined, specify the sizes of the transformed local Kabsch 3D profile in degrees.   
 

The Size 1 value is the angular spread of a reflection in directions tangent to the Ewald sphere, 
while the Size 2 value is the angular spread of a reflection in the direction perpendicular to the 
reciprocal lattice vector when in the diffraction condition.  Good starting values are 0.5 * arctan 
(spot_size / crystal_to_detector_distance) and max(crystal_mosaicity/3, 2 * image_rotation_width).  
These are the same as the Kabsch XDS parameters DIVRAD and DIVBET.  For either, if a value of 
0 is used, then an appropriate value is calculated.  For either, if a negative value is used, then 
profile analysis is not performed. 

 
11. Specify the maximum number of seconds to wait for a required image to appear before stopping in 

the Wait Limit field.  
 
 The value of 0 means do not wait, so if an image cannot be found, integration will finish. 
 
12. Select the Refinement Macro to be used.   
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 The choices are:  

• Crystal, then all detector 
• Detector, then all crystal 
• Low reso, then all reso 
• Single Step Refine 
• All 

 
13. Select the Pre-refinement to be used. 
 

The choices are: 
• None 
• First image 
• First & Last 
• First, Last & Middle  
• 1st images of 3 batches 
• All images of 5 batches 

 
14. In the Ice Rings  box, make desired entries in the Min Resin and Max Resin fields, if necessary.   
 

Click the Add button, the Ice Ring  dialog will appear prompting the user to enter the Min and Max 
resolutions of the Ice Ring.   
 
Alternately, Min and Max resolutions can be entered by clicking and dragging on the displayed 
image.  This method provides a visual representation of the Ice Ring , as well as providing numerical 
values in the entry fields. 

 

 
 
15. Click Run to integrate reflections.  
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Analyzing the Data 
 
Once integration is completed, you may wish to analyze the data for purposes of evaluating and 
determining Laue symmetry, centricity, and spacegroup.  Additionally, cell transformations and cell 
reduction tools are available here.  
 

Click Data Analysis on the Flow Bar.   
Several buttons become available. 

  
Laue Symmetry 

 
1. Click Laue  on the flow bar. 

The Laue dialog will appear. 
 

 
 
2. Select the Reflection List file to use (generally dtprofit.ref).  
 
3. Make other adjustments to settings as follows: 
 

Max R-merge Tolerance for considering a Laue class present 
Highest Laue Symmetry Limits the highest Laue class to be checked. 
Only check Laue groups compatible with 
current cell 

Unchecked, examines all Laue classes 
compatible with current cell 

Average Bijvoets (Assume 1+ = 1-) Unchecked examines Laue classes desired 
 

 
4. Click Run. 
 
 

Centricity 
 
1. Click Centricity on the Flow Bar. 

The Centricity dialog will appear. 
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2. Select the Reflection List file to use (generally dtprofit.ref).  
 
3. Click Run. 
 

 
 
4. Check the evaluation of centricity  

Select the correct centricity if it is not already selected 
 

5. Click OK  
 
 

Spacegroup 
 
1. Click Spacegroup on the Flow Bar. 

The Spacegroup dialog will appear. 
 

 
 
2. Select the Reflection List file to use.  
 
3. Select the <I/Sig> value above which the reflections in the parity class will be considered present  
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4. Click Run. 
 
5. Carefully look through the table and evaluate if the <I/Sig> should be raised or lowered.  Repeat the 

run after you have made adjustments.  
 
 

Scale and Average 
 
The Scale and Average step calculates and applies scale factors to different batches of reflections in an 
input reflection list, averages symmetry equivalent reflections, calculates merging and completeness 
statistics, and creates a reflection list of unique reflections. 
 
Scale with d*TREK (RAXIS or Mercury CCD) 
 
To Scale and Average your data,  
 
1. Click the Scale and Average button on the Flow Bar. 
 The Scale and Average dialog will appear.  
 

 
 
2.  The Reflection Lists  box displays the sample reflection list files.  Select a reflection file.  
 
3. In the Algorithms  box, select the corrections to be applied.  More than one may be applicable. 
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4. In the Absorption Correction group box, specify Method to use.   
 

• Fourier 
• Spherical 4,3 
• Spherical 3,2 

 
In order to perform an Absorptive Correction, the user must choose Absorption Correction from 
the Algorithms  box (see Step 2).   

 
 If None is selected, specify Max Cycles also to perform Fox and Holmes scaling. 
 

 If a method other than None is selected, the REQAB program of Dr. R. Jacobson is used to 
calculate and apply scale factors. The REQAB program usually gives the best results. 

 
5. Specify the number of Max Cycles. 

 
This option refers to the maximum number of non-linear least squares cycles to perform.  If the 
refinement converges, the maximum number of cycles may not be reached.  No shifts are applied to 
the last cycle. 

 
6. In the Error Model group box, specify a Weight Multiplier and Weight Addend. 
  
7. Specify a value for Exclude Sigma. 
 

Input reflections with Intensity/sigma less than Exclude sigma are excluded from contributing to the 
scale factor refinement.  However, these reflections are included in the final statistics and output 
files. 

 
8. Specify a value for Rejection Sigma. 
 

This field sets the rejection level for reflections measured more than once.  Reflections with scaled 
intensities differing by more than Rejection sigma from the weighted average intensity calculated 
from other symmetry-related measurements are flagged as rejected by setting their observed 
standard deviations to be negative. 

 
9. If the user wishes, selection of rejected reflections may be based on Chi^2 values (reflections above 

set value of Chi^2 are rejected) or Max Fraction values (only the worst reflections up to this 
fraction of total number of reflections are rejected.) 
 

10. In Scaled, Averaged Output File , specify a name for the output file. 
  

 Click the Advanced tab to set advanced values.  
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11. Specify the desired Resolution.   
 

If you wish to change the default resolution, click Set.  See Set Resolution on page 119 of Section 8 
Additional Processing for more information on the Set Resolution function. 

 
12. Set the Scaling Constraints. 
 

Batch ID: Specifies the name of the batch whose scale factors will remain fixed.  The scale 
factors of all other batches will shift relative to this batch.  Default: first batch in the 
input reflection list. 

 
Scale Factor: Specifies the scale factor of the fixed batch.  All shifted scale factors are rescaled, 

so this value remains fixed.  Default: 1. 
 

B-factor:  These options are only available when None is selected for the Absorption 
Correction Method list box on the Main tab.  

 
13. If you desire Optional Output file, click the appropriate option, then specify a name for the output 

file in the Output Name  edit field.  
 

If set, the scaled, but unaveraged, reflections are written to the specified file.  This may be useful for 
further scaling or for use with other averaging and rejection algorithms.  Reflections rejected by the 
scaling process will have their fSigmaI values set to 0 or less. 
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Check the Output hkl, I, SigI, No Header check box if you want the output file to include only the 
h,k,l, Intensity and sigmaI fields in free format, with no header.   

 
Rejected measurements (sigmaI <= 0) will be excluded from this file.  This format is suitable for 
input to many non-d*TREK programs such as teXsan for subsequent processing. 
 

14. When you are satisfied with your settings, click Run to run the Scale and Average step.  
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7  Tool Reference 
 
CrystalClear provides tools for the following functions:  
 

• Create, open, save and delete Projects and Samples 
• View, edit and set CrystalClear state information 
• Create new processing state 
• Display scan state 
• View instrument state display 
• Manually control X-ray instrument 
• Set user preferences  
• View log files 

 

Create a New Project and Sample 
 
When a new Login Name  and Password are used, the New Project Wizard assists the user in setting 
up the first project and sample.  A complete description of this process is available in Section 4 Running 
CrystalClear for the First Time on page 27.  Once the initial project is set up, additional projects and 
samples are created using the following procedure.   
 
1. Start CrystalClear and log in.  
 The Open Sample  dialog is displayed. 
 

• Alternatively, the Open Sample dialog can be accessed on the CrystalClear menu.  Click File > 
New Sample or New Project to create a new project and sample. 

 

   
 
The project/sample listed in the entry field(s) is the project/sample most recently updated by the user. 
Additional projects/samples can be viewed and/or selected by clicking the  appropriate down arrow(s).  
 

If the New Project Wizard appears, rather than the Open Sample dialog, it means CrystalClear did 
not find an existing project database file. Follow the steps in Section 4 Running CrystalClear for the 
First Time on page 27 to set up the first project and sample, or see your administrator.  
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2. To create a new project, click the New Project radio button.  
The existing project name will be highlighted. 
 

3. Type the new project name in the Project edit field.  This will replace the existing text.  

4. Click and highlight the existing Sample name.  Type the new sample name in the Sample  edit field. 
This will replace the existing text. 

5. Select the task you wish to use for this sample from the Task drop down list. 

6. Specify the directory with the images for this project. Type the full directory name in the Image 
Directory field.  If image files already exist, select using the Browse button.  

 

CrystalClear can be used to process data collected previously.  Images collected with CrystalClear, or 
other software, should contain header information with common filename extensions.  Images collected 
with the Rigaku R-Axis detector use filename extension .OSC.  Images collected with the Rigaku 
Mercury or Jupiter CCD detector use filename extension .IMG.   
 
CrystalClear will support .IMG (CCD), .OSC (RAXIS), and .STL (RAXIS) image files.  CrystalClear 
will also support Bruker, MAR CCD, MAR IP, ADSC CCD, MacScience, Brandeis CCD, and 
MedOptics image files. 
 
 

Create a New Sample 
 
Following the first Login to CrystalClear, at least one project and sample had been created in the user’s 
database.  
 
To create additional samples,    
 
1. Start CrystalClear.  Enter your Login Name  and Password. 

 
The Open Sample  dialog will appear. The names listed in the entry fields are the Project and 
Sample most recently updated by the user. Additional projects and samples can be viewed and/or 
selected by clicking the appropriate down arrow. 
 

• Alternatively, the Open Sample dialog can be accessed with the Toolbar icon .   
• The Open Sample dialog can also be accessed from the CrystalClear menu.  Click File > New 

Sample to create a new project sample.   
• The Open Sample dialog can also be accessed with the shortcut (Ctrl+N). 
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2. Click the New Sample  radio button. The existing sample name will be highlighted. 
 
3. Type the new sample name in the Sample edit field.  This will replace the existing text. 
 
4. Select the desired project from the Project drop down field.  
 By default, the last project you worked on will automatically be selected. 

5. Select the task you wish to use for this sample from the Task drop down list.  

6. Specify the directory with the images for this project.  Type the full directory name in the Image 
Directory field.  If image files already exist, select using the Browse button.  

 

 

Open an Existing Sample 
Following the Login procedure for CrystalClear, the Open Sample  dialog appears.  The Project and 
Sample  listed in the entry field are those most recently opened by the user. Other Projects and Samples 
can be accessed by clicking the down arrows. 
 

• Alternatively, access the Open Sample dialog with the Toolbar icon .   
• The Open Sample dialog can also be accessed with the shortcut, (Ctrl+O). 
• The Open Sample dialog can also be accessed from the CrystalClear menu.  Click File > Open 

Sample to open a sample.   
 
1. Following the Login procedure,  

the Open Sample  dialog will appear.  
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2. Select the desired project from the Project drop down list.  
 
3. Select the desired sample from the Sample  drop down list.  
 
4. Click OK.  
 
 

Close the Current Sample 
When CrystalClear closes a sample, the changes made during that work session may be saved or 
discarded.  
 
1. To close the current sample, click File > Close Sample . 

The following CrystalClear dialog will appear,  
 

 
 
This dialog allows the user to save changes made to a sample, or discard changes made during that 
session. Once the sample is closed, the user is free to open another sample or create a new project or 
sample.   
 
 

Save the Current Sample 

To save an open sample, click the Save Sample  button on the Toolbar . 
 
If a new sample is created when another sample is current, CrystalClear saves and closes the current 
sample. Upon exiting CrystalClear, the current sample is saved and closed. 
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• Alternatively, access the save feature from the CrystalClear menu.  Click File > Save Sample to 

save the current sample.  
• The save feature can also be accessed with the CrystalClear shortcut, (Ctrl+S). 

 
 

Delete Projects and Samples 
 
To delete a project or sample from the CrystalClear database,  
 
1. Click File > Delete Projects/Samples. 
 

If a current sample is open, the following CrystalClear dialog appears.  If you wish to close the 
current sample and continue the delete procedure, click Yes. 

 

 
 
 

The following CrystalClear dialog appears. To continue with the delete procedure, read the warning 
and click OK. 
  

  
 
 The Delete Projects/Samples dialog will appear.  
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2. Select (highlight) the project or sample you wish to delete, then click the appropriate Delete 

Project(s) or Dele te Sample(s) button.  
 

The project or sample will be removed from the CrystalClear database.  These files will also be 
removed from the actual files and directories where the project and sample files were stored. 
 
WARNING!  Selecting a Project will delete the Project and ALL Samples within that Project.  

 
 

Processing State - View, Edit and Set 
 
The processing state is a collection of crystal and instrument parameters associated with each step of 
processing the data. A Processing State consists of default, calculated or refined crystal, detector, and 
source values. For example, a current sample is in one state following Index Spots and in a different state 
following Refine Cell.  The Processing State of the current sample can be viewed while processing the 
data.   
 
To view the Processing State Display window, 
 

1. Click the Show Processing State Display toolbar button .  
The Processing State Display window will appear. 
 
• Alternatively, access Processing State Display from the CrystalClear menu. Click View > 

Processing State Display. 
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The information in the Processing State Display is as follows:  

 
Current State: The current processing state is displayed. 

 
State History: Previous states are displayed in a drop down list.  If desired, one may select a previous 

state and set it as the current state. 
 
Scans:  Click the down arrow to view a listing of scans   
 
Crystal: Settings for the crystal can be viewed and changed. These are the same settings as in the Setup 

dialog on the Crystal1 and Crystal2 tabs.  
 

Spacegroup: Settings for the Spacegroup can be viewed and changed. These are the same  
settings in the Setup dialog on the Crystal2 tab. 

 
Detector: Settings for the detector are specific for the scan.  Settings can be viewed and changed. These 
settings are the same settings as in the Setup dialog, Detector tab.  If the values in the Scans  field are 
changed, the Detector settings may change. 

 
Source: Settings for the X-ray source can be viewed and changed. These are the same settings as in the 

Setup dialog on the X-ray Source tab. 
 

The settings in the Processing State Display are the same settings in the Setup dialog. The Processing 
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State Display presents different view.  This display is accessible during data processing. 
 
To change the current state,  
 
1. Click the State History drop down list. 
 
2. Select the desired state.   

 
3. Check the values in all fields.   

If correct, click the Set As Current button.  
 
 All parameters will be set to the values that were active during the selected state.  
 
 

Create a New Processing State 
 
You can create your own processing state, as well as selecting an existing state.   
To create a custom state,  
 

1. Click the Show Processing State Display toolbar button . 
 The Processing State Display dialog will appear. 
 

• Alternatively, access Processing State Display from the CrystalClear menu. Click View > 
Processing State Display. 
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2. Select the state that is most like the new state you wish to create from the State History drop down 

list. 
 
3. Change the desired parameters in the Processing State Display window.   
 

Save Changes to New State  or Discard Changes.  If you want to go back to the original settings, 
click the Discard Changes button. Discard Changes  sets all the current parameters back to the 
values active during the previous state . 

 
4. Click Save Changes To New State . 
 The New State dialog will appear. 
 

  
 
5. Type a name for your new state and click OK.  
 
 The New State will automatically become the current state. The New State will be saved with the 

sample, along with all other states  The New State will be placed in the State History list..  
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View the Scan State Display 
 
The Scan State Display shows all image information relevant to the current sample.  All images and 
scans available for collection and processing can be viewed.  The Scan State Display also allows the 
user to modify scans.  
 
To view the Scan State Display window, 
 

1. Click the Show Scan State Display button on the toolbar .  
 

The Scan State Display window will appear. CrystalClear displays a window specific to the Image 
Collection Device Type selected; namely R-Axis, Jupiter CCD, or Mercury CCD.  

 
• Alternatively, click View > Scan State Display on the CrystalClear menu. 

 
The information reported on the Scan State Display is as follows: 
 

Screen group box contains: 
 

Schedules: Use the down-arrow to view additional Schedules.  User may Add, Delete , or 
use Manager on Screen Schedules. 

 
Scan Table : User may Add Scan or Delete Scan on the Scan Table , then make changes to 

scan settings, as desired.   
 

For assistance in manipulating the Scan Table  columns, headings or other 
settings, see Using the Scan Table  on page 103 of Section 7  Tool Reference.  

 
Collect group box contains: 

 
Schedules: Use the down-arrow to view additional Schedules.  User may Add, Delete , or 

use Manager on Collect Schedules. 
 
Scan Table : User may Add Scan or Delete Scan on the Scan Table , then make changes to 

scan settings, as desired..   
 

For assistance in manipulating the Scan Table  columns, headings or other 
settings, see Using the Scan Table  on page 103 of Section 7  Tool Reference.  

 
Save: When Save is clicked, the Default Manager appears.  For assistance, see Using 

the  Default Manager on page 209 of Appendix F: Defaults in CrystalClear.  
 

Sync with Disk: In a Process task, Sync with Disk updates the image directory on the 
drive and updates the Scan State Display.  This is a valuable option if 
more images are available than when the sample was initially created.  

 
 
 If the R-Axis is the Image Collect Device Type , the following window will appear. 
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If Mercury CCD is the Image Collection Device Type , the following window will appear.  
 

 
 
 
Using the Scan Table 

 
The Scan Table is useful in changing various settings of scans in a Collect Schedule.  The Scan Table 
consists of a series of manageable columns and column headings.  The user can manipulate the Scan 
Table, allowing columns to be viewed or hidden, and columns widths can be changed.  The Scan Table 
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is used to edit the various settings within a scan, to serve their particular needs within a Collect 
Schedule.  Using the Scan Table consists of: 
 
Manipulating the Scan Table: Assisting the user in viewing the Scan Table  by clicking, dragging, and 

viewing columns. 
 
Editing the Scan Table: Assisting the user in altering the individual scan settings within the 

columns to achieve the desired Collect Schedule . 
 
The Scan Table  is accessible on the Collect Images dialog and on twice the Scan State Display. 
 

• To access the Collect Images dialog:  Click the Collect Images button on the Flow Bar 
during a Collect task.  

 
(Task drop down list options: Screen Collect and 
Process, Collect and Process, or Collect.) 

 

• To access the Scan State Display: Click the Show Scan State Display button  on the 
toolbar.  

 
Or, click View > Scan State Display on the 
CrystalClear menu. 

 
The Collect Images dialog and the Scan State Display window displayed in CrystalCle ar is 
specific to the Image Collect Device Type selected; namely, R-Axis, Jupiter CCD, or Mercury 
CCD.  Even if your display is different from that illustrated in this manual, the instructions are 
the same.  

 
The following Scan Table  appears on the Collect Images dialog, and twice on the Scan State Display: 
 

 
 
The Scan Table  contains the following column headings: 
 

Scan ID:  Scan identification number. 
 

Template: Base name of the image. 
 

Detector Distance(mm):Crystal to Detector distance. 
 

2-Theta(deg): 2θ offset of the detector. 
 

Max Resolution: Specify maximum resolution in degrees. 
 

Wavelength(λ): Specify the wavelength of your X-ray source.  The wavelength is based 
on the Element type.  When you selected an Element, a valid 
wavelength will be selected automatically. 
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Phi(φ): Specify the position of the crystal goniometer in degrees. 

 
Rotation Axis: Phi (φ). (Phi (φ) is normally used for the R-Axis. 

 
Start Angle: The angle in degrees of the start position. 

 
End Angle: The angle in degrees of the ending position. 

 
Width: The width of one image, in degrees.  

 
Step: The angular distance between the start angles of two consecutive images 

in the scan. 
 

Number Images: The number of images to be collected in the scan 
 

Completeness: The percent completeness of the data in that scan. 
 

Start Number: The start number to assign to the first image of the scan.  
 

Exp Time: Specify exposure time in minutes. 
 

Total Images: Specify total number of images. 
 

Images Collected:   Images already collected, if any. 
 
Images Scheduled:   Images currently scheduled for collected during next collection run. 
 
Scheduled Start Angle:  The angle in degrees of the start position for currently scheduled 

images. 
 
Scheduled End Angle:  The angle in degrees of the ending position for currently scheduled 

images. 
 
 

Manipulating the Scan Table 
 
The Scan Table  can be easily manipulated using the computer mouse.  Right-click on the various 
column contents or the column headings, or click and drag columns. 
 

• Right-click any column heading:  All Columns  menu appears.  This allows the user to select, 
de-select individual columns to be displayed  If all column 
headings are selected, all columns are displayed. 

 
• Right-click Schedule heading: A Schedule All/Clear All  menu appears, in addition to the 

All Columns menu. 
 
• Click and drag heading lines Dragging a vertical column line allows the user to widen 

column widths to view a column heading.  Making columns 
narrow allows the user to fit more columns  into  the 
viewing area.  Dragging on horizontal lines expands depth 
of the table. 
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• Right-click column entries: Depending upon the particular column entry, a useful pop-

up menu appears: 
 

o View Images – Set All – Unset All 
o Propogate – Down – Up - All.   
o Autoset 

 
 

Editing the Scan Table 
 
Editing the Scan Table  allows the user to change settings in various scans in a Collect Schedule .  After 
using the Add Scan button, changes in column entries/values can be made. 
 
1. When the Add Scan button is used, scans are added to the list.   
 

Each image is named by using the Scan Template Name, then adding on a numeric value.  The 
number will increment by one with each added image, and is usually four digits long.  

 
A filename extension, such as .osc (for R-AXIS images) or .img (for CCD images) completes the 
filename.  For example, for the Project-Myoglobin and Sample -My, if the Root Image Name is 
Myo3, and the Start #  is 1; then the image files will be named Myo30001.osc, Myo30002.osc 
,Myo30003.osc., and so on. For Collect Sample, the Scan Template name defaults to the Sample 
name.  

 
2. Double-click in the Start Angle  field to specify the starting angle for the scan. 
 
 Initially, this field may be set at 0.00 or set at the angle determined in the Strategy step.  However, if 

a scan should be stopped for some reason, the Start Angle  should not be reset in order to continue 
the scan. 

 
See Strategy on page 80 of Section 6 Data Collection and Processing for assistance if necessary. 

 
3. Double-click in the End Angle  field and specify the ending angle for the scan.   
 

For example, if images are to be collected over the first 90 degrees of the sample, specify 90.0.  
 
4. Double-click in the Image Width field and specify the width of an image in the scan.   
 

Commonly the image width is 0.5 degrees. 
 

5. Double-click in the Exposure Time (min) field and specify the length of time for the exposure. 
Units for the exposure time can be in minutes or seconds, depending on the procedure.   

 
Refer to General Settings on page 141 of Appendix B:  Administration.  Additional information 
about changing the unit of exposure time is in Set User Preferences on page 110 of Section 7  Tool 
Reference  

 
7. Double-click in the Start # field and specify the starting number for the images. 
 

The # Images and the Completion Time fields will be calculated automatically based on the values 
assigned in the various parameters.  
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8. Make other adjustments to the settings as required.   

 
For example, if you wish to scan 90° of the crystal with a 0.5° image width, and scan every 0.5°, 
your settings may be:  
 

Start 
Angle  

    End  
   Angle  

 
Width 

 
    Step 

    # 
  Images 

Complete- 
    ness 

 Start 
     # 

0.00 90.0 0.50 0.50 180 --- 1 
 
 

View the Instrument State 
You can view the state of the X-ray detector with the Instrument State Display window. The 
information reported is as follows:  
 
To display the Instrument State Display window,  

1. Click the Show Instrument State Display toolbar button.   
 

• Alternatively you can click View > Instrument State Display on the menu.   
 
The information reported on the Instrument State Display is as follows: 
 

X-ray Source group box:  Information about the X-ray Shutter, orientation, Source Type and 
Optic Type . 

 
Goniometer group box:  Information on the Crystal orientation and Detector position. 
 
Detector group box:  Information on Image, Requested Settings , Expected finish time , and 

Detector type. 
 
The Instrument State Display window will appear. CrystalClear displays a window specific to the 
selected Image Collection Device Type ; namely R-Axis, Jupiter CCD or Mercury CCD. 
 
 If the R-Axis is the Image Collect Device Type , the following window will appears. 
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If Jupiter CCD or the Mercury CCD is the Image Collection Device Type , the following window 

will appear.  
 

 
 
Manually Control the Detector 
The instrument can be controlled from within CrystalClear with the Manual Instrument Control 
feature. 
 
Items that can be controlled include:  

• Goniometer and detector positioning 
• Shutter control 
• Imaging plate positioning and reading 
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• Complete instrument initialization 
• Erase lamps illumination (R-Axis only) 

 
To view the Manual Instrument Control window,  

1. Click the Show Manual Instrument Control button on the Tool Bar .  
 

• Alternately, you can click View > Manual Instrument Control on the menu.  
  

The Manual Instrument Control dialog will appear.  The options on the dialog will vary, 
depending on the detector that is currently selected.  
 
If the R-Axis is the Image Collect Device Type, the following window will appear.  
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 If the If Mercury CCD is the Image Collection Device Type , the following window will appear.  
 

  
 
2. Select the desired setting and Move!  
 
3. Click Initialize  to datum the detector and goniometer.  
 
Note:  In general, one must initialize the instrument before running individual items. 
 
 

Set User Preferences 
 
Users can set preferences for how CrystalClear will appear on their computer screen. For example, a 
user may wish to turn off the message window, Command Bar and Status Bar to allow more space for 
the image window.  
 
Users can also specify their preferred language to be used within CrystalClear, where they want to store 
certain files, whether to simulate the X-ray detector, and other user-specific preferences.  
 

Select View Settings 
 
To customize the View Settings,  
 
1.  Click Tools > Preferences on the menu.  
 The Preferences dialog will appear.  
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2. Check the desired options to appear on the CrystalClear interface.  
 
3. Select the language to use in CrystalClear. 
 
4.  Continue to check other tabs or click OK to save changes.  
 
 

Specify a directory for user files or scripts 
 
To customize the locations of user files and scripts,  
 
1.  Click Tools > Preferences on the menu.  
 The Preferences dialog will appear.  
 
2. Click the Directories tab. 
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3. Click the Ellipses Button  to the right of the item you wish to modify.  
 The Select Directory dialog will appear.  
 

  
 
4. Navigate to the directory to use, then click OK.  
 The selected directory will appear in the Preferences dialog.  
 
5. Continue to check other tabs or click OK to save changes. 
 
 

Specify  Instrument Server Simulator 
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It may be limiting or unfeasible to run CrystalClear only on the computer connected to an Image Collect 
Device (detector).  For example, it may be necessary and convenient to process collected data on a 
computer other than the one connected to the Image Collection Device (detector); or it may be useful to 
conduct in-house training sessions on CrystalClear on a computer other than that connected to the Image 
Collection Device (detector). 
 
CrystalClear provides an X-ray Detector Simulator.  The detector simulator allows the processing of 
data or user training on a computer other than the one connected to the Image Collection Device (X-ray 
detector). 
 
To configure CrystalClear to use the detector simulator,  
 
1.  Click Tools > Preferences on the menu.  
 The Preferences dialog will appear.  
 
2. Click the Server tab. 
 

 
 
3. In the Run As Simulator list box, check the box next to the name of the detector  that you wish to 

run as a simulator.  
 
4. Continue to check other tabs or click OK to save changes. 
 
 
Configure the Instrument Server Simulator 

 
Generally the instrument server simulators do not require changes to the configuration files.  However, 
note that the default images created by the server simulator will be “bogus”.  Images created by the 
server simulator cannot be used for processing.  The instrument server simulators should be reconfigured 
to read previously collected images already on disk.  
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When using the server simulator reconfigured to read previously collected images already on disk, all 
data collection conditions must be set up consistent with the parameters originally used in collecting the 
images. (i.e., scan rotation range, scan rotation axis, image width, direct beam position) in order to 
correctly process the images. 
 
 

R-Axis Simulator 
 
The R-Axis instrument server simulator, MSCServDetRAXIS_Simulator.exe, reads the same 
configuration file as its non-simulator counterpart, namely; 
(MSCServDetRAXIS.configuration).  The simulator interprets all options as the non-simulator 
server, plus two additional options (which are ignored by the non-simulator server).  These options are 
SimulatorBaseFilename and SimulatorMode.   
 
 SimulatorBaseFilename = drive:\path\base 

This option specifies the base name for the image files used by the 
simulator during data collection. The files should exist on the disk in the 
form drive:\path\base???.img , where ??? represents a number, padded 
on the right with 0s.  All image numbers in a scan must have the same 
number of digits (i.e., if there are 1000 images in the scan, then the first 
image number is denoted by 0001).  In versions 2.1.2 and earlier, the 
minimum number of digits in the image number is three (3) (i.e., image 
1 is denoted by 001), unless the largest image number in the scan would 
require more than three (3) digits as described above.  In versions 2.1.3 
and later, the minimum number of digits in the image number is four 
(4). 

 
 SimulatorMode = realtime | immediate 

This option indicates if the simulator will mimic real time when 
simulating exposures.  If the value is realtime, then the exposures will 
take real time to finish (e.g., a 30 second simulator exposure will take 
30 seconds to finish).  If the value is immediate, then the exposures will 
finish immediately. 

 
 

CCD Simulator 
 
The CCD instrument server simulators, namely;  MSCServDetCCD_Simulator.exe and 
MSCServCCDCamera_Simulator.exe, read the same configuration files as the non-simulator 
counterparts (MSCServDetCCD.configuration and 
MSCServCCDCamera.configuration, respectively). ).  The simulators interpret all options as the 
non-simulator servers, plus two additional options (which are ignored by the non-simulator servers).  
These options are SimulatorBaseFilename (MSCServCCDCamera) and SimulatorMode 
(MSCServDetCCD).   
 
 
 SimulatorBaseFilename = drive:\path\base 

This option specifies the base name for the image files used by the 
simulator during data collection. This option is only recognized by the 
CCD Camera server simulator, 
MSCServDetCCDCamera_Simulator.exe.  The files should 
exist on the disk in the form drive:\path\base???.img , where ??? 
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represents a number, padded on the right with 0s.  All image numbers in 
a scan must have the same number of digits (i.e., if there are 1000 
images in the scan, then the first image number is denoted by 0001).  
The previously collected images must be on a disk accessible by the 
framegrabber PC.  The minimum number of digits in the image number 
depends on the version of MSCServDetCCD_Simulator.exe, not 
MSCServCCDCamera_Simulator.exe.  In versions earlier than 
3.0.0, the minimum number of digits in the image number is three (3) 
(i.e., image 1 is denoted by 001), unless the largest image number in the 
scan would require more than three (3) digits as described above.  In 
versions 3.0.0 and later, the minimum number of digits in the image 
number is four (4), unless specified otherwise by the 
MinimumScanTemplate keyword in 
MSCServDetCCD.configuration. 

 
 SimulatorMode = realtime | immediate 

This option indicates if the simulator will mimic real time when 
simulating exposures.  If the value is realtime, then the exposures will 
take real time to finish (e.g., a 30 second simulator exposure will take 
30 seconds to finish).  If the value is immediate, then the exposures will 
finish immediately. 

 
 

Specify User Preferences  
 
To customize other user preferences,  
 
1.  Click Tools > Preferences on the menu.  
 The Preferences dialog will appear.  
 
2. Click the General tab. 
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3. Select the Scale and Average Graphs  to be displayed. 
 
4. Set the Resolution Units  for the image display 
 
5. Set the Exposure Time Units , for data collection and image display. 
 
6. Continue to check other tabs or click OK to save changes. 
 
 

Specify Collection Defaults  
 
To customize the preferences for setting up collection,  
 
1.  Click Tools > Preferences on the menu.  
 The Preferences dialog will appear.  
 
2. Click the Collection tab. 
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3. Make changes to the options. 

 
4. Continue to check other tabs or click OK to save changes. 
 
 

View Log Files 
 
CrystalClear creates log files that help you “see” what settings were used during processing.  The results 
of the log files can help in troubleshooting problems.   
 
To view a log file or another file in text mode,  
 

1. Click the View Log File  button on the Tool Bar . 
The Open dialog will appear.  
 

• Alternatively, click View > Log File on the menu.  
 
2. Select the log file to view.  
 
3. Click Open.  
 
See Appendix C: Sample Log Files on page 161 for more information on log files. 
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8 Additional Processing 
 

Set Resolution 
You can Set Resolution used during various data processing steps. Each of the following dialogs within 
the processing procedure includes a Set button:  Find Spots, Index Spots, Refine Cell, Predict Spots, 
Strategy, Integrate Reflections, Scale and Average. When this button is clicked, the Set Resolution 
dialog appears.  
   
To Set Resolution for one or more processing steps, 
 
1. Click the Set button on a displayed dialog displayed within processing procedure. 
 The Set Resolution dialog will appear. 
 

 
 
2.  Check the steps to set the default resolution.  
 
3. Specify the resolution values in the Minimum and Maximum edit windows; or press To Edge of 

Image or To Corner of Image buttons.  
 
4. Click OK.   
 
Once the resolution is set for each step, the specified values will appear on the respective dialog.  
 
 

Merge Reflection Lists with d*TREK 
 
In addition to scale and average in the d*TREK processing module, reflection lists can be merged 
separately.  The Merge Reflections  task will also merge reflection list files with different columns or 
fields. 
 
To Merge Reflection Lists , 
  
1. Start CrystalClear and log in. 
 
2. At the Open Sample  dialog, select a sample.  
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This sample should have been processed at least up through Integrate Reflections.  
 

3. At the Task drop down list, select Combine Reflections .  
 
4.  Click Merge  on the Flow Bar.  
 
 The Merge Reflection Lists  dialog will appear. 
 

  
 
5. Select the reflection lists to be merged in the Reflection Lists list box.  
 
6. Specify a name for the resulting output file in the Output Merged File  edit field.  
 
7. Specify a Zone Type .  The available options are:   
 None, H00, 0K0, 00L, HK0, H0L, 0KL 
 
8. To restrict resolution, check the Restrict Resolution check box, then specify the Minimum and 

Maximum values. 
 
9. To Import Reflection File , click the button.   

The Select Reflection File to Import  dialog appears, 
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a. There are several ways to select a file to import: 

• Click  to browse for a file to import.   
• Select a file to import by clicking on it.  
• Type the File name to import in the entry field. 
• Click Files of type  down arrow to view files other than (*.ref.) 

 
b. Click Open to import the file. 
 

 
 
Note:  When files are imported, the filename is added to the Reflection List.  If the imported file has 
a unique name, it is placed in the list with the same name.  If the imported file has a duplicate 
filename, it is augmented as “import1(filename).  Doing a second file with the same name augments 
that filename to “import2(filename). See the Merge Reflection Lists  dialog above. 

 
10. When satisfied with your selections, click Run.  
 
 

Create and Edit Macros 
Once a group of settings has been selected, it is convenient to quickly apply those settings.  A macro 
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allows you to store a group of settings for crystal refinement; then select the macro to quickly apply 
those settings.  CrystalClear offers several predefined macros.  
 

• All 
• Single Step refine 
• Detector, then all crystal 
• Crystal, then all detector 
• Lo reso, then all reso 

 
CrystalClear also allows you to create and edit custom macros. 
 
 
Creating a Macro 

 
To create a custom macro,  
 
1.  On the Refine  dialog, click the Advanced button.  
 The Macro Editor dialog will appear.  
 

• The Refine  dialog can be accessed by clicking the Refine Cell button on the Flow Bar 
during a Processing  task.  (Task drop down list options: Process or Screen Collect and 
Process)  Click the Advanced button to access the Macro Editor dialog. 
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2. Click the New Macro button.  
 The New Macro dialog will appear. 
 

 
 
3.  Enter a unique name for the New Macro.  
 
4. From the list of CrystalClear predefined macros, select a macro with values similar to those to be 

used in the New Macro, then click OK.  
 
5. The Macro Editor dialog will appear with a step-by-step list of the selected macro.  Customize the 

macro by altering the values of the predefined macro.  Highlight a step and change the values to 
reflect those desired.  Continue to highlight steps and make changes as desired. 

 
Use the New Step button to access the New Refine Step dialog to add a new step to the macro. 
  

 
 
Use Remove Step button to delete the macro step selected.   
 

6. When the customized New Macro is satisfactory, click Close.  
 

When you click Close on the Macro Editor, the customized steps and values are saved with the 
New Macro name.  This New Macro is specific to the current sample.  
 

7. When the Refine  dialog appears, click Save.   
The Default Manager dialog appears. 
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Default Manager dialog allows the New Macro to be saved at the Site Level, User Level, Project 
Level, or Sample Level. Using Default Manager allows you to use the New Macro in other projects 
and samples. 
 

8. Choose the level or destination of the macro and click OK. 
 
 

Edit a Macro 
 
To edit a macro,  
 
1.  On the Refine  dialog, click the Advanced button.  
 The Macro Editor dialog will appear.  
 

• The Refine  dialog can be accessed by clicking the Refine Cell button on the Flow Bar 
during a Processing  task.  (Task drop down list options: Process or Screen Collect and 
Process)  Click the Advanced button to access the Macro Editor dialog. 

 
2. Select the macro you wish to edit from the macro list. 

 
3. Edit the macro by changing the values of the listed macro.  Highlight a step and change the values to 

reflect those desired.  Continue to highlight steps and make changes as desired. 
 

Use the New Step button to access the New Refine Step dialog to add a new step to the macro. 
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Use Remove Step button to delete the selected macro step.  
 

4. When all macro steps are satisfactory, click Close.  
 

When you click Close on the Macro Editor, the customized steps and values of the edited macro are 
saved specific to the current sample.  

 
5. When the Refine  dialog appears, click Save.  The Default Manager dialog appears.  This dialog 

allows the edited macro to be saved at the Site Level, User Level, Project Level, or Sample Level. 
 
6. The Default Manager allows you to use the edited macro in other projects and samples.  If you wish 

to use the edited macro on additional projects, or make it available to other samples or all projects, 
make the appropriate selections on the Default Manager dialog, then click OK. 

 
 

The Collect Schedule 
 
The Collect Images dialog is useful in working with Collect Schedules.  New schedules can be created, 
existing schedule can be imported and altered to meet the various needs of each user.  The Collect 
Images dialog is used to Run and Save Collect Schedules. 
 
Use the Collect Images dialog to: 
  

• Create a Collect Schedule  
• Import a Collect Schedule  
• Run a Collect Schedule  
• Save a Collect Schedule  

 
1. Access the Collect Images dialog. 
 

•  The Collect Images dialog can be accessed by clicking the Collect Images button on the Flow 
Bar during a Collect task. (Task drop down list options: Screen Collect and Process, Collect 
and Process, or Colle ct.) 
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Note: When CrystalClear is using the R-Axis as the Image Collect Device Type, the illustrated 
Collect Images dialog appears. When CrystalClear is using the Mercury CCD Image Collection 
Device Type, a slightly different Collect Images dialog appears.  The following instructions apply 
for both dialogs.  
 
 

Create a Collect Schedule 
 
To create a new collect schedule,  
 
1. Access the Collect Images dialog. 
 

•  The Collect Images dialog can be accessed by clicking the Collect Images button on the Flow 
Bar during a Collect task. (Task drop down list options: Screen Collect and Process, Collect 
and Process, or Collect.) 

 
2. Use the Scan Table  to alter the scans:: 
 

• Use the Add Scan button to increase the number of scans at a different crystal orientation.  
Adjust settings as desired. 

 
• Use the Remove Scan button to remove undesired scans.   

 
For assistance in manipulating the Scan Table  columns, headings or other settings, see 
Using the Scan Table  on page 103 of Section 7  Tool Reference.  

 
3. Make adjustments to the settings as required.   
 
4. When all settings are satisfactory for the new Collect Schedule, you can:  

 
• Run  See Run a Collect Schedule , on page 128, for assistance. 
• Save  See Save a Collect Schedule , on page 127, for assistance. 
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Import a Collect Schedule 

 
To import an existing collect schedule,  
 
2. Access the Collect Images dialog. 
 

•  The Collect Images dialog can be accessed by clicking the Collect Images button on the Flow 
Bar during a Collect task. (Task drop down list options: Screen Collect and Process, Collect 
and Process, or Collect.) 

 
3. Use the Import button to use an existing Collect Schedule  from Project, User, or Site Levels. 
 

• If you wish to use the defaults of different Sample, you must open that Sample and Save the 
defaults at the Project, User, or Site level.  For assistance, see Using the Default Manager 
on page 209 of Appendix F: Defaults in CrystalClear. 

 
The Import Schedule  dialog will appear. 

 

 
 

4. There are several options on the Import Schedule  dialog: 
 

• Use the Rename  button to rename a selected schedule. A Rename Schedule  dialog appears. 
• Use the Delete  button to delete a selected schedule. A CrystalClear warning dialog appears. 
• Use the Import button to import a selected schedule.  A Name Schedule  dialog appears. 

 
5. Use the Close button to close this dialog and return to the Collect Images dialog. 

 
6. Manipulate the imported schedule, making changes to settings on the Scan Table , as desired. 
 

For assistance in manipulating the Scan Table  columns, headings or other settings, see Using the 
Scan Table  on page 103 of Section 7  Tool Reference.  

 
 
Save a Collect Schedule 

 
When the Save button is used, the Default Manager dialog appears.  For assistance using the 
Default Manager Dialog, see page 209 in Appendix F: Defaults in CrystalClear, for assistance. 
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1. When the Collect Images dialog Save button is clicked, 

the Default Manager dialog will appear. 
 

 
 
2. The Default Manager dialog allows the user to save the settings to various levels.   

 
Select the Current Levels  you wish to save by clicking the appropriate check-box.   
 

• Alternatively, selections can be made by clicking the radio-button beside the appropriate 
Site, User, Project, or Sample names. 

 
a. Use the following buttons for assistance in setting defaults: 
 

• Set   Sets a default 
• Unset   Unsets a default 
• Set All Sets all Levels 
• Unset All   Unsets all Levels 
 
Note:  Only Users with Administrator privileges are authorized to set Site Defaults.  For most 
users, this option is grayed-out. 
 
 

Run a Collect Schedule 
 
To run a collect schedule,  
 
1. Access the Collect Images dialog. 
 

•  The Collect Images dialog can be accessed by clicking the Collect Images button on the Flow 
Bar during a Collect task. (Task drop down list options: Screen Collect and Process, Collect 
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and Process, or Collect.) 
 

2. Use the Scan Table  to alter the scans, you may: 
 

• Use the Add Scan button to increase the number of scans at a different crystal orientation.  
Adjust settings as desired. 

 
• Use the Remove Scan button to remove undesired scans.   

 
For assistance in manipulating the Scan Table  columns, headings or other settings, see 
Using the Scan Table  on page 103 of Section 7  Tool Reference.  
 

3. Make adjustments to the settings as required.   
 
4. When all settings are satisfactory for the new Collect Schedule, you can:  
 Click Run to start the scheduled collection. 
 
  The Double -Check Settings  dialog will appear. 
 

 
 
5. Review the specified settings on the detector. 
 
6. Click Start Image Collection, or Cancel Image Collection if an error is found.  
 

In the event CrystalClear detects insufficient disk space available for the entire data collection, a 
dialog will appear to guide you through selecting a new collection directory.  You may need to 
“cancel” the data collection and free up space on the hard drive.  If you wish to delete the images 
and processing from an old sample (presumably with all necessary file archived), see Delete 
Projects and Samples on page 97 of Section 7  Tool Reference 

 
 
Delete Collection Schedule 

 
To delete a collection schedule, 
Access the Scan State Display dialog. 
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Click the Show Scan State Display button on the toolbar .  
Or click View > Scan State Display on the CrystalClear menu.  
 

The Scan State Display window will appear. CrystalClear displays a window specific  to the Image 
Collection Device Type selected; namely R-Axis or Mercury CCD.  

 

  
 
1. Select the schedule in the Collect Schedule  drop down box of the Scan State Display dialog.  
 
2. Click Delete button. 
 

 
 
3. Click Yes button to permanently delete the Collect Schedule . 
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9  Images 
 

The Image Window 
 
CrystalClear offers a graphical view of your data in the image window.  
 
 

 
 

1 Large Image Window 
2 Profile Windows  
3 Large Image Window Toolbar  
4 Small Image Window Toolbar 
5 Small Image Window  
6 Image Information Window 
 
 
Large Image Window 

 
The image is displayed in the large image window. Cross hairs allow you to select the portion of the 
image that will display in the Small Image Window.   
 
Profile Windows 

 
The profile windows display a graphical profile, showing you the values of the pixels that intersect the x- 
and y-axis cross hairs.  To display the integrated intensity of a spot, click on the spot in the large image 
window. You can also click and drag across an area to see how the values change from pixel to pixel.  
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Large Image Window Toolbar 

 
You can manipulate the image in the large image window using the tools on the Image Window toolbar. 
 

 
Select You can use the Select tool to point at a particular pixel and get 

information about that pixel in the Information Window. With the 
Select tool, you can also click to see a profile plot of pixel values in 
the Profile Window.  
 

 
Magnify Choose the Magnify tool, then click in the image window to see a 

magnification of an area. 

 
Zoom Choose this tool to zoom in or out.   

To zoom in on a specific area: right-click, then drag out a box 
To zoom in: left-click, then move the cursor up 
To zoom out: left-click, then move the cursor down  

 
Full View This tool returns the display back to full view after you have used 

the Zoom feature. 

 
Pan This tool allows you to pan across the image. Choose this tool, then 

click and drag in the direction you wish to pan. 

 
Measure This tool displays a measurement in angstroms between two points. 

Click on a point, then drag to a second point.  

 
Profile  Use this tool to get a profile of a cross section. Unlike the Select 

profile, which gives only right-angle profiles, with this tool you can 
get a profile of pixel values in a line connecting two points. Click on 
a point, then drag to a second point to display the profile.  
 

 
Add Spots With this tool, you can click on a spot to add it to the reflection list.  

 
Delete Spots With this tool, you can remove spots from the reflection list. The 

spot closest to where you click will be removed.  

 
Measure Pixels Use this tool to measure pixels in the Image Window. 

 
Quad Erasure This tool is used to define a four-sided area to be masked out during 

processing. This is handy to remove the beam stop shadow from an 
image. To use, click in four corners of the area to be removed.  (See 
Non-uniformity Type  on page 54 in Section 6 Data Collection and 
Processing for help with Mask Files.) 

 
Circle Erasure This tool is used to define a circular area to be masked out during 

processing. To use, click the center of the circular area, then drag to 
the outside edge of the area. When the mouse button is released, the 
circular area will be defined. (See Non-uniformity Type  on page 
54 in Section 6 Data Collection and Processing for help with Mask 
Files.) 
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Free-hand Erasure This tool is not yet implemented. 

 
Undo Last Erasure This tool will undo the last erasure. This tool only allows a single 

undo. 

 
Write File Save an image file. This tool allows for saving an image that has 

been modified. 

 
Write Mask File  Click this tool to save a mask file. The mask file is an image file that 

includes any erasures you might have made. (See Quad Erasure and 
Circle Erasure or See Non-uniformity Type  on page54 in Section 
6 Data Collection and Processing for help with Mask Files..) 

 
Contrast Use this tool to adjust the contrast of your image.  

 
Reverse Use this tool to reverse the pixel values in your image. 

 
Color Use this tool to toggle between gray scale and color display. 

 
Toggle Square Root 
Display 

This tool displays the image with each pixel value being converted 
to its square root. This gives more contrast to the image, truncating 
the strong pixels and raising the display of weak pixels.   

 
Reset Local Contrast This tool sets the contrast of the displayed portion of the image. This 

is useful in zoomed areas where there is a smaller or greater 
difference in minimum and maximum pixel intensities than the 
current contrast values.  
 

 
Load Reflection List This tool loads a reflection list into memory. You can then add or 

remove spots with the Add Spots and Delete Spots tool; then use 
Write Reflection list to save the edited reflection list. 

 
Write Reflection List This tool saves the current reflection list with any additions or 

deletions.  

 
Set Reflection Size This tool allows you to adjust the size of the circle drawn around 

each spot. Note that this circle is for display purposes only and does 
not reflect the integration area or background/peak separation. 

 
Toggle Filtering This tool allows you to filter out spots that are not found in the 

current image. For example, a spot that appears in Image 10 may not 
intersect Image 1. This tool filters out all spots whose rotation range 
does not intersect the displayed image.   

 
Previous Image This tool displays the previous image in the series.  For example, if 

the current image is Img004.osc, clicking this tool will display 
Img003.osc. 

 
Next Image This tool displays the next image in the series.  For example, if the 

current image is Img004.osc, clicking this tool will display 
Img005.osc. 
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Overlay Images Displays an image created from a specified series of images.  Each 

pixel in the resultant image is generated by using the maximum 
value occurring in the images for that pixel position. This is 
generally used to display the image that would result from a wider 
rotation/oscillation angle. 

 
Underlay Images Displays an image created from a specified series of images.  Each 

pixel in the resultant image is generated by using the minimum 
value occurring in the images for that pixel position.  This is 
generally used for examining the background over wide 
rotation/oscillation angle or for examining the extent of a reflection 
across several images and rotation angle values. 

 
Average Images Displays an image created from a specified series of images.  Each 

pixel in the resultant image is generated by using the average value 
occurring in the images for that pixel position. 

 
Tile Images Displays an image created from tiling a specified series of images. 

 
 
Spots that appear with a red circle during Integration are rejected spots (the spots may be saturated, or 
otherwise invalid), while those spots that appear within a red circle during refinement are spots whose 
difference between observed and calculated positions the exceed rejection limits in x, y, or φ . Spots that 
appear with a green circle during refinement have been excluded from refinement, either because they 
fall outside the resolution limits, or the lie too close to the rotation axis, or they are below the I/σ(I) 
cutoff. 
 
 
Small Image Window Toolbar 

 
The toolbar for the small image window includes tools similar to the Large Image Window toolbar. 
However, they act upon the small image window only. 
 
Small Image Window 

 
A smaller portion of the image appears in the Small Image Window. You can select the portion that will 
appear here by moving the cursor in the Large Image window and clicking the mouse.  
 
Image Information Window 

 
Information about the image appears in the Image Information window.  Much of the data listed here is 
for information purposes. However, you can manipulate such things as the number of spots displayed 
with the controls listed here.  If a scroll bar appears, you can scroll up and down to see additional items 
in the control. If the background for a field is white, then that field is editable.  To enact a change to the 
window, but not a permanent change to the state, enter the desired value and press Tab.  
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Appendix A: Files and Directory Structure 
 
The CrystalClear program ships with the files in the following lists.  Your installation may not include 
all files, depending on the detector type that your copy of CrystalClear came with. 
 

Installed Files 
 
CrystalClear program files 

 
CrystalClear.exe    Executable program file  
CoreCode11.dll    Shared code program library 
CoreRes11ENG.dll   English language resource file  
CoreHobject11.dll   DLL for database functions 
gzip.exe     Decompression utility used to decompress image files 
DundasUG.dll    DLL for table controls 
system.configuration   System configuration file  
xg_dll.dll    DLL for x-ray generator control 
 
Compute Servers 

 
MSCServDetCCD_Simulator.exe  CCD compute server simulator 
MSCServDetCCD.exe   CCD compute server 
MSCServDetCCD.configuration  CCD compute server configuration file  
MSCServDetRAXIS_Simulator.exe  RAXIS compute server simulator 
MSCServDetRAXIS.exe   RAXIS compute server 
MSCServDetRAXIS.configuration  RAXIS compute server configuration file  
RAXIS_IV.configuration   RAXIS IV configuration file  
RAXIS_IV++.configuration    RAXIS IV++ configuration file  
MSCServProcDTREK.exe   D*TREK compute server 
MSCServProcPROCESS.exe  PROCESS compute server 
MSCServProcTwinSolve.exe  TwinSolve compute server 
AFC7_RCD2.configuration Configuration file for AFC7 goniometer/RCD2 controller 
AFC8_RCD3.configuration  Configuration file for AFC8 goniometer/RCD3 controller 
MercuryDefault.header   Default header file for Mercury CCD 
Errors.xer    Twinsolve errors list 
Huber.xpa    Twinsolve file  
huhelp.xhe    Twinsolve help file  
spacegrp.xsg    Twinsolve spacegroup file  
 
 

Help Files 
 
CrystalClear.chm    Online help file for CrystalClear 
CrystalClearDoc.pdf       Online Manual for CrystalClear 
CoreHelp.chm    Online help file for CrystalClear 
TwinSolve.chm    Online help file for TwinSolve module 
infolist.txt    Readme file containing release notes and other info 
hh.exe     HTML help engine  
hhctrl.ocx    Help engine file  
itircl.dll     Help engine file  
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itss.dll     Help engine file  
popup.ocx    Help engine file  
 
 
OCX Components 

 
FlowCtrl.ocx    Flow Control OCX 
RegFlowCtrl.bat    Batch file for registering FlowCtrl.OCX 
UnRegFlowCtrl.bat   Batch file for un-registering FlowCtrl.OCX 
Regsvr32.exe    Program that registers OCX components 
 
 
RAXWish Files 

 
deisl1.isu 
_isreg32.dll 
blt80b1.dll 
raxvideo.exe 
raxwish.exe 
shape.dat 
shape.ico 
aaa.log 
shape001.ppm 
shape002.ppm 
shape003.ppm 
shape004.ppm 
tcl80.dll 
tclpip80.dll 
tif2rax.exe 
tk80.dll 
tix4180.dll 
raxshape.ini 
autoexec.bat 
raxvideo.ini    Initialization file for RAXVideo.exe 
 
 
Crypto-Box files 

 
Version.txt     (Win95/98)  
Cbn.vxd     (Win95/98) 
Install.bat     (Win95/98) 
Marx.reg     (Win95/98) 
Readme.txt     (Win95/98) 
Cbn.inf      (Win95/98) 
Register.bat    (Win95/98) 
Marxdev1.ini     (WinNT) 
Marxdev1.reg    (WinNT) 
Marxdev1.sys     (WinNT) 
Marxdev2.ini     (WinNT) 
Marxdev2.reg     (WinNT) 
Marxdev2.sys     (WinNT) 
Marxdev3.ini     (WinNT) 
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Marxdev3.reg     (WinNT) 
Marxdev3.sys     (WinNT) 
Cbnvdd.dll     (WinNT) 
Install.bat     (WinNT) 
All_devs.reg     (WinNT) 
Msdos.bat     (WinNT) 
Readme.txt     (WinNT) 
Regini.exe     (WinNT) 
Register.bat     (WinNT) 
 
 
Additional Files 

 
tcl80p2.exe    Tcl installation program 
ws295sdk.exe    Windows Sockets installation (required for Windows 95) 
uninst.isu    Uninstallation file  
MoveData.dll    DLL for MoveCCData.exe 
MoveCCData.exe    Moves and converts older databases to new version, 

 

Files Created by CrystalClear 
CrystalClear creates settings and script files: 

AdminDatabase.ho   Administration database file. This file is located in the 
Administration directory. It stores information about groups, 
users, servers, tools, modules, and default preferences.  

InstrumentName.ho   Databases detector-specific for settings. There is a defaults 
database file for every detector supported by CrystalClear in 
DATA\SiteDefaults.  These files contain the default settings for 
new users. The settings stored in this file and are transferred to 
the CrystalClearUserDefaults.ho  file each time a new user is 
added.  Please refer to the document entitled “Defaults in 
CrystalClear” for more information on detector inheritance.  

SiteInfo.ho    Database for detector settings. This file is located in the DATA 
directory. 

CrystalClearProjects.ho   This file is located in each User directory. It includes a 
list of all the projects created for that user. Each user has a 
unique CrystalClearProjects.ho file.  

CrystalClearUserDefaults.ho  This file is located in each User directory. It includes the user’s 
own default settings. 

CrystalClearProjectDefaults.ho  This file is located in the User/Project directory. This file 
includes defaults used when a new sample is created. 

CrystalClearSamples.ho This file is located in the User/Project directory. This file is 
included in each project directory. It holds settings for each 
sample. 

 
Samplename.ho    This file is located in the User/Project/Sample 

directory. Each sample will have its own Samplename.ho file. 
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This file holds current settings for the sample.   

SessionScript.scp   CrystalClear records all actions that change the program state 
in this file throughout the CrystalClear session. When a new 
session is started, the previous SessionScript.scp file is saved to 
SessionScript.bak, and a new SessionScript.scp file is created.  

SessionScript.bak   This file is a backup of the previous session SessionScript.scp. 
Only one previous session is saved in the SessionScript.bak.  

Dtfind.log    This is a log of the activity during a Find operation. 

Dtindex.log    This is a log of the activity during an Index operation. 

Additional log files are created specific to the current operation. 

 

 

Directories 
A subdirectory called Data is created off the CrystalClear program directory. This subdirectory will 
contain information about the users, projects, and samples that are processed with CrystalClear.  

 

Program Directory  The directory where the CrystalClear program and its peripheral files 
installed.  

 
Administration The Administration database is stored in this directory.  
 
Data Directory  The directory where the data about users, projects, and samples is 

stored. The data directory is a subdirectory of the Program Directory. 
 
(User) Each user has a directory where their project and sample data is stored. 

The Administrator directory is a user directory created for the 
Administrator.  

 
(User/Project) All of a user's projects have a unique directory located under the user 

directory.  
 

(User/Project/Sample) A project can contain any number of samples. The sample data is stored 
in a unique subdirectory under the Project to which it belongs.  

 

Scripts A script directory is created for each user. This directory is used by 
default to store the SessionScript.scp and SessionScript.bak files, as 
well as any scripts that the user may record.  Users can change their 
script directory in Preferences, if desired.  

 

Twinsolve A directory called c:\huber is created to store files required by the 
TwinSolve module.  

 
RAXWish  A directory called c:\RAXWish is created to store files required by the 

RAXWish software.  
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DirectBeamShots   A directory called DirectBeamShots is created, located off of the 
CrystalClear program directory for storage of direct beam shot 
information.  

 
ContinuousIPReadImages A directory called ContinuousIPReadImages is created, located 

off of the CrystalClear program directory for storage of continuous IP 
Read information.  

 
 
PMTCheckImages A directory called PMTCheckImages is created, located off of the 

CrystalClear program directory for storage of PMT Check Image 
information.  
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Appendix B:  Administration 
 

CrystalClear has a built-in mechanism for managing various projects and samples, based on the Login 
Name . Once CrystalClear is installed, the administrator should specify default settings for the detector, 
and set up an account for each user. In order to add accounts to CrystalClear, you will need to log into 
CrystalClear as administrator. 
 

Administrator Login 
To log in as Administrator,  

1. Start CrystalClear.  
The Login dialog will appear. 
 

 
 

2. In the Login Name  edit field, Enter Administrator.  

3. Leave the Password edit field blank, and click OK.  

 CrystalClear ships with an Administrator account automatically set up. By default, this 
Administrator acount has no password (blank). A new password for the Administrator account 
should be set by using the procedure to Edit User Settings on page145 of Appendix B:  
Administration. 

4. At the Open Sample  dialog, click Cancel to close the dialog.  

 

General Settings 
The CrystalClear administrator can set general defaults within the program. All settings made by the 
administrator become default settings for new users at their initial login.  
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To set defaults, access the Administration dialog. 
1. At the menu line, click Tools > Administration.  

The Administration dialog will appear.  
 

 
The settings include view options.  Select the options you wish to be displayed.   
 

Standard Tools:  Toggle the display of the standard tools, such as Open, Save, View Log file, etc.  

View Tools:   Toggle the display of the View tools  

Task List:   Toggle the display of the task box 

Flow Bar:   Turn display of the Flow Bar on or off (initial default = on) 

Command Line Bar:  Turn display of the Command Line Bar on or off (initial default = on) 

Message Bar:  Turn display of the Message Bar on or off (initial default = on) 

Script Tools:   Toggle the display of the script tools (play, record, pause and stop) 

Status Bar:    Turn display of the Status Bar on or off (initial default = on) 

 

A default language for CrystalClear can be selected with the Default Language option.  

Default Language: Select the default language for the application.  
 

Administration of Users 
With the Administration dialog, the Administrator can access the Users  tab to add users, edit user 
settings, and remove users.  

Note:  When a new Login Name  is created, the general settings defined by the administrator are applied 
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to the user's personal settings database.  Each user can modify their own settings for their Login Name 
once they have logged in. 

 

Add a User 
 

To add a user, 

1. Access the Administration dialog by clicking Tools > Administration.  
The Administration dialog will appear.  
 
If you have logged in as a user without administration privileges, the Tools > Administration option 
is disabled.  Log in as Administrator to access this option.  

 
2. Click on the Users  tab.  

 

  
3. Click the Add button 

 The User Settings dialog will appear.  
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4. Enter the user new name in the Name  edit box.  

For the user's convenience, the name you enter in this field could be the same as the user's Windows 
login name. By default, CrystalClear displays the user's Windows login name in the initial 
CrystalClear Login Name field.  

5. Enter a meaningful description of the user in the Description edit box. This description can be the 
person's full name, their job title, or any other text that is meaningful in your work environment. 

6. Enter the path to the user's preferred data directory in the Data filename edit box.  

If you leave this field blank, CrystalClear will automatically create a subdirectory for the user, and 
that path will be displayed in this edit window when you edit the user's settings in the future.  

For example, the default directory for the user name Jesplin would be c:\Program Files\Rigaku 
MSC\CrystalClear\data\Jesplin, if f:\data\Jesplin were not used.  

7. In the Password group box, enter a user password in both the New and Confirm edit fields.  

The password is not case-sensitive. 

8. Select the default language to be used for the user.   

 English is the default language. In the future, other languages may be added to CrystalClear.  

9. In the Member of (Groups) group box, select the groups(s) to which the user should belong. The 
user will be a member of all groups with a check in the box.  

10. Click OK to add the user.  

 

Remove a User 
 
To remove a user, 

1. Access the Administration dialog by clicking Tools > Administration.  
The Administration dialog will appear.  
 
If you have logged in as a user without administration privileges, the Tools > Administration option 
is disabled.  Log in as Administrator to access this option.  
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2. Click on the Users  tab.  
 
4.  Select the user to be removed from the user list.  
 
5. Click Remove . 

The following CrystalClear dialog appears. 
 

 
 

When you remove a user, you also be given the option of deleting the user’s data and data directory.  

6. Click the appropriate response: 

• Yes Remove user and all directories  
• No  Remove user but do not remove all directories 
 
 

Edit User Settings 
 
Use this feature to edit a user’s password, description, data path, or assigned groups 

 
To edit user settings,  

 
1. Access the Administration dialog by clicking Tools > Administration.  

The Administration dialog will appear.  
 
If you have logged in as a user without administration privileges, the Tools > Administration option 
is disabled.  Log in as Administrator to access this option.  

 
2. Click on the Users  tab.  
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2. Select the user name or Administrator from the Users  list, then click Edit.    
 The User Settings dialog will appear. 

 

  
 
3. Make the desired changes in the settings.  
 

It is recommended that the default (blank) Administrator password be changed to a specific 
password to protect against unauthorized changes in the CrystalClear settings.  
 
To change a Password, enter the New password.  Re-enter the password in the Confirm field.  

 
4. Click OK to save the changes.  
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The user’s current data will not be moved to a new user path.  
 
 

Administration of Groups 
 
To help manage the privileges given to different users, assign users to Groups . CrystalClear ships with 
two pre-defined Groups : Administrators and Users. By assigning a user to the pre-defined 
Administrators Group, the user will have privileges to add, edit, or remove users, groups, tools, or 
servers.  
 
To administer groups,  

 
1. Access the Administration dialog by clicking Tools > Administration.  

The Administration dialog will appear.  
 
If you have logged in as a user without administration privileges, the Tools > Administration option 
is disabled.  Log in as Administrator to access this option.  

 
2. Click on the Groups  tab.  
 

  
 
Add a Group 

 
To add a group and create groups that use combinations of Administrative and Application Rights.  
 

1. Click the Add button.  
 The Group Settings dialog will appear. 
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2. In the Name  edit field, enter a name for the user group. 

3. In the Description entry field, enter a description for the new group. 

4. In the Administrative Rights list, select the rights you wish to grant to members of this group. 

5.  In the Application Rights list, if applicable, select the rights you wish to grant to members of this 
group. 

6. Click OK to save the new group. 

Once you add a new group, it will appear in the Members of (Groups) list in the User Settings 
dialog.  

 

Remove a Group 
 

To remove a group,  

1.  Select the group to be deleted in the group list. 

2. Click Remove .  

When you delete a group, any users who are currently a member of that group will lose the rights 
given to them by being a member of that group. All other groups will remain intact, and the user will 
still have any rights granted to them by other groups.  

 
 

Edit Group Settings 
 
To edit a groups’ selected privileges,   

1.  Select the group to be edited in the group list. 
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2. Click Edit.  

 
3. Make the desired changes, then click OK to save the changes.  

 
 

Administration of Tools 
 

You can add software tools to CrystalClear with the Tools  tab in the Administration  dialog. When you 
add a tool, a menu entry for that tool will be added to the Tools  menu. This makes it easy to access your 
software tools from within CrystalClear. 

To administer tools,  
 

1. Access the Administration dialog by clicking Tools > Administration.  
The Administration dialog will appear.  
 
If you have logged in as a user without administration privileges, the Tools > Administration option 
is disabled.  Log in as Administrator to access this option.  

 
2. Click on the Tools  tab.  
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Add a Tool 
 
You can add tools, such as a script that you have created to automate the processing of a sample, or an 
executable program.  
 
To add a tool, 

1. Click the Add button. 
 The Tool Settings  dialog will appear.  
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2. In the Name  edit field, enter the name of the tool.  
 This name will appear on the Tools tab, and in the Tools pull down menu.  

3. In the Command edit field, enter the command line of the tool. 

4. In the Arguments edit field, enter any arguments that are required for correct operation of the tool. 

5. In the Initial edit field, specify the directory that should be active when the tool application starts. 

6. If you want to be prompted for arguments when the tool starts, check the Prompt for Arguments 
check box.  

7. If you want the tool to run without having a window pop up on the screen, select the Run 
Minimized check box.  

8. If the tool is a script, check the Tool is a Script check box. 

 
Remove a Tool 

 
To remove a tool,  

1.  Select the tool to be deleted in the tool list. 

2. Click Remove .  

The tool will be removed from the Tool list in CrystalClear only. It will not be deleted from the hard 
drive.  

 

Edit Tool Settings 
 
To edit a tool's settings,   

1.  Select the tool to be edited in the tools list. 

2. Click Edit.  

3. Make the desired changes, then click OK to save the changes.  

 

Administration of Servers 
 

A server is a software package that interfaces with CrystalClear. The purpose of the server is to perform 
complex calculations, and pass the results back to CrystalClear. CrystalClear ships with two compute 
servers: d*TREK and PROCESS, and two instrument server, CCD control and R-AXIS control.  When 
you install CrystalClear, the servers are installed and configured automatically.  

 You cannot remove the servers, nor can you add additional servers to CrystalClear at this time. The 
items that appear in the Servers list may vary, depending on which detector you have, and which servers 
shipped with your particular copy of CrystalClear.  

 

To administer servers,  
 

1. Access the Administration dialog by clicking Tools > Administration.  
The Administration dialog will appear.  
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If you have logged in as a user without administration privileges, the Tools > Administration option 
is disabled.  Log in as Administrator to access this option.  

 
2. Click on the Servers  tab.  
 

 
 

Edit Server Settings 
 

To edit the settings of a server,  
 
1. Select the server to be edited, and click the Edit button.  
 The Server Settings  dialog will appear.  
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3. Change the desired options, then click OK to save the changes.  

 Path:   Specify the path where the server program is located. By default the servers are 
installed in the same directory as the CrystalClear program. You can change this path 
if you need to move the server to another location. For example: c:\program 
files\Rigaku MSC\CrystalClear\dtrek.exe 

 Arguments:  Specify any argument that you wish to pass to the server upon its startup. By default, 
no startup options are specified. 

 Description:  Specify a description of the server software. For example, CCD Controller Software. 

 Options :  Generally, if the server software were running in the background all the time, you 
would check the Stand Alone Server check box. The application would then forgo an 
attempt to start the server software when it is needed. However, CrystalClear always 
opens and closes the servers as needed, so you should leave this option unchecked.  

 IP Address:  By default, the server software will use the local machine for processing the data. This 
is specified by the default IP address of 127.0.0.1. If you wish the server software to 
use a different machine for processing, specify that machine's IP address here.  
   

 Port:  The Port options allow you to select the port to be used for communication between 
the application and the server software. (This is not referring to a port such as the 
serial or parallel port; rather it is a software communication port.) By default, a port 
value and port range have already been specified for you, and in most cases you can 
use the default values. However, if you are running other software that is using the 
same port as one of the servers, you can adjust the port ID here.  

Auto Generate:  If you are not sure what port may be free, you can select the AutoGenerate check box 
to allow CrystalClear to select a free port for you. 
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Port Number:  To specify a specific unique port value, you can enter a value here. Generally, the 
default port will work fine. You should only change this value if you are familiar with 
your system and software. 

Range:  If you select Auto Generate, you may want to also specify a port range from which to 
choose a port ID. You can do so in the Range edit fields.  

 Note:  At this time,CrystalClear does not support adding or removing servers.  

 

 
 

Specify Default Site-level Settings 
 
After installing CrystalClear, you should set the default settings for your site.  These settings will be 
inherited by all projects that are created later.  
 
To set the default settings,  
 
1. Start CrystalClear and log in as the administrator. 
 
2. Close the sample by clicking Close in the Open Sample dialog.  
 
3. Click the Setup button on the Flow Bar.  
 

• Alternatively, you can click Sample > Setup on the menu bar.  
 
4. Make adjustments to the settings on each tab, then click Save.  
 The Default Manager dialog will appear.  
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5. Check the Site radio button, then click OK.  
 

If the Site radio button in the Current Levels  group box is grayed out, you do not have 
administrator privileges.  Exit CrystalClear and log in as an administrator, then repeat these steps.  

 
6. Continue through all of the dialogs available from the flow bar, repeating steps 4 and 5 for each 

dialog.  
 
The settings will be saved to the CrystalClear Site Default database. All the settings in this database will 
be inherited by each project as it is created.  Users can modify these setting for their own projects and 
samples.  
 
For additional information about the options in the Setup dialog, see page 50 in Section6 Data Collection 
and Processing. 
 
 

Set Up Image Collection Device Type 
 
CrystalClear operates with either a Rigaku R-Axis or a Rigaku Mercury or Jupiter CCD image 
collection device.  After you install the CrystalClear software, you will need to select the device type in 
order to control the instrument.   
 

Select the Image Collection Device Type 
 
To select the correct device type, 
 
1. Start CrystalClear and log in as the administrator. 
 
2. Close the sample by clicking Cancel or OK in the Open Sample dialog.  
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3. Click Utilities > Administrator Utilities. 
 The Administrator Utilities dialog will appear.  
 

  
 
4.  From the Image Collection Device Type  drop down list, select the appropriate device. 
 

The current choices are R-AXIS II, R-AXIS IV, R-AXIS IV++, AFC7 Mercury, AFC8 Mercury, AFC9 
Jupiter, and AFC9 Jupiter210. 
 

5. If changes are made in Administrator Utilities, the following CrystalClear dialog appears. 
Click OK 

 
You must exit CrystalClear and restart the program in order for the new Administrator 
Utilities settings to be embedded.  

 

 
 
If no changes are made, close the Administrator Utilities dialog by clicking the  on the upper-
right of the dialog box. 

 
6. If necessary, exit CrystalClear by clicking the  on the upper-right of the screen. 
 

• Alternatively, you can click File > Exit on the menu bar.  
 
 
Determine Direct Beam Position  
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In order to correctly process data that have been collected on the instrument, the position of the direct X-
ray beam on the face of the detector at 20 equal to 0 must be determined.  This procedure must be 
performed after every filament change (on instruments using a rotating anode source) or after replacing 
the X-ray tube (on instruments using a sealed tube source).  Note that the procedure outlined below can 
also be used to align the detector to the X-ray beam (see the appropriate hardware manual for 
instructions on how to perform this procedure).  
 
Note for R-AXIS users: On the R-AXIS IV and R-AXIS IV++ systems, the imaging plates (IPs) are 
attached to a flexible stainless steel belt.  When each IP is placed in the expose position, the IPs are not 
placed in exactly the same position (there is generally a 1 to 4 pixel difference in the position), 
effectively resulting in a two (2) detector system.  Failure to correct for this effect can cause problems 
during processing, due to drastic changes in the direct beam position between successive images.  The 
instrument server uses the direct beam position information to shift the images read from one of the IPs 
when they are written to disk, so that the direct beam position on images from both IPs coincide, 
effectively reducing the system back to a single detector system. 
 

Warning:  In order to protect the detector, the direct beam shall always be attenuated during direct 
beam shots. 

 
To take a direct beam shot,  
 
1. Start CrystalClear and log in as the administrator. 
 
2. Close the sample by clicking Cancel or OK in the Open Sample dialog.  
 
3. Click Utilities > Administrator Utilities. 
 The Administrator Utilities dialog will appear.  

 
4. Remove the beam stop. 

 
Remember to return the beam stop when direct beam shots are complete. 
 

5. Specify the settings for Direct beam shots . 
 

a. Set the Number of shots to at least 5 for the R-Axis detector.  For the CCD, only one (1) direct 
beam shot will be taken regardless of the value entered. 

 
b. For R-AXIS detectors, the detector should generally be initialized (so that the IPs are erased) 

before taking direct beam shots, and so Initialize before direct beam shots should be selected. 
 
6. Click Take! to take direct beam shot(s). 
 

When doing direct beam shots, you do not need to turn down the generator, but you must place some 
attenuation in the X-ray beam. 
  

The images generated during direct beam shots are placed in the DirectBeamShots subdirectory of 
the Program Directory.  The direct beam utility generates a log file, called DirectBeam.log, which 
contains output information concerning the position and shape of the direct beam for each shot taken.  
For R-AXIS detectors, there also a summary at the end of the log file containing the important results 
from the direct beam shots.  The direct beam utility also generates a summary file, called 
DirectBeamSummary.log, which contains the summaries for all direct beam shots taken on the 
detector. 
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A summary of the typical log file DirectBeam.log generated by the direct beam shot utility can be 
found in Appendix C: Sample Log Files on page 161. 
 
7. Replace beam stop when finished. 
 
8. Close the Administrator Utilities by clicking the  on the upper-right of the dialog box. 
 
 

Check PMT (PhotoMultiplier Tube) 
 
On R-AXIS systems, to check the photomultiplier tube,  
 
1. Start CrystalClear and log in as the administrator. 
 
2. Close the sample by clicking Cancel or OK in the Open Sample dialog.  
 
3. Click Utilities > Administrator Utilities. 
 The Administrator Utilities dialog will appear.  
 
4. Specify if the instrument should be initialized before checking the PMT, by either checking 

(initialize the instrument) or unchecking (do not initialize the instrument) the Initialize R-AXIS 
check box in the Photo Multiplier Tube (PMT) check group. 
 

5. Click Take! to check the PMT. 
 

On CCD systems, this check is not available. 
 
6. Close the Administrator Utilities by clicking the  on the upper-right of the dialog box. 
 
 
For information on how to interpret the result, consult the appropriate instrument hardware manual. 
 
The images generated during the PMT check is placed in the PMTCheckImages subdirectory of the 
Program Directory.  The PMT check utility generates a log file, called PMTCheck.log, which contains 
output information concerning the average background, 3σ level and the number of pixels having a value 
of 0 in the image.  The PMT check utility also generates a summary file, called 
PMTCheckSummary.log, which contains the summaries for all PMT checks performed on the 
detector. 
 
A summary of the typical log file PMTCheck.log generated by the PMT check utility can be found in 
in Appendix C: Sample Log Files on page 161. 
 
 
Continuously Reading an IP 
 
On R-AXIS systems, the system can be set up to continuously read the IPs.  This is mostly used as a 
diagnostic tool and will normally only be performed by a Rigaku/MSC service technician.  To put the R-
AXIS in continuous IP read mode,  
 



Appendix B:  Administration 

 
CrystalClear User Manual  Page 159 

1. Start CrystalClear and log in as the administrator. 
 
2. Close the sample by clicking Cancel or OK in the Open Sample dialog.  
 
3. Click Utilities > Administrator Utilities. 
 The Administrator Utilitie s  dialog will appear.  
 
4. Specify the setting for the Continuous IP Read mode. 
 

a) Specify the number times to read the IPs in the Number of cycles field. 
b) If the R-AXIS should be initialized before performing the test, select the Initialize R-AXIS 

check box. 
c) Select the Write images to same file  check box if the images are to be written to the same file 

on disk.  If this check box is unselected, then each image will be written to a separate file on 
disk.  Unless there is a need for saving the images read, writing the images to the same file on 
disk is the preferred mode of operation.  Each image is approximately 18 Mb in size, and so 
writing the images to separate files can quickly fill up the disk (which may be the system disk). 

d) If it is desired that the X-ray shutter open briefly (for approximately 1 second) before reading an 
IP, select the Open X-ray shutter during read option.   

 
Unless there is a valid reason for selecting this option, we strongly suggest that 
you unselect this option for safety reasons. 

 
5. Click Take! to begin the continuous IP read. 
 

On CCD systems, this feature is not available. 
 
The images generated during the continuous IP read check is placed in the 
ContinuousIPReadImages subdirectory of the Program Directory.  The continuous IP read check 
utility generates a log file, called ContinuousIPRead.log, which contains output information 
indicating the success of failure of each of the IP reads.  The continuous IP read check utility also 
generates a summary file, called ContinuousIPReadSummary.log, which contains the summaries 
for all continuous IP read checks performed on the detector. 
 
A summary of the typical log file ContinuousIPRead.log generated by the PMT check utility can 
be found in Appendix C: Sample Log Files on page 161. 
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Appendix C: Sample Log Files 
 

During processing, CrystalClear records information in log files.  You can use these log files to double-
check that the correct parameters were used during processing, and to help you refine your settings.   
 
Below is a list of the logs files that are created by the d*TREK compute server.  
 
For d*TREK 
 
Process Log Filename  

Find Spots dtfind.log 

Refine Spots dtrefine.log 

Index Spots dtindex.log 

Predict Spots dtpredictspots.log 

Integrate Spots dtintegrate.log 

Scale and Merge dtscalemerge.log 

Merge Reflections dtreflectionmerge.log 

Strategy dtstrategy.log 

  
 
For PROCESS 
 
Process Log Filename  

Peak Search psearch.log 

Index index.log 

Refine refosc.log 

Integrate integ.log 

Merge merge.log 

Scale  scale.log 

Post Refine post.log 

Average average.log 

 
 
For TwinSolve 
 
Process Log Filename  

  

  

  

The log files are stored in the Sample directory.  
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You can view the log files during processing to follow the progress of the job. 
 
To view a log file during a processing step,  
 
1. Click Windows > Log File Viewer.  
 The selected log file will be displayed on the screen.  
 
If you wish to view log files from previous processing steps,  
 
1. Click View > Log File . 

The Open dialog appears. 
 

 
 
2. Select the log file to view. 
 
3. Click Open.  
 The selected log file will be displayed on the screen. 
 

Find Spots Log 
A summary of a typical log file, which is produced by Find Spots, is listed below. The filename is 
dtfind.log. 
 
1 dtfind:  Copyright (c) 1996 Molecular Structure Corporation 
2 ... 
3 File /user4/jwp/DATA/NUCL4/nucl4001.osc successfully opened. 
4 Find object listing: 
5 Sigma: 0 
6 Minimum: 2000 
7 Circle lim: 950, 950, 0, 1343 
8 Rect lim: 19, 1881, 19, 1881 
9 Spot wind.: 30, 30 
10 Peak filt.: 6 
11 Back. tile: 237, 237 
12 Pad: 3 
13 Seq. num.: 1, 1 
14 Image dim.: 1900, 1900 
15 3D dump: 0 
16 There were 554 preliminary reflections found in a 2D search. 
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17 Average peak 3sigma size in pixels: 
18    7.99 by   6.69 pixels. 
 
19 dtfind: There were 553 spots found. 
20 dtfind: Spots written to dtfind.ref 
21 DTREK_STATUS: 0 
 
If the sequence range had included multiple contiguous images and the 2D method was not specified, 
then lines 17-18 in the output above would have also included the peak size in degrees: 
 
17 Average peak 3sigma size in pixels and degrees: 
18   11.82 by   9.87 pixels by  0.66 degrees. 
 
If the box size is incorrectly chosen, reflection centroids may not be accurate and subsequent 
autoindexing and refinement will fail.  If the crystal is slipping during data collection, it will have 
multiple orientations and subsequent steps will fail.  If the crystal is twinned or cracked, reflection 
centroids may come from different crystal fragments with different orientations and subsequent steps 
will fail. 
For the lowest residuals during refinement between observed and calculated reflection centroids, it is 
best to have spots from a narrow rotation range.  For a better refinement of detector position and crystal 
properties, it is better to have spots from a wider rotation range.   
 

 

Index Spots Log 
A summary of a typical log file called dtindex.log  that is created during the Index Spots procedure, 
is shown below: 
 
1 dtindex:  Copyright (c) 1996 Molecular Structure Corporation 
2 ... 
3 Reciprocal lengths of shortest difference vectors: 
4 72.6744 
5 60.6784 
6 57.6331 
7 50.2659 
8 42.3718 
 
9 Method:     Direct space cosine Fourier transform 
10 Out header: dtindex.head 
11 Max cell:   68.0689 
12 Num diffs:  50 
13 Spacegroup: 0 
14 Verbose:    1 
 
15 Performing direct space cosine Fourier transform indexing ... 
16 Suggested grid interval is: 1.5 
17 Suggested max cell is:      112.5 
18 Actual grid interval is:    1.5 
19 Actual max cell is:         112.5 
20 Start peak minimum: 0.924801 
21 Used  peak minimum: 0.924801 
22 Number of peaks found: 4 
23 Start peak minimum: 0.647361 
24 Used  peak minimum: 0.647361 
25 Number of peaks found: 5 
 
26 Least-squares fit of reduced primitive cell to 44 lattice characters 
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27 sorted on decreasing (highest to lowest) symmetry. 
28 Only solutions with residuals <=  10.0 are listed. 
29 ====================================================================== 
30 Soln  LeastSq Spgrp Cent         Bravais         a         b         c 
31  num residual  num* type            type     alpha      beta     gamma 
32 ====================================================================== 
33    4    3.789    75    P      tetragonal    71.698    71.698   106.730 
34                                             90.000    90.000    90.000 
35  
36    6    3.735    21    C    orthorhombic   100.969   101.820   106.730 
37                                             90.000    90.000    90.000 
38  
39    9    3.677     5    C      monoclinic   100.969   101.820   106.730 
40                                             90.000    90.335    90.000 
41  
42   10    1.130    16    P    orthorhombic    69.244    74.070   106.730 
43                                             90.000    90.000    90.000 
44  
45   11    0.638     3    P      monoclinic    74.070    69.244   106.730 
46                                             90.000    90.457    90.000 
47  
48   13    0.000     1    P       triclinic    69.244    74.070   106.730 
49                                             90.457    90.000    90.482 
50  
51 ====================================================================== 
52 *Suggested spacegroup number until systematic absences are examined. 
53 Enter solution number of your choice: 10 
54 Solution number 10 selected. 
 
55 Unit cell parameters and orientation angles 
56 ====================================================================== 
57       Integer         a         b         c 
58 Num  residual     alpha      beta     gamma     Rot1     Rot2     Rot3 
59 ====================================================================== 
60   1     0.044    69.241    74.081   106.637  155.782   30.261  102.479 
61                  89.463    90.013    89.579 
 
62   2     0.044    69.241    74.081   106.637 -155.782  -30.261  -77.521 
63                  90.537    89.987    89.579 
 
64   3     0.044    69.241    74.081   106.637   24.218  -30.261  -77.521 
65                  90.537    90.013    90.421 
 
66   4     0.044    69.241    74.081   106.637  -24.218   30.261  102.479 
67                  89.463    89.987    90.421 
 
68 ====================================================================== 
69 Enter your choice: 1 
70 Orientation angles choice 1 selected. 
 
71 Crystal listing: 
 
72 Unit cell lengths:   69.2409   74.0809  106.6370 
73 Unit cell  angles:   90.0000   90.0000   90.0000 
74 Unit cell  volume: 546986.750 
75 Orientation angles:  155.7821   30.2615  102.4790 
76 Mosaicity:    0.300 
77 Description: unknown 
 
78 Spacegroup number: 16 
79 name: P222 
80 Num. equiv. posns: 4 
81 dtindex - Wrote header file dtindex.head 
82 DTREK_STATUS: 0 
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Lines 3-8 The reciprocal lengths in Ångstroms of the shortest reciprocal lattice difference vectors 
are listed.  These often (but not always!) suggest the longest unit cell length.  Sometimes 
the difference vector indicating the longest cell length is not available from the input 
reflection list.  Sometimes a split, cracked or twinned crystal will give extraordinarily long 
lengths which is diagnostic of these conditions. 

Lines 15-19 A direct space cosine Fourier map is calculated for a hemisphere volume with radius 
112.5 Å and grid size 1.5 Å.  If the maximum cell length of the crystal is larger than the 
Actual max cell (line 19), then it will be impossible to get an initial cell, so set Max 
Cell Length in the dialog and re-run.  For small cell lengths, if the Actual grid 
interval (line 18) is too large, then it will be difficult to get a solution, set Grid Size  in 
the dialog and re-run. 

Line 20 An initial minimum peak height in the Fourier map is determined and listed.  Since the 
origin of the Fourier map (point 0,0,0) is normalized to have a value of 1, a peak 
minimum of 0.9 or greater suggests that a solution to indexing will be found.  Initial peak 
minimums below 0.9 suggest a problem such as incorrect grid size, incorrect spatial 
distortion, incorrect direct beam position, incorrect detector position, or a split, cracked, or 
twinned crystal. 

Line 22 Four peaks were found with a height above the minimum and at least 3 were non-coplanar 
and define a 3-dimensional lattice.  If at least 3 non-coplanar peaks were not found, the 
peak minimum would have been lowered by 5% and the Fourier map searched again.  
This will be repeated until a solution is found or the minimum peak height is 0.3. 

Lines 23-25 Just in case, after 3 non-coplanar peaks are found the peak minimum is reduced to 70% of 
the original value and the Fourier map is searched again. 

Lines 26-51 The 3 non-coplanar peaks are used to determine a reduced primitive cell.  This reduced 
primitive cell is then fit with a least-squares procedure (Anderson & Bernstein, 1988; 
Paciorek & Bonin, 1992) to the 44 lattice characters (Int. Tables Vol. A, pp. 746).  The 
solutions with residuals less than or equal to 10 are listed in order of decreasing 
symmetry. Usually, residuals below 5 have been solutions.  Any lattice symmetry must be 
ultimately confirmed by examining symmetry in the diffraction intensities! 

Line 53 Since User Chooses Solution in the menu was set, the user is prompted to select a 
solution.  Solution 10 was selected. 

Lines 55-68 The orientation angles for the selected cell and lattice are displayed sorted on an 
Integer residual.  Residuals greater than 0.10 are considered poor solutions and 
suggest a problem such as incorrect spatial distortion, incorrect direct beam position, 
incorrect detector position, or a split, cracked, or twinned crystal.  In general, orientations 
with the same residual are equivalent. 

Line 69 The user was prompted to select a solution, and number 1 was selected. 
Lines 71-80 The crystal cell properties are listed.  Note that indexing does not determine the crystal 

mosaicity, but nevertheless a default value is listed (line 76). 
Line 90 The resulting unit cell properties is written to the output header file dtindex.head 

which can be used as input to the next step:  Refine. 

 

Refine Spots Log 
A summary of a typical log file created by Refine Spots, called dtrefine.log, is shown below: 
 
 
1 dtrefine:  Copyright (c) 1996 Molecular Structure Corporation 
2 Header of file dtindex.head successfully read. 
3 ... 
4 Crystal listing: 
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5 Unit cell lengths:   69.2409   74.0809  106.6370 
6 Unit cell  angles:   90.0000   90.0000   90.0000 
7 Unit cell  volume: 546986.812 
8 Orientation angles:  155.7820   30.2610  102.4790 
9 Mosaicity:    0.300 
10 Description: unknown 
 
11 Spacegroup number: 16 
12 name: P222 
13 Num. equiv. posns: 4 
 
14 CRYSTAL_Goniometer listing:  
 
15 Description: Eulerian 3-circle 
16 Number of values: 3 
 
17          Name    Datum   Current  Units   Vector 
18 ===================================================================== 
19         Omega    0.000   Unknown    deg   (  1.000,   0.000,   0.000) 
20           Chi    0.000   Unknown    deg   (  0.000,   1.000,   0.000) 
21           Phi    0.000   Unknown    deg   (  1.000,   0.000,   0.000) 
22 ===================================================================== 
 
23 Source listing:  
 
24 Single wavelength: 1.5418 
25 Polarization: 0.5, 1, 0, 0 
26 Intensity: 0 
 
27 RX_Detector listing:  
 
28 Pixel dimensions: 1900, 1900 
29 Nominal size in mm: 193.23, 199.5 
30 Description: RAXIS conversion 
 
31 RX_Goniometer listing:  
 
32 Description: UNKNOWN 
33 Number of values: 6 
 
34          Name    Datum   Current  Units   Vector 
35 ===================================================================== 
36          RotZ    0.000   Unknown    deg   (  0.000,   0.000,   1.000) 
37    RotX/Swing    0.000   Unknown    deg   ( -1.000,   0.000,   0.000) 
38          RotY    0.000   Unknown    deg   (  0.000,   1.000,   0.000) 
39        TransX    0.000   Unknown     mm   (  1.000,   0.000,   0.000) 
40        TransY    0.000   Unknown     mm   (  0.000,   1.000,   0.000) 
41   TransZ/Dist   98.000   Unknown     mm   (  0.000,   0.000,  -1.000) 
42 ===================================================================== 
43 DetResolution min: 154180 
44 DetResolution max: 1.6678 
 
45 Refine resol min: 99999 
46 Refine resol max: 1e-05 
47 I/sigma cutoff:   0 
48 Rejection limits: 1, 1, 2 
49 Rel. rot. weight: 9999 
 
50 Refinement results 
51 ======================================================== 
52 Crystal 
53                a, b, c:    68.6284    73.7186   106.5789 
54                 Sigmas:     0.0170     0.0102     0.0235 
55                 Shifts:     0.0000     0.0000     0.0000 
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56     alpha, beta, gamma:    90.0000    90.0000    90.0000 
57                 Sigmas:     fixed      fixed      fixed  
58                 Shifts:     fixed      fixed      fixed  
 
59  Crys Rot1, Rot2, Rot3:   155.773     29.915    102.325 
60                 Sigmas:     0.0094     0.0029     0.0084 
61                 Shifts:     0.0000     0.0000     0.0000 
 
62              Mosaicity:     0.300 
63                  Sigma:     0.0000 
64                  Shift:     0.0000 
65 ======================================================== 
66 Detector:  0 
67 Trans1, Trans2, Trans3:     0.074      0.069     97.871 
68                 Sigmas:     0.1201     0.1350     0.2432 
69                 Shifts:     0.0000     0.0000     0.0000 
 
70   Det Rot1, Rot2, Rot3:     0.056     -0.026     -0.034 
71                 Sigmas:     0.1259     0.0640     0.0724 
72                 Shifts:     0.0017     0.0000     0.0000 
73 ======================================================== 
74 Source 
75 Wavelength, Rot1, Rot2:     1.5418     0.000      0.000 
76                 Sigmas:     fixed      fixed      fixed  
77                 Shifts:     fixed      fixed      fixed  
78 ======================================================== 
79 Refinement residuals  
80 rmsResid (mm)  = 0.271192 
81 rmsResid (Deg) = 0.292639 
82 ======================================================== 
 
83 Reflections in list:  553 
84 Reflections accepted: 514 
85 Reflections rejected: 39 
86 Reflections ignored:  0  (Outside I/sigI or Resolution limits) 
 
87 dtrefine - Wrote header file dtrefine.head 
88 DTREK_STATUS: 0 
 
Lines 4-13 The original or starting crystal properties in the input header are listed. 
Lines 14-22 The original crystal goniometer properties are listed. 
Lines 23-26 The original source properties are listed. 
Lines 27-42 The original or starting detector properties and position are listed. 
Lines 43-44 The minimum and maximum resolution in Ångstroms of pixels on the detector are 

computed and listed. 
Lines 45-49 The input (command line) options to Refine Spots are listed. 
Lines 50-78 The refinement results (refined crystal, detector and source properties) are listed.  The 

shifts shown are for the last cycle and should be very close to 0.0000.  Any property not 
refined will have the word “fixed” in the output or possibly 0.0000 for the estimated 
standard deviation.  

Lines 79-82 The root-mean-square residuals for the observed reflection centroids in millimeters and 
degrees are shown.  Residuals depend on spot centroid variances which depend on the 
size of the detector pixels, whether the reflection centroids are from 2D (single image) 
or 3D (multiple images) data, the detector calibration, the spot size, the crystal 
mosaicity, the image rotation angle increment, etc.  For 2D data, the residuals will be 
higher than with 3D data.  Typical values for 2D data when the image rotation width is 
less than the mosaicity are 0.1-0.4 mm and 0.1 to 0.5 degrees.  For 3D data, these values 
are 0.05-0.1 mm and 0.05-0.1 degrees. 

Lines 83-86 The number of input reflections is listed along with the number used in the refinement.  
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Those reflections that are rejected exceeded the rejection limits for the differences 
between observed and calculated centroid or were too close to the rotation axis.  Those 
reflections that are ignored did not pass the Intensity/SigmaI and resolution limits. 

 

Predict Log 
 
1 dtpredict:  Copyright (c) 1996 Molecular Structure Corporation 
2 d*TREK version 6.1SSI -- Oct 27 2000 
3 Command line: 
4  dtpredict input.head -seq 180 180 -mosaicity 0.60 -out output.head -ref \ 
5     dtpredict.ref -display -list 
6      Header of file input.head successfully read. 
 
7 Crystal listing: 
 
8  Unit cell lengths:   78.9495   78.9495   36.8831 
9  Unit cell  angles:   90.0000   90.0000   90.0000 
10  Unit cell  volume: 229893.231 
11 Orientation angles:   58.4917  -54.9206  -90.2980 
12          Mosaicity:     0.600 
13        Description: unknown 
14 RX_NONUNF_TYPE: >>None<< 
15 Predict listing: 
 
16 Spacegroup number: 96 
17              name: P43212 
18 Num. equiv. posns: 8 
19 Equival. position  1: 
20           1,      0,      0           0 
21           0,      1,      0           0 
22           0,      0,      1           0 
 
23 Equival. position  2: 
24          -1,      0,      0           0 
25           0,     -1,      0           0 
26           0,      0,      1         0.5 
 
27 Equival. position  3: 
28           0,      1,      0         0.5 
29          -1,      0,      0         0.5 
30           0,      0,      1        0.75 
 
31 Equival. position  4: 
32           0,     -1,      0         0.5 
33           1,      0,      0         0.5 
34           0,      0,      1        0.25 
 
35 Equival. position  5: 
36           0,      1,      0           0 
37           1,      0,      0           0 
38           0,      0,     -1           0 
 
39 Equival. position  6: 
40           0,     -1,      0           0 
41          -1,      0,      0           0 
42           0,      0,     -1         0.5 
 
43 Equival. position  7: 
44          -1,      0,      0         0.5 
45           0,      1,      0         0.5 
46           0,      0,     -1        0.75 
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47 Equival. position  8: 
48           1,      0,      0         0.5 
49           0,     -1,      0         0.5 
50           0,      0,     -1        0.25 
 
51 Crystal Orientation Matrix is: 
52 [0][*]: -3.78606e-005, -0.00727938, 0.0103656 
53 [1][*]: 0.00666557, 0.00880277, 0.00620622 
54 [2][*]: -0.0230547, 0.0117159, 0.00814348 
 
55 CRYSTAL_ Goniometer listing:  
 
56         Description: Eulerian 3-circle 
57    Number of values: 3 
 
58          Name    Datum   Current  Units   Vector 
59 ===================================================================== 
60  VirtualOmega    0.000   Unknown    deg   (  1.000,   0.000,   0.000) 
61    VirtualChi    0.000   Unknown    deg   (  0.000,   0.000,   1.000) 
62           Phi    0.000   Unknown    deg   (  1.000,   0.000,   0.000) 

===================================================================== 
 
63 Source listing:  
 
64   Single wavelength: 1.5418 
65    Direction vector: 0, 0, 1 
66 Spectral Dispersion: 0.0002, 0.0002 
67           Crossfire: 0.0002, 0.0002, 0, 0 
68        Polarization: 0.5, 1, 0, 0 
69                Size: 0, 0, 0, 0 
70           Intensity: 0 
71 RX_Detector listing:  
 
72    Pixel dimensions:     3000, 3000 
73  Nominal size in mm:     300, 300 
74         Description:     RAXIS conversion 
75   Fast pixel vector: 1, 0, 0 
76   Slow pixel vector: 0, 1, 0 
77     Spatial distortion descriptive text: 
78     Simple pixel scaling spatial distortion 
79     Simple spatial distortion: 
80     Center of primary beam: 1479, 1529 
81            Pixel size (mm): 0.1, 0.1 
82          Direction vectors: 0, 1, -1, 0 
 
83 RX_ Goniometer listing:  
 
84         Description: UNKNOWN 
85    Number of values: 6 
 
86          Name    Datum   Current  Units   Vector 

===================================================================== 
87  RotAboutBeam    0.169   Unknown    deg   (  0.000,   0.000,   1.000) 
88        2Theta    0.079   Unknown    deg   ( -1.000,   0.000,   0.000) 
89          RotY    0.214   Unknown    deg   (  0.000,   1.000,   0.000) 
90        XShift   -0.054   Unknown     mm   (  1.000,   0.000,   0.000) 
91        YShift    0.120   Unknown     mm   (  0.000,   1.000,   0.000) 
92      Distance  119.478   Unknown     mm   (  0.000,   0.000,  -1.000) 

===================================================================== 
93 DetResolution min:  154180 
94 DetResolution max:  1.51956 
95 DetResolution edge: 1.76436 
 
96 Rotation list: 
97             Start:  184.500 
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98               End:  185.000 
99         Increment:    0.500 
100              Time:  180.000 
101      Oscillations: 0 
102       Axis vector: 1, 0, 0 
103         Axis name: Phi 
104        Dark start: 0 
105       Dark update: 0 
106 Dark change limit: 0 
107   DCoffset  start: 0 
108   DCoffset update: 0 
109 Predict resol min: 999999 
110 Predict resol max: 0.5 
 
111 Component 1 crystal mosaicity: 0.6 
 
112 dtpredict: There were 1339 reflections predicted. 
113 Number of reflections written: 1339 
114 dtpredict: Reflections written to dtpredict.ref 
 
 
Strategy Log 
 
1 dtstrategy:  Copyright (c) 1997 Molecular Structure Corporation 
2  d*TREK version 6.1SSI -- Oct  6 2000 
3 Command line: 
4  dtstrategy input.head -cmin 99.00 -rangemax 360.00 -lscale 0.30 -out \ 
5     output.head 
6      Header of file input.head successfully read. 
7 RX_NONUNF_TYPE: >>None<< 
8 Setting predict resolution to detector EDGE, not corner! 
9 Predicting reflections ... 
  
10 Component 1 crystal mosaicity: 0.6 
11  ... done.  8936 reflections predicted. 
  
12 Crystal listing: 
  
13  Unit cell lengths:   78.8782   78.8782   36.8650 
14  Unit cell  angles:   90.0000   90.0000   90.0000 
15  Unit cell  volume: 229365.567 
16 Orientation angles:  -53.5160   71.4165  -86.2778 
17          Mosaicity:     0.600 
18        Description: unknown 
  
19 Spacegroup number: 75 
20              name: P4 
21 Num. equiv. posns: 4 
  
22 Reducing reflnlist to asymmetric unit and sorting ... 
23  ... done. 
24 Searching for best rotation start and range ... 
25  ... done. 
  
26 Strategy results 
 ============================== 
27 Resolution:       23.66 - 1.76 
28 Rotation start:   42.00 
29 Rotation end:    102.00 
30 Rotation range:   60.00 
 ============================== 
  
31 Completeness vs Rotation range 
 ------------------------------------ 
32     Rotation     Cumul  %Comp  %Comp 
33       range      range  shell  cumul  
 ------------------------------------ 
34   42.0 -  47.0     5.0   15.1   15.1 
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35   47.0 -  52.0    10.0   15.4   31.9 
36   52.0 -  57.0    15.0   16.3   45.9 
37   57.0 -  62.0    20.0   14.4   58.4 
38   62.0 -  67.0    25.0   15.0   69.7 
39   67.0 -  72.0    30.0   15.6   77.7 
40   72.0 -  77.0    35.0   14.5   85.1 
41   77.0 -  82.0    40.0   15.6   91.4 
42   82.0 -  87.0    45.0   14.7   94.5 
43   87.0 -  92.0    50.0   15.4   97.1 
44   92.0 -  97.0    55.0   13.8   98.5 
45   97.0 - 102.0    60.0   15.0   99.1 
 ------------------------------------ 
46   42.0 - 102.0    60.0   99.1   99.1 
  
  
47 Expected Completeness vs Resolution 
 -------------------------------------------------------------------------------- 
48   Resolution      Calc     Num   Num     Num     Num    Num    Avg  %Comp  %Comp 
49      range      unique  reflns  rejs   mults  single unique   mult  shell  cumul 
 -------------------------------------------------------------------------------- 
50  23.66 -  3.78    2777    5666     0    2037     592   2629   2.38   94.7   94.7 
51   3.78 -  3.01    2592    5555     0    1888     703   2591   2.42  100.0   97.2 
52   3.01 -  2.63    2370    5370     0    1925     444   2369   2.45  100.0   98.1 
53   2.63 -  2.39    2481    5296     0    1814     666   2480   2.40  100.0   98.5 
54   2.39 -  2.22    2370    5333     0    1814     555   2369   2.49  100.0   98.8 
55   2.22 -  2.09    2666    6185     0    2222     444   2666   2.49  100.0   99.0 
56   2.09 -  1.98    2370    5148     0    1814     555   2369   2.41  100.0   99.1 
57   1.98 -  1.89    2481    5259     0    1888     592   2480   2.36  100.0   99.2 
58   1.89 -  1.82    2185    5037     0    1666     518   2184   2.54  100.0   99.3 
59   1.82 -  1.76    2629    5259     0    1777     777   2554   2.36   97.1   99.1 
 -------------------------------------------------------------------------------- 
60  23.66 -  1.76   24921   54108     0   18845    5846  24691   2.43   99.1   99.1 
  
61 *** Note: cell length factor was 0.30, so the results above are approximate. *** 
  
 
 

Integrate Log 
An edited summary of a typical log file called dtintegrate.log that is created is shown following: 
 
1 dtintegrate:  Copyright (c) 1996 Molecular Structure Corporation 
2      Header of file dtrefine.head successfully read. 
3 RX_NONUNF_TYPE: >>None<< 
4  
5  
6 Command line string: >>-reso<< 
7 Command line string: >>-window<< 
8 Command line string: >>-pad<< 
9 Command line string: >>-profsize<< 
10 Command line string: >>-batch<< 
11 Command line string: >>-display<< 
12 Command line string: >>-seq<< 
13  
14 =============================================== 
15 Integrate object listing: 
16 =============================================== 
17 Verbose level:                    1 
18 Scan sequence range:              1, 20 
19 Resolution range:                 100, 3 
20 Images/batch:                     5 
21 Batch prefix:                      
22 Image padding:                    2 
23 Window size:                      30, 30 
24 Profile size:                     0.5, 0.5 
25 =============================================== 
26  
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27 dtintegrate: 3D method used 
28 RX_NONUNF_TYPE: >>None<< 
29  
30      File /user4//DATA/NUCL4/nucl4001.osc successfully opened. 
31  
32 ================================================================== 
33 ================================================================== 
34 IMAGE #: 1  (of 20) 
35    Name: /user4//DATA/NUCL4/nucl4001.osc 
36    Date: 25-Sep-1997 
37    Time: 14:53:12 
38 ================================================================== 
39  
40 Rotation list: 
41             Start:   24.000 
42               End:   24.250 
43         Increment:    0.250 
44              Time:  120.000 
45  
46 Reflection dispositions 
47 ================================================= 
48 Status:    New  Active    Full   DNormal DSpecial 
49 Number:    340     340       0       0       0 
50 ================================================= 
51  
52 Shoebox dispositions 
53 ============================================= 
54 Status:  Total Filling    Full   Freed 
55 Number:   1951     340       0    1611  
56 ============================================= 
57  
58 ... 
59      File /user4//DATA/NUCL4/nucl4020.osc successfully opened. 
60  
61 ================================================================== 
62 ================================================================== 
63 IMAGE #: 20  (of 20) 
64    Name: /user4//DATA/NUCL4/nucl4020.osc 
65    Date: 25-Sep-1997 
66    Time: 14:58:28 
67 ================================================================== 
68  
69 Rotation list: 
70             Start:   28.750 
71               End:   29.000 
72         Increment:    0.250 
73              Time:  120.000 
74  
75 Reflection dispositions 
76 ================================================= 
77 Status:    New  Active    Full   DNormal DSpecial 
78 Number:      0     338     338     648      90 
79 ================================================= 
80  
81 Shoebox dispositions 
82 ============================================= 
83 Status:  Total Filling    Full   Freed 
84 Number:   1951       0     738    1213  
85 ============================================= 
86 Refinement options found: 
87      +CrysAll +DetAll -rej 1.0 1.0 2.0 -cycles 10 -weight 9999 -display -go 
88 Refine listing: 
89  
90 Crystal listing: 
91  
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92  Unit cell lengths:   68.7533   73.7744  107.0866 
93  Unit cell  angles:   90.0000   90.0000   90.0000 
94  Unit cell  volume: 543168.687 
95 Orientation angles:  155.9357   29.9512  102.4337 
96          Mosaicity:    0.480 
97        Description: unknown 
98  
99 Spacegroup number: 16 
100              name: P222 
101 Num. equiv. posns: 4 
102  
103 CRYSTAL_Goniometer listing:  
104  
105         Description: Eulerian 3-circle 
106    Number of values: 3 
107  
108          Name    Datum   Current  Units   Vector 
109 ===================================================================== 
110         Omega    0.000   Unknown    deg   (  1.000,   0.000,   0.000) 
111           Chi    0.000   Unknown    deg   (  0.000,   1.000,   0.000) 
112           Phi    0.000   Unknown    deg   (  1.000,   0.000,   0.000) 
113 ===================================================================== 
114  
115 Source listing:  
116  
117   Single wavelength: 1.5418 
118        Polarization: 0.5, 1, 0, 0 
119           Intensity: 0 
120  
121 RX_Detector listing:  
122  
123    Pixel dimensions: 1900, 1900 
124  Nominal size in mm: 193.23, 199.5 
125         Description: RAXIS conversion 
126  
127 RX_Goniometer listing:  
128  
129         Description: UNKNOWN 
130    Number of values: 6 
131  
132          Name    Datum   Current  Units   Vector 
133 ===================================================================== 
134          RotZ    0.230   Unknown    deg   (  0.000,   0.000,   1.000) 
135    RotX/Swing   -0.026   Unknown    deg   ( -1.000,   0.000,   0.000) 
136          RotY   -0.042   Unknown    deg   (  0.000,   1.000,   0.000) 
137        TransX    0.092   Unknown     mm   (  1.000,   0.000,   0.000) 
138        TransY    0.061   Unknown     mm   (  0.000,   1.000,   0.000) 
139   TransZ/Dist   98.013   Unknown     mm   (  0.000,   0.000,  -1.000) 
140 ===================================================================== 
141 DetResolution min: 154180 
142 DetResolution max: 1.66982 
143  
144 Refine resol min: 99999 
145 Refine resol max: 1e-05 
146 I/sigma cutoff:   0 
147 Rejection limits: 1, 1, 2 
148 Rel. rot. weight: 9999 
149  
150 Refinement results 
151 ======================================================== 
152 Crystal 
153                a, b, c:    68.7510    73.7993   107.0777 
154                 Sigmas:     0.0032     0.0025     0.0053 
155                 Shifts:     0.0000     0.0000     0.0000 
156  



Appendix C:  Sample Log Files 

 
Page 174  CrystalClear User Manual 

157     alpha, beta, gamma:    90.0000    90.0000    90.0000 
158                 Sigmas:     fixed      fixed      fixed  
159                 Shifts:     fixed      fixed      fixed  
160  
161  Crys Rot1, Rot2, Rot3:   155.938     29.965    102.437 
162                 Sigmas:     0.0012     0.0011     0.0035 
163                 Shifts:     0.0000     0.0000     0.0000 
164  
165              Mosaicity:     0.442 
166                  Sigma:     0.0221 
167                  Shift:     0.0000 
168 ======================================================== 
169 Detector:  0 
170 Trans1, Trans2, Trans3:     0.095      0.058     98.009 
171                 Sigmas:     0.0185     0.0138     0.0358 
172                 Shifts:     0.0000     0.0000     0.0000 
173  
174   Det Rot1, Rot2, Rot3:     0.252     -0.024     -0.043 
175                 Sigmas:     0.0166     0.0082     0.0085 
176                 Shifts:     0.0002     0.0000     0.0000 
177 ======================================================== 
178 Source 
179 Wavelength, Rot1, Rot2:     1.5418     0.000      0.000 
180                 Sigmas:     fixed      fixed      fixed  
181                 Shifts:     fixed      fixed      fixed  
182 ======================================================== 
183 Refinement residuals  
184 rmsResid (mm)  = 0.0724333 
185 rmsResid (Deg) = 0.0393826 
186 ======================================================== 
187  
188 Reflections in list:  648 
189 Reflections accepted: 645 
190 Reflections rejected: 3 
191 Reflections ignored:  0  (Outside I/sigI or Resolution limits) 
192  
193  
194 Strong peak info listing 
195 ================================================================================ 
196 Area    Num Intensity  Sigma BackAvg BackSig Siz0 Siz1 Siz2 Dl Shft0 Shft1 Shft2 
197 ================================================================================ 
198   1       0         0      0       0       0  0.0  0.0  0.0  0   0.0   0.0   0.0 
199   2       8    824481   1482     705      84 13.0 12.6  3.0 11  -0.9   0.1   0.0 
200   3      22   1667487   2064     831      92 12.7 14.5  4.8 12   0.1   0.0   0.0 
201   4      21   1296592   1936     854      89 13.2 13.5  5.9 12  -0.5   0.3   0.0 
202   5      15    578864   1376     774      84 12.9 11.8  3.1  9   0.0   0.6   0.0 
203   6       0         0      0       0       0  0.0  0.0  0.0  0   0.0   0.0   0.0 
204   7       0         0      0       0       0  0.0  0.0  0.0  0   0.0   0.0   0.0 
205   8     133    783169   1433     820      88 14.4 10.2  2.8 12  -0.5   0.5   0.0 
206   9     116    871217   1401     693      79 13.3 10.8  3.3 14   0.7   0.0   0.0 
207  10     101    802518   1323     715      74 13.3 10.7  3.5 13  -0.3  -0.3   0.0 
208  11     150    664956   1398     842      87 14.8 10.2  2.9 13   0.1   0.0   0.0 
209  12       0         0      0       0       0  0.0  0.0  0.0  0   0.0   0.0   0.0 
210  13       0         0      0       0       0  0.0  0.0  0.0  0   0.0   0.0   0.0 
211  14       6   1027184   1709     698      83 13.0 13.2  3.8 15   0.1   0.9   0.0 
212  15      22    961800   1779     767      89 12.1 13.4  4.5 14   0.9   0.5   0.0 
213  16      22    908059   1754     806      85 12.3 13.1  5.5 13   0.0  -0.2   0.0 
214  17      11    655907   1430     714      78 12.6 12.3  3.9 12   0.5  -0.2   0.0 
215  18       0         0      0       0       0  0.0  0.0  0.0  0   0.0   0.0   0.0 
216 ================================================================================ 
217 All     627    828911   1465     778      84 13.8 11.0  3.4 13   0.0   0.1   0.0 
218 ================================================================================ 
219    Normal: 648, Special: 90, Reclassified as partial: 1 
220 Integrate: ...done. 
221  
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222  
223 *** dtintegrate *** 
224 ================================================================ 
225 Summary of results for scan rotation from    24.000 to    29.000 
226          with image sequence numbers from     1     to    20 
227 ---------------------------------------------------------------- 
228  
229 Total reflections predicted:                2714 
230 Total reflections with no errors:           1687 
231 Total reflections with bad errors*:           64 
232 Total reflections partial in scan*:          886 
233 Total reflections unprocessed at end:          0 
234 Total reflection  profiles written:         1764 
235  
236 Reflection integration status codes 
237 ==================================== 
238                  Status  Num reflns 
239 ------------------------------------ 
240              No Errors:       1687 
241 ------------------------------------ 
242      Processed special:        158  Not processed as strong, but otherwise OK 
243              On edge 0:          2  Some intensity on edge of box in 1st dim 
244              On edge 1:          0  Some intensity on edge of box in 2nd dim 
245              On edge 2:         78  Some intensity on edge of box in 3rd dim 
246              Too far 0:          0  Obs centroid too far from calc in 1st dim 
247              Too far 1:          0  Obs centroid too far from calc in 2nd dim 
248              Too far 2:          0  Obs centroid too far from calc in 3rd dim 
249              Too big 0:          0  Obs size too large in 1st dim 
250              Too big 1:          0  Obs size too large in 2nd dim 
251              Too big 2:          0  Obs size too large in 3rd dim 
252              Overlap 0:          0 *Obs peak overlapped in 1st dim 
253              Overlap 1:          0 *Obs peak overlapped in 2nd dim 
254              Overlap 2:          0 *Obs peak overlapped in 3rd dim 
255               Too dark:         64 *Some peak pixels saturated 
256                Too low:          0 *Some peak pixels too low, may be shadowed 
257         Bad background:          0 *Error in background determination 
258      Bad background sd:          0 *Error in background sigma determination 
259   Bad non-uniformity A:          0 *Peak pixels flagged as bad 
260   Bad non-uniformity B:          0  Background pixels flagged as bad 
261  Partial at scan start:        513 *Reflns incomplete at start of the rotation 
262    Partial at scan end:        393 *Reflns incomplete at end of the rotation 
263      Rotation too wide:          0 *Reflns predicted to be on too many images 
264 ==================================== 
265               *Rejected from output. 
266  
267 dtintegrate: There were 1764 profiles written to file reflnprofiles.profit. 
268  
269 dtprofit:  Copyright (c) 1996 Molecular Structure Corporation 
270 dtprofit settings: 
271  
272 Minimum required contributors to a reference profile: 50 
273 Minimum reference profile value in peak area: 0 
274 Variance weighted profile analysis method B used. 
275 Maximum number of reference profiles: 72 
276 Number of reflection profiles read in: 1764 
277 Profile   Reflns  Sum(Pi**2/Vi)  Contributors 
278 ============================================= 
279    0       149       670      0 0/0 18/0 1/1 6/0 19/6 24/0 7/21 25/121  
280    1       149       670      1 1/1 19/6 7/21 2/0 6/0 0/0 25/121  
281 ... 
282   71       193       648      71 71/0 53/0 70/12 65/0 52/8 47/0 64/173  
283   72      1764       620      Overall profile 
284      File D0001.refprof successfully opened. 
285      Success writing file D0001.refprof! 
286      File D0019.refprof successfully opened. 
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287      Success writing file D0019.refprof! 
288      File D0037.refprof successfully opened. 
289      Success writing file D0037.refprof! 
290      File D0055.refprof successfully opened. 
291      Success writing file D0055.refprof! 
292  
293 Int/SigmaI vs Average correlation of 
294    observed to reference profiles 
295 ===================================== 
296 Sigma range     Avg.Corr.  Num.Refln. 
297 ------------------------------------- 
298  0 ...  3          0.169       31 
299  3 ...  6          0.636       52 
300  6 ...  9          0.845       65 
301  9 ... 12          0.926      142 
302 12 ... 15          0.954      286 
303 15 ... 18          0.970      279 
304 18 ... 21          0.978      245 
305 21 ... 24          0.983      219 
306 24 ... 27          0.988      149 
307 27 ... 30          0.993      296 
308 ------------------------------------- 
309  
310 Correlation range vs 
311  number of reflections 
312 ========================= 
313 Corr.range     Num.Refln. 
314 ------------------------ 
315 0.0 ... 0.1           7 
316 0.1 ... 0.2           8 
317 0.2 ... 0.3           6 
318 0.3 ... 0.4           7 
319 0.4 ... 0.5           9 
320 0.5 ... 0.6          14 
321 0.6 ... 0.7          13 
322 0.7 ... 0.8          25 
323 0.8 ... 0.9          71 
324 0.9 ... 1.0        1604 
325 ------------------------ 
326 Number of reflections written: 1764 
327 DTREK_STATUS: 0 
 
 
Lines 14-25  The command line options/settings are listed. 
Line 27 The 3D method is used, rather than the 2D method.  (The 2D method is not available 

at this time.) 
Line 28 The non-uniformity type (see section 4.5 and p. 17) is None. 
Line 30  The first image is read in. 
Lines 34-37 The name of the image, current date, and time are listed. 
Lines 40-44 The rotation start, end, increment, and exposure time are listed. 
Lines 46-50 The numbers of new, active, full, done normal and done special reflections are 

listed.  New reflections are those for which the 3D integration box is newly created.  
Active reflections includes all reflections which receive any pixel contributions from 
the current image.  Full reflections are those for which the 3D integration box has 
just filled.  DNormal reflections are those full reflections (from this image or a 
previous image, but within a batch) which have a normal preliminary integration.  
DSpecial reflections are those full reflections which have a special preliminary 
integration and which do not have an accurate centroid determination.  A special 
integration might occur if the reflection is not strong or a warning or error occurred 
during integration. 
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Lines 52-56 The total number of allocated 3D shoeboxes (a shoebox is the 3D data array of 
pixels for a single reflection) is listed, the number that are filling (i.e. in use), those 
that are full, and those that are freed (not in use), are listed.  Full shoeboxes are 
buffered until the end of a batch when refinement is done and profiles are written 
out. 

Line 58 A big portion of the output log file was edited away. 
Lines 59-85 The last image in the scan to integrate is read in and info about it is listed. 
Lines 86-87 The end-of-batch refinement is about to take place.  The refinement options are 

listed. 
Lines 88-191 The standard refinement output is listed.  For an explanation, see section 4.8. 
Lines 184-185 Notice that the residuals are very low since 3D centroids are used in refinement. 
Lines 194-218 Information about strong peaks is listed for 18 different areas of the detector.   
 The detector is divided into 6 by 3 areas (fast pixel direction by slow pixel 

direction).  The columns are: 
   Num  Number of strong reflections 
   Intensity Average intensity of strong reflections 
   Sigma  Average standard deviation of intensity 
   BackAvg Average background value 
   BackSig Average background standard deviation 
   Siz0  Average peak size at 1σ in pixels in the fast pixel direction 
  Siz1  Average peak size at 1σ level in pixels in the slow pixel  

   direction 
   Siz2  Average peak size at 1σ level in images in rotation direction 
   Dl  Average spot size as a function in reciprocal space 

                           Shft0  Average shift in pixels between observed and calculated  
    centroid in the fast pixel direction 

                           Shft1  Average shift in pixels between observed and calculated  
    centroid in the slow pixel direction 

                        Shft2  Average shift in images between observed and calculated 
    centroid in the rotation direction 

     The calculated centroid of non-strong reflections is shifted by 
     the above shifts. 

 
Line 219 The number of reflections processed in the batch is listed. 
Line 220 The end of images is reached and integration is done. 
Lines 225-265 A summary of the number of reflections integrated, along with their status, is listed.  

Reflections with bad errors and that are partial are not included in the output 
reflection files.  The status codes are self-explanatory.  A reflection that is partial at 
both the scan start and scan end is counted in both places, but counted only once at 
the top.  Reflections in categories that are asterisked (*) are rejected.  Reflections 
may fit in multiple categories. 

Line 267 The number of reflection profiles written to reflnprofiles.profit is listed.  These 
profiles will be read by dtprofit and processed.  
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Lines 269-270 The dtprofit module is started in order to fit profiles.  This performs three-
dimensional profile analysis with a method similar to that of Kabsch (1988). 

Line 272 At least 50 strong reflections must contribute to a reference profile.  If too few 
reflections are found in the same region, nearby regions are used until sufficient 
strong reflections contribute. 

Line 274 A variance weighted profile analysis method is used.  This is different from Kabsch 
(1988), but like Otwinowski & Minor (1997). 

Line 275 In this scan, there are up to 72 regions (18 per detector * 4 batches) for which 
reference profiles are calculated. 

Lines 277-282 For each regional reference profile the number of strong reflections that contribute 
and their original region (as m/n pairs) are listed.  If too few strong reflections are 
found, all strong reflections in the input are used. 

Line 283 A single overall reference profile is also calculated. 
Lines 284-291 The reference profiles are written to disk in the form of a d*TREK image file. 
 
 

Each image file shows 18 reference profiles.  Each reference profile is a three-dimensional cube of 9 by 
9 by 9 Kabsch-transformed pixels.  The pixels are NOT in image or data space, but rather in a 
transformed Kabsch space (read his 1988 paper J. Appl. Cryst. 21, 916-924).  Since images are displayed 
in 2D, each 9 by 9 by 9 cube is displayed as a series of 9 two-dimensional 9 by 9 planes (Figures 19-22).  

  
Reference profiles.  

 
Profile size too large.  Peak 
crowded into center, so decrease 
first Profile size value (make box 
smaller). 

 
Profile size too small.  Peak 
overfills box, so increase first 
Profile size value (make box 
bigger). 

 
Profile size just right.  Peak fills 
box, but there is background at 
edges and faces. 
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Stack them up in your mind to make them 3D.  Because of the Kabsch transformation, reference profiles 
should look very similar throughout reciprocal space.  The appearance of the reference profiles is 
affected by the Profile size  option.  The width of the profile in the plane of the display is determined by 
the first value to Profile size , while the number of squares the profile fits in is determined by the second 
value.  To make the profiles appear larger in the plane, decrease the first value.  To make them appear 
smaller, increase the first value.  To make them appear on more squares, decrease the second value.  To 
make them appear on fewer squares, increase the second value.  In reality, the profiles do not change 
physical size  you change the size of the box around them.  That is, by cropping the box closer to the 
profile, the profile will fill a larger portion of the box.  If you make the box larger, the profile will fill a 
smaller portion of the box.  In any event, do not make the second value less than 2 times the image 
rotation angle increment! 
 
Lines 293-308 The average correlation between observed profiles and the corresponding reference 

profile is listed for 10 Intensity/SigmaI ranges.  If the assumptions of profile -fitting 
are valid, then the correlations should be very high (>0.85) for strong reflections.  
You are reminded that the assumptions are: 1) Reflection centroids are accurately 
predicted; and 2) Reflections do have the same profiles, that is, the same shape and 
boundary and the same relative intensity distribution within the boundary. 

 

Laue Log  
 
1 dtcell:  Molecular Structure Corporation 
2 d*TREK version 6.2SSI -- Dec 11 2000 
3 Command line: 
4  dtcell input.head dtintegrate.ref -head output.head -tols 1e6 1e6 1e6 \ 
5     1e6 1e6 1e6 -anom -maxrmerge 0.150000 -spacegroup 16 -laueonly 
6 Header "input.head" opened. 
7      Header of file input.head successfully read. 
8 Lattice oP assumed for space group 16. 
9 Command line string: >>-head<< 
10 Output Header Name set to "output.head". 
11 Command line string: >>-tols<< 
12 Cell tolerances set to [ 1000000.00 1000000.00 1000000.00 1000000.00  
13 1000000.00 1000000.00] 
14 Command line string: >>-anom<< 
15 Laue check assumes I+ != I- 
16 Command line string: >>-maxrmerge<< 
17 Maximum R-merge is 0.150000 
18 Command line string: >>-spacegroup<< 
19 Space group set to: P222 (#16) 
20 Laue check disabled. 
21 Laue group set to: mmm 
22 Lattice set to oP 
23 Command line string: >>-laueonly<< 
 ////////////////////////////// 
24 Finished reading command line. 
25 Input Cell:        [   6.36  15.51  25.07  90.00  90.00  90.00 ] 
26 Input Sigmas:      [ 0.0003 0.0009 0.0013 0.0000 0.0000 0.0000 ] 
27 Input Orientation: [  97.41  -1.70 171.25 ] 
  
28 Reading Reflection file dtintegrate.ref ... 
29 Creflnlist::nRead with filename: dtintegrate.ref 
30 INFO in Creflnlist::nRead, EOF after 12641 reflections read in 
31                                     (12641 total now in list). 
32 Laue Check 
 ----------------------------------------------------- 
33    Laue  Unique     Num  Calc    Obs  R-Merge   Pass? 
34   class    axis  unique  mult   mult                  
 ----------------------------------------------------- 
35      -1       -    1314     1   2.01     0.02  [PASS] 
36     2/m       a    3786     2   2.25     0.02  [PASS] 
37     2/m       b    4037     2   2.29     0.02  [PASS] 
38     2/m       c    1996     2   2.13     0.02  [PASS] 
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39     mmm       -    4195     4   2.45     0.02  [PASS] 
40     4/m       a    3091     4   2.53     0.43  ------ 
41     4/m       b    2186     4   2.45     0.33  ------ 
42     4/m       c    3504     4   2.87     0.32  ------ 
43   4/mmm       a    3213     8   3.40     0.44  ------ 
44   4/mmm       b    2532     8   2.81     0.30  ------ 
45   4/mmm       c    2732     8   4.10     0.33  ------ 
46      -3       -    2782     3   2.58     0.59  ------ 
47    -3m1       -    2979     6   3.23     0.65  ------ 
48    -31m       -    3169     6   3.25     0.64  ------ 
49     6/m       -    2947     6   3.44     0.53  ------ 
50   6/mmm       -    2310    12   4.75     0.64  ------ 
51     m-3       -    3276    12   3.17     0.54  ------ 
52    m-3m       -    2557    24   4.39     0.69  ------ 
 ----------------------------------------------------- 
53     mmm selected with R-merge of ......  0.02 
54 No reindexing done. 
55 Reflection file not updated. 
56 Header "output.head" written. 
 

Centricity Log  
1 dtcell:  Molecular Structure Corporation 
2 d*TREK version 6.2SSI -- Dec 11 2000 
3 Command line: 
4  dtcell input.head dtintegrate.ref -head output.head -centricityonly 
5 Header "input.head" opened. 
6      Header of file input.head successfully read. 
7 Lattice oP assumed for space group 16. 
8 Command line string: >>-head<< 
9 Output Header Name set to "output.head". 
10 Command line string: >>-centricityonly<< 
 ////////////////////////////// 
11 Finished reading command line. 
12 Input Cell:        [   6.36  15.51  25.07  90.00  90.00  90.00 ] 
13 Input Sigmas:      [ 0.0003 0.0009 0.0013 0.0000 0.0000 0.0000 ] 
14 Input Orientation: [  97.41  -1.70 171.25 ] 
15 Reading Reflection file dtintegrate.ref ... 
16 Creflnlist::nRead with filename: dtintegrate.ref 
17 INFO in Creflnlist::nRead, EOF after 12641 reflections read in 
                                     (12641 total now in list). 
18 N(Z) test: fraction of intensities less than Z x <I> 
 ------------------------------------------------------------------------------- 
19 Z=           0.1    0.2    0.3    0.4    0.5    0.6    0.7    0.8    0.9    1.0 
20 centric     .248   .345   .419   .479   .520   .561   .597   .629   .657   .683 
21 acentric    .095   .181   .259   .330   .394   .451   .503   .551   .593   .632 
22 deviation  -.153  -.164  -.160  -.149  -.126  -.110  -.094  -.078  -.064  -.051 
23                              theoretical average deviation ==>   -.115 
  
24 measured   0.317  0.463  0.556  0.617  0.665  0.698  0.723  0.745  0.766  0.781 
25 deviation -0.069 -0.118 -0.137 -0.138 -0.145 -0.137 -0.126 -0.116 -0.109 -0.098 
26                                 measured average deviation ==>   -0.119 
 ------------------------------------------------------------------------------- 
27 Centric Distribution Selected. 
28 No reindexing done. 
29 Reflection file not updated. 
30 Header "output.head" written. 
31  
 

Spacegroup Log  
1 dtcell:  Molecular Structure Corporation 
2 d*TREK version 6.2SSI -- Dec 11 2000 
3 Command line: 
4  dtcell input.head dtintegrate.ref -head output.head -lauegroup mmm \ 
5     -acentric -rejects 20 -asigma 10.000000 
6 Header "input.head" opened. 
7      Header of file input.head successfully read. 
8 Lattice oP assumed for space group 16. 
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9 Command line string: >>-head<< 
10 Output Header Name set to "output.head". 
11 Command line string: >>-lauegroup<< 
12 Laue group set to: mmm 
13 Laue check disabled. 
14 Command line string: >>-acentric<< 
15 Space group is Acentric. 
16 Centricity check disabled. 
17 Command line string: >>-rejects<< 
18 Command line string: >>-asigma<< 
19 Absence I/Sigma(I) set to 10.000000 
20 ////////////////////////////// 
21 Finished reading command line. 
  
22 Input Cell:        [   6.36  15.51  25.07  90.00  90.00  90.00 ] 
23 Input Sigmas:      [ 0.0003 0.0009 0.0013 0.0000 0.0000 0.0000 ] 
24 Input Orientation: [  97.41  -1.70 171.25 ] 
  
25 Reading Reflection file dtintegrate.ref ... 
26 Creflnlist::nRead with filename: dtintegrate.ref 
27 INFO in Creflnlist::nRead, EOF after 12641 reflections read in 
28                                     (12641 total now in list). 
29 Checking systematic absences... 
30 Outputing 'dtcell_rejects.ref'... 
31 Number of reflections written: 3724 
32 BEGIN Texsan Output 
 ----------------------------------------------------------------------------- 
33  Odd/Even parity class                      
  --------------------------------           
34  Class  Total  Observed   <I/sig>           
  --------------------------------           
35    eee   1606     1364      160.9           
36    eeo   1593     1325      166.6           
37    eoe   1576     1295      169.2           
38    eoo   1571     1362      174.5           
39    oee   1572     1362      164.9           
40    oeo   1573     1380      155.4           
41    ooe   1572     1378      181.8           
42    ooo   1578     1404      183.3           
  ---------------------------------          
                                             
  --------------------------------   --------------------------------        
43    hk0  Total  Observed   <I/sig>     h0l  Total  Observed   <I/sig>        
  --------------------------------   --------------------------------        
44     ee     83       68      367.3     e e    102       79      258.4        
45     eo     74       44      222.4     e o    101       62      105.3        
46     oe     78       63      296.6     o e    103       85      276.9        
47     oo     77       53      250.1     o o    100       80      208.8        
  --------------------------------   --------------------------------        
                                                                             
  --------------------------------   --------------------------------        
48    0kl  Total  Observed   <I/sig>     hhl  Total  Observed   <I/sig>        
  --------------------------------   --------------------------------        
49     ee    374      287      185.4     e e     97       89      380.6        
50     eo    372      291      181.9     e o     98       73      357.0        
51     oe    354      266      217.1     o e     96       90      378.7        
52     oo    360      284      257.4     o o     94       88      434.2        
  --------------------------------   --------------------------------        
                                                                             
  --------------------------------                                           
53    h-hl Total  Observed   <I/sig>                                           
  --------------------------------                                           
54     ee    114       98      236.7                                           
55     eo    113       77      183.4                                           
56     oe    113      107      249.9                                           
57     oo    117      108      304.1                                           
  --------------------------------                                           
                                                                             
  --------------------------------   --------------------------------        
58    hhh  Total  Observed   <I/sig>     hh0  Total  Observed   <I/sig>        
  --------------------------------   --------------------------------        
59      e      5        5      708.6       e      5        3      496.1        
60      o      7        7      1008.4       o      5        5      919.9        
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  --------------------------------   --------------------------------        
                                                                             
  --------------------------------   --------------------------------        
61    h00  Total  Observed   <I/sig>     0k0  Total  Observed   <I/sig>        
  --------------------------------   --------------------------------        
62      e      4        4      914.1       e     19       19      744.1        
63      o      4        4       75.9       o     18        1       -0.5*       
64    o/e     --       --        0.1     o/e     --       --       -0.0        
  --------------------------------   --------------------------------        
                                                                             
  --------------------------------                                           
65    00l  Total  Observed   <I/sig>                                           
  --------------------------------                                           
66      e     18       15      383.6                                           
67      o     19        2        3.0*                                          
68    o/e     --       --        0.0                                           
  --------------------------------                                           
                                                                             
  ---------------------------------------------------------------            
69   Zone           a+b=4n                  a+b not equal 4n                   
70         Total  Observed    <I/sig>    Total  Observed    <I/sig>            
  ---------------------------------------------------------------            
71    0kl    366      287      214.7      1094     841       208.4             
72    h0l    101       79      230.6       305     227       206.9             
73    hk0     79       60      269.9       233     168       291.9             
                                                                             
                                                                             
  ---------------------------------------------------------------            
74   Zone            a=4n                    a not equal 4n                    
75         Total  Observed    <I/sig>    Total  Observed    <I/sig>            
  ---------------------------------------------------------------            
76    0k0     10       10      572.2        27      10       311.3             
77    00l      9        7      351.1        28      10       135.8             
78    h00      1        1       75.4         7       7       555.0             
  ---------------------------------------------------------------            
                                                                             
  ---------------------------------------------------------------            
79   Zone           2h+l=4n                2h+l not equal 4n                   
80         Total  Observed    <I/sig>    Total  Observed    <I/sig>            
  ---------------------------------------------------------------            
81    hhl     96       87      288.7       289     253       419.9             
  ---------------------------------------------------------------            
                                                                             
  -------------------------------------------------------------------------- 
82            h+l=3n;l odd             h+l=3n             h+l not equal 3n     
83         Total Obsvd <I/sig>    Total Obsvd <I/sig>    Total Obsvd <I/sig>   
  -------------------------------------------------------------------------- 
  h-h0l     76    60  240.0       154   131  239.8       303   259  246.1     
  --------------------------------------------------------------------------  
84           -h+l=3n;l even                 -h+l=3n           -h+l not equal 3n 
  --------------------------------------------------------------------------  
85  h-h0l     77    60  231.2       149   125  238.2       308   265  246.8     
  --------------------------------------------------------------------------  
                                                                             
                                                                             
  ---------------------------------------------------------------            
86                   l=3n                    l not equal 3n                    
87         Total  Observed    <I/sig>    Total  Observed    <I/sig>            
  ---------------------------------------------------------------            
88  000l      13        6      212.5        24      11       175.0             
  ---------------------------------------------------------------            
89                   l=6n                    l not equal 6n                    
  ---------------------------------------------------------------            
90  000l       6        5      457.0        31      12       136.2             
  ---------------------------------------------------------------            
  
 ----------------------------------------------------------------------------- 
91 END Texsan Output 
  
  
  
92 ALL Systematic Absences 
 ---------------------------------------------------------------------------- 
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93  Refln. Type       hkl      0kl      h0l      hk0      h00      0k0      00l  
 ---------------------------------------------------------------------------- 
94  Total Reflns    12641     1460      406      312        8       37       37  
  
95         h!=2n     6295   ------      203      155        4   ------   ------  
96                   5524   ------      165      116        4   ------   ------  
97                171.35    ------  243.36   273.47    75.91    ------   ------  
  
98          h=2n     6346   ------      203      157        4   ------   ------  
99                   5346   ------      141      112        4   ------   ------  
100                 167.79   ------   182.22   299.00   914.12   ------   ------  
  
101         k!=2n     6297      714   ------      151   ------       18   ------  
102                   5439      550   ------       97   ------        1   ------  
103                177.22   237.42    ------  236.50    ------   -0.55*   ------  
  
104          k=2n     6344      746   ------      161   ------       19   ------  
105                   5431      578   ------      131   ------       19   ------  
106                 161.95   183.65   ------   333.05   ------   744.09   ------  
  
107         l!=2n     6315      732      201   ------   ------   ------       19  
108                   5471      575      142   ------   ------   ------        2  
109                169.97   219.01   156.79    ------   ------   ------    3.01*  
  
110          l=2n     6326      728      205   ------   ------   ------       18  
11                   5399      553      164   ------   ------   ------       15  
                 169.15   200.83   267.70   ------   ------   ------   383.64  
  
112       k+l!=2n     6314      726   ------   ------   ------   ------   ------  
113                   5378      557   ------   ------   ------   ------   ------  
114                168.25   199.05    ------   ------   ------   ------   ------  
  
115        k+l=2n     6327      734   ------   ------   ------   ------   ------  
116                   5492      571   ------   ------   ------   ------   ------  
117                 170.87   220.72   ------   ------   ------   ------   ------  
  
118       h+l!=2n     6308   ------      204   ------   ------   ------   ------  
119                   5427   ------      147   ------   ------   ------   ------  
120                171.94    ------  191.95    ------   ------   ------   ------  
  
121        h+l=2n     6333   ------      202   ------   ------   ------   ------  
122                   5443   ------      159   ------   ------   ------   ------  
123                 167.19   ------   233.84   ------   ------   ------   ------  
  
124       h+k!=2n     6292   ------   ------      152   ------   ------   ------  
125                   5399   ------   ------      107   ------   ------   ------  
126                166.00    ------   ------  260.44    ------   ------   ------  
  
127        h+k=2n     6349   ------   ------      160   ------   ------   ------  
128                   5471   ------   ------      121   ------   ------   ------  
129                 173.09   ------   ------   310.90   ------   ------   ------  
  
130         h!=4n     9572   ------      310      229        7   ------   ------  
131                   8376   ------      244      172        7   ------   ------  
132                175.36    ------  239.44   293.55   554.96    ------   ------  
  
133          h=4n     3069   ------       96       83        1   ------   ------  
134                   2494   ------       62       56        1   ------   ------  
135                 151.46   ------   126.74   266.36    75.42   ------   ------  
  
136         k!=4n     9469     1097   ------      231   ------       27   ------  
137                   8188      842   ------      167   ------       10   ------  
138                176.10   220.86    ------  285.36    ------  311.34    ------  
  
139          k=4n     3172      363   ------       81   ------       10   ------  
140                   2682      286   ------       61   ------       10   ------  
                 150.05   176.98   ------   289.04   ------   572.17   ------  
  
141         l!=4n     9468     1096      302   ------   ------   ------       28  
142                   8175      857      223   ------   ------   ------       10  
143                168.43   213.57   210.68    ------   ------   ------  135.82   
  
144          l=4n     3173      364      104   ------   ------   ------        9  
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145                   2695      271       83   ------   ------   ------        7  
146                 172.94   199.04   218.93   ------   ------   ------   351.10  
  
147       k+l!=4n     9481     1094   ------   ------   ------   ------   ------  
148                   8124      841   ------   ------   ------   ------   ------  
149                170.07   208.38    ------   ------   ------   ------   ------  
  
150        k+l=4n     3160      366   ------   ------   ------   ------   ------  
151                   2746      287   ------   ------   ------   ------   ------  
152                 168.02   214.65   ------   ------   ------   ------   ------  
  
153       h+l!=4n     9474   ------      305   ------   ------   ------   ------  
154                   8151   ------      227   ------   ------   ------   ------  
155                170.61    ------  206.89    ------   ------   ------   ------  
  
156        h+l=4n     3167   ------      101   ------   ------   ------   ------  
157                   2719   ------       79   ------   ------   ------   ------  
158                 166.43   ------   230.61   ------   ------   ------   ------  
  
159       h+k!=4n     9476   ------   ------      233   ------   ------   ------  
160                   8137   ------   ------      168   ------   ------   ------  
161                166.99    ------   ------  291.90    ------   ------   ------  
  
162        h+k=4n     3165   ------   ------       79   ------   ------   ------  
163                   2733   ------   ------       60   ------   ------   ------  
164                 177.26   ------   ------   269.86   ------   ------   ------  
 ---------------------------------------------------------------------------- 
165 Sending tcl command 
  
166 Systematic Absences <I/sig(I)> <= 10.00 
 ---------------------------------------------------------------------------- 
167  Refln. Type       hkl      0kl      h0l      hk0      h00      0k0      00l  
 ---------------------------------------------------------------------------- 
168  Total Reflns    12641     1460      406      312        8       37       37  
  
169     Condition     ----     ----     ----     ----     ----    k!=2n    l!=2n  
170 Num Reflns.       ----     ----     ----     ----     ----       18       19  
171 Num Observed      ----     ----     ----     ----     ----        1        2  
172    <I/sig(I)>     ----     ----     ----     ----     ----    -0.55     3.01  
 ---------------------------------------------------------------------------- 
173 Sending tcl command 
174 Spacegroups found. 
 --------------------------------------------------- 
175  Number     Name Presentation Centricity Likelihood 
 --------------------------------------------------- 
176      18   P21212       P22121   Acentric     1.00  
 --------------------------------------------------- 
  
177 Space groups whose 'Presentation' field differs 
178 from the 'Name' field were found in a  
179 non-standard presentation. 
180 Re-indexing will be required to convert to a 
181 standard presentation. 
  
182 Options: 
183 T)      Print Texsan Output 
184 S)      Print Selected Spacegroups 
185 A)      Print Table of absences used to selected spacegroups 
186 B)      Print Table of all absences applicable to laue group 
187 Q)      Quit 
188 #)      Type spacegroup number. 
189 Enter)  Select spacegroup 18 
  
190 Choice: Q 
191 Terminating. 
192 No reindexing done. 
193 Reflection file not updated. 
194 Header "output.head" written. 
  
 

Scale and Average Log  
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1 dtscalemerge: Copyright (c) 1996 Molecular Structure Corporation 
2  Header of file lyso.head successfully read. 
3  Creflnlist::nRead called. 
4  Names of reflection fields: 
5  nH (int) 
6  nK (int) 
7  nL (int) 
8  nPartial (int) 
9  nBatchIndex (int) 
10 nPackedHKL (int) 
11 nReducedH (int) 
12 nReducedK (int) 
13 nReducedL (int) 
14 nAnomFlag (int) 
15 nCentPhase (int) 
16 fIntensity (float) 
17 fSigmaI (float) 
18 fObs_pixel0 (float) 
19 fObs_pixel1 (float) 
20 fObs_rot_mid (float) 
21 f2STLsq (float) 
22 fResolution (float) 
23 sBatch (Cstring) 
24 INFO in Creflnlist::nRead, EOF after 31914 reflections read in (31914 total now  
25    in list). 

 
Lines 1-25 The input reflection list is read in and the fieldnames in the reflection list are listed.  Note 

that for efficiency, the fields normally added by  dtscalemerge are present in the 
reflection list.  If not present, they would be added, but this would take additional time. 

 
 
27 Cscalemerge listing: 
28 Batch  fixed:      L002 
29 Scale  fixed:      1 
30 Bvalue fixed:      0 
31 Rej criteria:      3 
32 Mul sig fact:      1.3 
33 Add sig fact:      0.02 
34   Max cycles:      10 
35    FixB Flag:      0 
36    Anom Flag:      0 

 
Lines 27-36 The option settings used by this run of dtscalemerge are listed.  These confirm what is 

set on the command line or in the Scale  menu. 
 
 
37 Crystal listing: 
 
38 Unit cell lengths: 79.2, 79.2, 38.9 
39 Unit cell  angles: 90, 90, 90 
40 Unit cell  volume: 244006 
 
41 Spacegroup number: 96 
42 name: P43212 
43 Num. equiv. posns: 8 

 
Lines 37-43 Information about the crystal unit cell dimensions and spacegroup is listed next.  This 

comes from the input_header_file which in this example is  lyso.head. 
 
 
44 There are 20 different batches in the input reflection list. 
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Line 44 20 different batch names were found in the input reflection list. 
 
 
45 Observed position limits of the Batches 
46 -------------------------------------------------------------------------------- 
47 Batch    Num            fObs_pixel0           fObs_pixel1          fObs_rot_mid 
48  name   refs         Min        Max        Min        Max        Min        Max 
49 -------------------------------------------------------------------------------- 
50  L001   1603       -96.0       95.2      -91.6       85.8      -28.8      -28.8 
51  L002   1625       -95.2       95.0      -88.9       90.0      -26.3      -26.3 

... 
68  L019   1564       -96.0       94.9      -94.8       93.9       16.3       16.3 
69  L020   1590       -95.7       94.8      -91.4       93.1       18.8       18.8 
70 -------------------------------------------------------------------------------- 

 
Lines 45-70 A table lists for each batch the minimum and maximum value of the observed reflection 

positions found in the input reflection list file.  In this example, the fObs_pixel0 and 
fObs_pixel1 fields are in millimeters and not pixels.  This table is a quick check that 
the input reflection list contains the expected range of values. 

 
 
71 Intensity and Resolution limits of the Batches 
72 -------------------------------------------------------------------------------- 
73 Batch    Num             Intensity            Resolution         [2sinT/lam]^2  
74  name   refs         Min        Max        Min        Max        Min        Max 
75 -------------------------------------------------------------------------------- 
76  L001   1603       -26.7    11964.6      39.60       1.94     0.0006     0.2646 
77  L002   1625       -16.5    13621.4      79.20       1.95     0.0002     0.2642 
... 
94  L019   1564       -26.6    14997.3      27.75       1.94     0.0013     0.2653 
95  L020   1590       -33.7    12513.4      27.75       1.94     0.0013     0.2647 
96 -------------------------------------------------------------------------------- 

 
Lines 71-96 The minimum and maximum intensity, resolution and |d*|2 ≡ (2sinθ/λ)2 for each batch is 

listed in this table.  Check that the minimum intensity of each batch is not outrageously 
less than zero; this would indicate problems with integration.  Confirm that the resolution 
limits are what is expected. 

 
 
97 Sorting and reducing reflnlist to asymmetric unit ... 
98 ... done sorting 

 
Lines 97-98 The reflection list was reduced to the asymmetric unit and sorted.  The input list need not 

be sorted as this step will ensure that symmetry-related reflections are adjacent in the file. 
 
 
99  Selection string: -fIntensity/fSigmaI<3.000 
100 Number of reflns which match above selection: 5294 

 
Lines 99-100 This confirms that you excluded reflections with I/σ  < 3 from contributing to the 

refinement of the scale factors.  5294 of the input reflections were thus excluded.  These 
reflections are included, however, in the final statistics. 

 
 
101 Last cycle: no shifts. 
102 For cycle number 10 
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Lines 101-102 The last cycle was reached, so no shifts were applied.  Dtscalemerge calculates and 

prints out statistics on the results. 
 
 
103 Method 1     Expected Rmerge:      0.033 
104 Method 2     Expected Rmerge:      0.034 
105              Actual   Rmerge:      0.032 

 
Lines 103-105 Two methods for approximating the Rmerge are given, followed by the actual Rmerge 

(see the equation below) in the data set.  The actual Rmerge should be close to the 
expected Rmerges or something is wrong with the error model.  The expected Rmerges are 
calculated as follows: 

 

Method 1: Rmerge Ih= 1 , where Ih  is the average intensity for all averaged 
reflections. 

 

Method 2: Rmerge
I

N
N

h

h

h

i

=
σ

, where σ h  is the average standard deviation for 

averaged reflections, Nh is the number of unique reflections, and Ni is the 
number of overlaps. 

 
 

Actual:  Rmerge
I I

I

hi h
ih

h
ih

=
−∑∑

∑∑

| |
 

 
106 Multiplicity of observed reflections 
107 -------------------------------------------------------------------------------- 
108 Mult |        1       2       3       4       5       6       7       8      >8 
109 -------------------------------------------------------------------------------- 
110 Refs |      897    2720    3418    2628    2060    1492     500     142      20 
111 -------------------------------------------------------------------------------- 
112 *Reflections with a multiplicity of 1 are not used in 
113 scale factor refinement nor in Rmerge calculations. 

 
Lines 106-113 The multiplicity of observed reflections is listed in a table.  The entire process of 

refining scale factors requires multiple observations for reflections.  That is, reflections 
that are symmetry-related need to appear in multiple batches.  Reflections with a 
multiplicity of 1 are neither used in scale factor refinement nor in the Rmerge calculations.  
A high redundancy will improve the I/σ in the merged and averaged results (see e.g. the 
dtscalemerge documentation Eqn. 10). 

  
 
114 Overlaps among scaling batches 
115 ---------------------------------------------------------------------------- 
116 Batch |   L001  L002  L003  L004  L005  L006  L007  L008  L009  L010 
117 ---------------------------------------------------------------------------- 
118  L001 |    298   745   671   259   196   168   199   174   182   263 | L001 
119  L002 |    787   659   286   243   193   162   204   166   161   280 | L002 
120  L003 |    656   226   240   246   217   173   162   162   191   259 | L003 
...  
163  L020 |    137   172   151   166   178   166   198   169   191   134 | L020 
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164 ---------------------------------------------------------------------------- 
165 Batch |   L011  L012  L013  L014  L015  L016  L017  L018  L019  L020 
166 ---------------------------------------------------------------------------- 

 
Lines 114-166 Overlaps among the scaling batches are listed next (but only if the dtscalemerge 

command line option -countoverlap was used).  The entire refinement of scale 
factors depends on overlaps among the different batches.  If a batch has no overlaps with 
the other batches, then there is no information present in the reflection list which can be 
used to refine the scale factor of that batch.  In this case, the procedure used in the non-
linear least squares algorithm will simply keep the scale factor for that batch unchanged.  
Note that this table is normally NOT symmetric.  For example, there are 745 reflections in 
batch L001 that have at least 1 symmetry-related reflection in batch L002.  But there are 
787 reflections in batch L002 that have symmetry mates in L001.  There are 298 
reflections in L001 which overlap with a symmetry-related reflection in the same batch 
(each reflection is counted once).  To make this excrutiatingly clear, here is another 
example:  suppose batch X001 has 10 copies of a reflection with hkl = (10 1 2) and batch 
X002 has just 1 copy.  The table will then appear: 

--------------------- 
Batch |   X001  X002  
--------------------- 
 X001 |     10    10  
 X002 |      1     0 
 

 If a batch has few overlaps, you might use dtreflnmerge or an editor to combine that 
batch with another batch that you think will have the same scale factors (i.e. a batch that is 
adjacent in rotation angle or time scan; see section 4.13). 

 
 
167 Reflections in input file 
168 -------------------------------------------------------------------------------- 
169       Batch       Num       Num       Num       Num       Num 
170        name      refs  excluded      rejs     ovlps   singles 
171 -------------------------------------------------------------------------------- 
172        L001      1603       206        53      1327        17 
173        L002      1625       227        40      1341        17 
174        L003      1609       238        34      1310        27 
175        L004      1574       238        25      1280        31 
... 
191        L020      1590       268        28      1152       142 
192 -------------------------------------------------------------------------------- 
193 All batches     31914      5294       585     25138       897 

 
Lines 167-193 Information about reflections in the batches is listed in a table. 

Num refs Total number of reflections in this batch 
Num excludedNumber of reflections excluded because of the  I/σ cutoff. 
Num rejs Number of rejected reflections.  There should be very few, if any 

rejected reflections.  Any batch with a large number of rejected 
reflections should be investigated.  Perhaps it is indexed differently 
from the other batches. 

Num ovlps Number of reflections in this batch which overlap another reflection 
either in this batch or another batch. 

Num singles Number of reflections with no overlaps in the entire dataset.  To have 
many of these is undesirable . One observation for a data point, as 
opposed to numerous, is not recommended. 

 
 

194 Refined scale factors 
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195 -------------------------------------------------------------------------------- 
196 Batch       Num     Scale 
197  name     ovlps       K     *Shifts       B     *Shifts 
198 -------------------------------------------------------------------------------- 
199  L001      1327    1.0138    0.0000    0.0389    0.0000 
200  L002      1341    1.0000    0.0000    0.0000    0.0000 
201  L003      1310    0.9911    0.0000   -0.0036    0.0000 
... 
216  L018      1203    1.0519    0.0000   -0.3011    0.0000 
217  L019      1149    1.0593    0.0000   -0.3365    0.0000 
218  L020      1152    1.0748    0.0000   -0.3388    0.0000 
219 -------------------------------------------------------------------------------- 
220 *Shifts are for previous cycle only! 

 
Lines 194-220 This table lists the refined scale factors for the batches and the number of reflections that 

contributed to the refinement.  Examine this to assure that the scale factors “make sense.”  
In this example, an unfrozen lysozyme crystal was used. Some radiation damage is 
expected, but not much.  That is, the later batches will need to be  “scaled up” and to have 
larger scale factors.  Indeed, this is the case.  Remember that: 

  I I I k ecorr hi hj j
Bj= = × −2 2 2sin /θ λ   

 
 Also, since the batches are from the same crystal and same experiment, expect the scale 

factors to vary relatively smoothly.  Indeed, this is the case.  However, if the crystal had 
been a plate, or larger than the beam, expect larger variations due to more drastic volume 
changes.  Finally, double check that refinement has converged.  The shifts should be 0 on 
the last cycle. 

 
 
221 In the tables below Rmerge is defined as: 
222 Rmerge = Sum Sum |Ihi - <Ih>| / Sum Sum <Ih> 
223           h   i                  h   i 
224 where Ihi is the ith used observation for unique hkl h, 
225 and  <Ih> is the mean intensity for unique hkl h. 

 
Lines 221-225 A reminder of the equation for Rmerge. 
 
 
226 Rmerge vs Batch 
227 -------------------------------------------------------------------------------- 
228        Batch Average     Num   Num     Num     Num   <I/   ChiSq Rmerge Rmerge 
229         name  counts     obs  rejs   ovlps  single   sig>         batch  cumul 
230 -------------------------------------------------------------------------------- 
231         L001     865    1397    53    1327      17   12.4  0.387  0.036  0.036 
232         L002     997    1398    40    1341      17   15.0  0.425  0.033  0.035 
233         L003     865    1371    34    1310      27   11.7  0.314  0.035  0.035 
234         L004     950    1336    25    1280      31   11.8  0.282  0.029  0.033 
235         L005     887    1349    31    1286      32   11.7  0.292  0.032  0.033 
236         L006    1024    1368    27    1310      31   12.7  0.309  0.032  0.033 
237         L007     955    1382    27    1331      24   14.5  0.352  0.035  0.033 
238         L008     921    1264    20    1216      28   13.3  0.293  0.031  0.033 
239         L009     955    1310    25    1257      28   11.6  0.258  0.032  0.033 
240         L010     989    1373    23    1319      31   12.4  0.256  0.027  0.032 
241         L011     877    1229    26    1186      17   11.3  0.275  0.034  0.032 
242         L012     951    1389    24    1338      27   11.9  0.258  0.030  0.032 
243         L013     931    1245    21    1189      35   11.4  0.254  0.028  0.032 
244         L014     933    1384    23    1308      53   11.9  0.245  0.030  0.032 
245         L015    1069    1281    24    1210      47   11.3  0.279  0.032  0.032 
246         L016     968    1248    31    1162      55   11.6  0.255  0.033  0.032 
247         L017     912    1362    36    1264      62   11.1  0.246  0.032  0.032 
248         L018     929    1314    36    1203      75   11.3  0.260  0.032  0.032 
249         L019     977    1298    31    1149     118   11.0  0.283  0.032  0.032 
250         L020     859    1322    28    1152     142   11.2  0.271  0.033  0.032 
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251 -------------------------------------------------------------------------------- 
252  All batches     941   26620   585   25138     897   12.0   0.29  0.032  0.032 

 
Lines 226-252 

 This table lists Rmerge vs Batch.  It is easy to recognize any batch not matching well with 
the other batches. 

 
Average counts The average counts of reflections in the batch.  This includes 

reflections that overlap and those that do not.  If you assume 
Poissonian counting statistics, then the expected Rmerge for this 
batch would be 1 I .  So for batch L001, 1 865 0 034= .  is 
consistent with 0.036 found. 

Num refs Total number of reflections in this batch. 
Num rejs Number of rejected reflections.  There should be very few, if any 

rejected reflections.  Any batch with a large number of rejected 
reflections should be investigated.  Perhaps the batch is indexed 
differently from the other batches. 

Num ovlps Number of overlapping reflections in this batch that have 
symmetry-related mates and that contributed to the Rmerge. 

Num singles Number of reflections with no overlaps in the entire dataset.  One 
observation for a data point, as opposed to numerous, is not 
recommended. 

<I/sig> The average Intensity/SigmaI for reflections in the batch.  This is 
for the corrected but unmerged reflections.  A higher <I/sig> was 
expected for the averaged reflections shown in subsequent tables. 

ChiSq  This is the pseudo-normalized χ2 for each batch. 

  ( )χ 2 21
= −∑∑N

w I I
hi

hi hi h
i

N

h

N hih

   

Rmerge batch This is the Rmerge of the reflections which belong to this batch 
where Ih  is calculated from reflections from all batches. 

Rmerge cumul This is the Rmerge of the reflections which belong to this batch and 
all previous batches in the table where Ih  is calculated from 
reflections from all batches. 

 
 

253 Rmerge vs Intensity/SigmaI 
254 -------------------------------------------------------------------------------- 
255 Int/sigmaI   Average     Num   Num     Num     Num   <I/   ChiSq Rmerge Rmerge 
256    range      counts     obs  rejs   ovlps   mults   sig>   norm  shell  cumul 
257 -------------------------------------------------------------------------------- 
258   18 -   >20    1470   15510   326   15086    3407   30.9  1.225  0.029  0.029 
259   16 -    18     271    1567    49    1497     384   16.0  1.133  0.057  0.029 
260   14 -    16     206    1658    39    1584     421   14.0  1.032  0.065  0.030 
261   12 -    14     160    1713    49    1614     447   12.0  0.939  0.073  0.030 
262   10 -    12     120    1936    46    1857     536   10.0  0.852  0.088  0.031 
263    8 -    10      94    1648    26    1583     512    8.0  0.601  0.092  0.031 
264    6 -     8      70    1501    39    1370     520    6.0  0.416  0.114  0.032 
265    4 -     6      49     813    11     547     263    3.9  0.188  0.117  0.032 
266    2 -     4     ---     274     0       0       0    ---    ---    ---  0.032 
267  < 0 -     2     ---       0     0       0       0    ---    ---    ---  0.032 
268 -------------------------------------------------------------------------------- 
269  < 0 -   >20     941   26620   585   25138    6490   19.5   1.00  0.032  0.032 

 
Lines 253-269  This table lists Rmerge vs Intensity/SigmaI.   
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Average counts   The average counts of reflections in the shell.  This includes 

reflections that overlap and those that do not.  If you assume 
Poissonian counting statistics, then the expected Rmerge for this 
shell would be 1 I .  So, for the shell of highest I/σ, 

1 1470 0 026= .  is consistent with 0.029 found.  In the 4-6 shell, 

1 49 0142= .  is consistent with 0.117 found. 
Num obs Number of reflections in this shell. 
Num rejs Number of rejected reflections.  There should be very few,  if any 

rejected reflections.  Any shell with a large number of rejected 
reflections should be investigated.  Perhaps there are a number of 
saturated reflections or unaccounted shadows on the detector. 

Num ovlps Number of reflections in this shell having symmetry-related mates 
and that contributed to the Rmerge. 

Num mults Number of unique reflections measured multiple times in the shell.  
The average multiplicity or redundancy for the shell is Num ovlps / 
Num mults. 

<I/sig> The average Intensity/SigmaI for averaged reflections in the shell.  
As expected, there is a larger <I/sig> for the averaged reflections 
than shown for unaveraged reflections in the Rmerge vs. Batch 
table. 

ChiSq norm This is the normalized χ2 popularized by Dr. Zbyszek Otwinowski 
calculated as 

     ( )χ 2 21
=

−
−∑∑( )N N

w I I
hi h

hi hi h
i

N

h

N h ih

   

 where Nh is the number of unique reflections and Nhi is the number 
of contributors to or multiplicity of averaged reflection Ih .  Values 
close to 1 suggest that the error model (whi) is valid. 

Rmerge shell This is the Rmerge for reflections which belong to this shell. 
Rmerge cumul This is the cumulative Rmerge for reflections which belong to this 

shell and all previous shells.  It shows what the Rmerge would be if 
the data is cut off at different  I/σ levels. 

 
 Remark: Use the table to determine at what resolution the crystal stopped diffracting. 
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270 Rmerge vs Resolution 
271 -------------------------------------------------------------------------------- 
272 Resolution   Average     Num   Num     Num     Num   <I/   ChiSq Rmerge Rmerge 
273    range      counts     obs  rejs   ovlps   mults   sig>   norm  shell  cumul 
274 -------------------------------------------------------------------------------- 
275 79.2 -  6.12    2260     278    31     228      64   21.2  0.797  0.042  0.042 
276 6.12 -  4.34    2346    1564    44    1468     351   28.2  0.945  0.029  0.031 
277 4.34 -  3.54    3147    2196    37    2095     492   33.7  0.934  0.024  0.027 
278 3.54 -  3.07    2102    2586    39    2482     603   32.0  1.014  0.026  0.026 
279 3.07 -  2.74    1055    2963    55    2836     705   27.5  1.086  0.030  0.027 
280 2.74 -  2.51     597    3137    69    2982     747   22.7  1.125  0.036  0.028 
281 2.51 -  2.32     382    3321    74    3170     834   17.6  0.999  0.045  0.029 
282 2.32 -  2.17     278    3378    76    3199     832   14.0  1.028  0.057  0.030 
283 2.17 -  2.05     192    3204    72    3002     813   11.0  0.999  0.071  0.031 
284 2.05 -  1.94     118    3993    88    3676    1049    8.4  0.890  0.090  0.032 
285 -------------------------------------------------------------------------------- 
286 79.2 -  1.94     941   26620   585   25138    6490   19.5   1.00  0.032  0.032 

 
Lines 270-286 This table lists  Rmerge vs Resolution 
 
 Resolution rangeThe resolution range of the shell in Ångstroms. 

Average counts The average counts of reflections in the shell.  This includes 
reflections that overlap and those that do not.  If you assume 
Poissonian counting statistics, then the expected Rmerge for this 
shell would be 1 I .  So for the shell of highest I/σ, 

1 2260 0 021= .  which is inconsistent with 0.042 found.  It 
was then discovered that low resolution reflections which were 
obscured by the asymmetric beamstop were not rejected, hence 
the higher Rmerge for this shell. In the 2.05-1.94 shell, 
1 118 0 092= .  is consistent with 0.090 found. 

Num obs  Number of reflections in this shell. 
Num rejs Number of rejected reflections.  There should be very few,  if 

any rejected reflections.  Any shell with a large number of 
rejected reflections should be investigated.  Perhaps the shell 
contains extraneous diffraction from ice. 

Num ovlps Number of reflections in this shell having symmetry-related 
mates and that contributed to the Rmerge. 

Num mults Number of unique reflections measured multiple times in the 
shell.  The average multiplicity or redundancy for the shell is 
Num ovlps / Num mults. 

<I/sig> The average Intensity/SigmaI for averaged reflections in the 
shell.  As expected, there is a larger <I/sig> for the averaged 
reflections than shown for unaveraged reflections in the Rmerge 
vs Batch table. 

ChiSq norm This is the normalized χ2 popularized by Dr. Zbyszek 
Otwinowski.    Values close to 1 suggest that the error model is 
valid. 

Rmerge shell  This is the Rmerge for reflections which belong to this shell. 
Rmerge cumul This is the cumulative Rmerge for reflections which belong to 

this shell and all previous shells.  It shows what the Rmerge 
would be if the data were cut off at different resolution levels. 
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287 Completeness vs Resolution 
288 -------------------------------------------------------------------------------- 
289 Resolution      Calc     Num   Num     Num     Num    Num    Avg  %Comp  %Comp 
290    range      unique     obs  rejs   mults  single unique   mult  shell  cumul 
291 -------------------------------------------------------------------------------- 
292 79.2 -  6.12     363     278    31      64      19     83   2.98   22.9   22.9 
293 6.12 -  4.34     593    1564    44     351      52    403   3.77   68.0   50.8 
294 4.34 -  3.54     736    2196    37     492      64    556   3.88   75.5   61.6 
295 3.54 -  3.07     863    2586    39     603      65    668   3.81   77.4   66.9 
296 3.07 -  2.74     966    2963    55     705      72    777   3.74   80.4   70.6 
297 2.74 -  2.51    1061    3137    69     747      86    833   3.68   78.5   72.5 
298 2.51 -  2.32    1131    3321    74     834      77    911   3.56   80.5   74.1 
299 2.32 -  2.17    1226    3378    76     832     103    935   3.53   76.3   74.4 
300 2.17 -  2.05    1290    3204    72     813     130    943   3.32   73.1   74.2 
301 2.05 -  1.94    1362    3993    88    1049     229   1278   3.06   93.8   77.0 
302 -------------------------------------------------------------------------------- 
303 79.2 -  1.94    9591   26620   585    6490     897   7387   3.52   77.0   77.0 

 
Lines 287-303 This table lists Completeness vs Resolution.  In order to perform subsequent 

crystallographic analyses, you would like to have very complete data. 
 

Resolution rangeThe resolution range of the shell in Ångstroms. 
Calc unique Number of calculated unique reflections in this shell.  This is 

calculated from the unit cell dimensions and the space group in 
an exact manner (it is not an approximation). 

Num obs Number of observations for reflections in this shell.  The more 
the better. 

Num rejs Number of rejected reflections.  There should be very few,  if 
any rejected reflections.  Any shell with a large number of 
rejected reflections should be investigated.  Perhaps the shell 
contains extraneous diffraction from ice or low resolution 
reflections are behind the beamstop.  (Notice that more than 
10% of the observations in the lowest shell are rejected.  That’s 
bad!) 

Num mults Number of unique reflections resulting from the overlaps in the 
shell.  In other words, the number of unique reflections 
measured more than once. 

Num single  Number of unique reflections measured just once. 
Num unique Number of unique reflections measured (Num mults + Num 

single). 
Avg mult The average multiplicity or redundancy in the reflections in the 

shell.  Simply (Num obs - Num rejs) / Num 
unique. 

%Comp shell This is the percent completeness for reflections which belong to 
this resolution shell: 100 x Num unique / Calc 
unique. 

%Comp cumul This is the cumulative percent completeness for reflections 
which belong to this shell and all previous shells.  It shows what 
the completeness would be if the data were cut off at different 
resolution levels. 
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Direct Beam Log 
 
A summary of the typical log file DirectBeam.log generated by the direct beam shot utility is shown 
below. 
 
1  Direct Beam Utility  Copyright (c) 1998 Molecular Structure 

Corporation 
2  Number of cycles: 5 
3  Exposure time: 1 seconds 
4  Date: Thu Mar 30 16:41:19 2000 
 
5  .....................      
6  .....................      
7  .....................      
8  .......111111........      
9  ......111111111......      
10  .....11122222111.....      
11  ....112233333211.....      
12  ...11123456543211....      
13  ..11223579A9753211...      
14  ..112357ADFFB85311...      
15  .112357AFJNMHB6321...     Direct beam for IP 1, cycle 1 
16  .112469DJQUTNE8421...     Position (x,y) = (1499.84, 1509.80) 
17  .11247AFMUZXQG95211..     Pixel Intensity = 10841 
18  .11247BGOV+YQG9521...     Integrated Intensity, sigma(I) = 330647, 

895 
19  .11246AGMTXVNF8421...     I/sigma(I) = 369.5 
20  ..12358DIORQKC7321...     3sigma width (x,y) = (12, 13) 
21  ..112469DHJJE95311...     Full width at half maximum (x,y) = (5.57, 

6.86) 
22  ...123469BDDA7421....      
23  ...11234578875321....      
24  ....1122345553211....      
25  ....111223333211.....      
26  .....11111222111.....      
27  .......11111111......      
28  .........11111.......      
29  .....................      
30  .....................      
31  .....................      
 
32  … 
 
33  Average direct beam results for IP 1 
34  Position (x,y) = (1499.64, 1509.61) +/- (0.262854, 0.14148) 
35  Pixel Intensity = 10533 +/- 445.806 
36  Integrated Intensity, sigma(I) = 336594, 893.455 +/- (4324.93, 

4.73774) 
37  I/sigma(I) = 376.732 +/- 4.30341 
38  Full width at half maximum (x,y) = (5.55258, 6.88398) +/- 

(0.0486711, 0.0397825) 
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39  Average direct beam results for IP 2 
40  Position (x,y) = (1500.92, 1509.61) +/- (0.266244, 0.175193) 
41  Pixel Intensity = 10740.4 +/- 268.098 
42  Integrated Intensity, sigma(I) = 336789, 896.288 +/- (4495.92, 

3.81553) 
43  I/sigma(I) = 375.777 +/- 6.19005 
44  Full width at half maximum (x,y) = (5.57419, 6.89354) +/- 

(0.0479199, 0.0299656) 
 
45                    IP1                       IP2 
46  Cycle      x       y       I         x       y       I 
47  -----   -----------------------   ----------------------- 
48    1     1499.8, 1509.8 [ 10841]   1500.7, 1509.8 [ 10932] 
49    2     1499.4, 1509.6 [ 10346]   1501.3, 1509.4 [ 10267] 
50    3     1499.4, 1509.4 [  9872]   1501.0, 1509.7 [ 10826] 
51    4     1499.6, 1509.7 [ 11006]   1500.9, 1509.5 [ 10846] 
52    5     1500.0, 1509.5 [ 10600]   1500.7, 1509.6 [ 10831] 
 
Lines 5-31 ASCII text representation of the spot profile.  Each character represents the value of a 

pixel.  Pixel values are on a 0-35 scale (0 is represented by ., 10-35 are represented by 
A-Z).  Pixel closest to the center of the spot is represented by a +. 

Line 15 For R-AXIS systems, the IP number and cycle number are listed.  For CCD systems, a 
description of the type of CCD is listed. 

Lines 16-17 The position of the center of the spot and the value of the pixel closest to the center are 
listed. 

Lines 18-19 The integrated intensity, I, σ(I), and I/σ(I) for the peak are listed. 
Lines 20-21 The width of the peak, at the 3σ level and at half of the maximum value of the peak are 

listed. 
Lines 33-38 For R-AXIS systems, the results for IP1, averaged over all of the cycles.  For CCD 

systems, these lines do not appear in the file. 
Lines 39-44 For R-AXIS systems, the results for IP2, averaged over all of the cycles.  For CCD 

systems, these lines do not appear in the file. 
Lines 48-52 For R-AXIS systems, the direct beam positions and pixel value tabulated for each IP and 

cycle.  For CCD systems, these lines do not appear in the file. 
 

Important:  If either X-beam or Y-beam position differ from IP1 or IP2, this will be corrected at the 
time of data collection using the values from the direct beam shots.  If the values of either X-beam 
position differs on the same IP between cycles, the adjustments may be needed for the IP belt itself. 
 

A summary of the typical summary file DirectBeamSummary.log generated by the direct beam 
shot utility is shown below. 
 
1  Direct Beam Utility 
2  Number of cycles: 1 
3  Exposure time: 1.0 seconds 
4  Date: Thu Sep 30 17:34:19 1999 
 
5  Average direct beam position for IP1 = (2682.6,1505.9) 
6  Average direct beam position for IP2 = (2683.5,1505.5) 
 
7                    IP1                       IP2 
8  Cycle      x       y       I         x       y       I 
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9  -----   -----------------------   ----------------------- 
10    1     2682.6, 1505.9 [  7090]   2683.5, 1505.5 [  7209] 
 
11  Direct Beam Utility 
12  Number of cycles: 2 
13  Exposure time: 1.0 seconds 
14  Date: Tue Oct 19 11:02:31 1999 
 
15  Average direct beam position for IP1 = (1505.1,1506.6) 
16  Average direct beam position for IP2 = (1507.1,1506.7) 
 
17                    IP1                       IP2 
18  Cycle      x       y       I         x       y       I 
19  -----   -----------------------   ----------------------- 
20    1     1504.2, 1507.0 [241280]   1506.2, 1506.8 [247008] 
21    2     1506.1, 1506.3 [ 14490]   1508.0, 1506.7 [ 14340] 
 
22  … 
 
23  Direct Beam Utility 
24  Number of cycles: 5 
25  Exposure time: 1.0 seconds 
26  Date: Thu Mar 30 16:56:17 2000 
 
27  Average direct beam position for IP1 = (1499.6,1509.6) 
28  Average direct beam position for IP2 = (1500.9,1509.6) 
 
29                    IP1                       IP2 
30  Cycle      x       y       I         x       y       I 
31  -----   -----------------------   ----------------------- 
32    1     1499.8, 1509.8 [ 10841]   1500.7, 1509.8 [ 10932] 
33    2     1499.4, 1509.6 [ 10346]   1501.3, 1509.4 [ 10267] 
34    3     1499.4, 1509.4 [  9872]   1501.0, 1509.7 [ 10826] 
35    4     1499.6, 1509.7 [ 11006]   1500.9, 1509.5 [ 10846] 
36    5     1500.0, 1509.5 [ 10600]   1500.7, 1509.6 [ 10831] 
 
Lines 1-10 Summary of direct beam shots taken on 30 September 1999 
Lines 11-21 Summary of direct beam shots taken on 19 October 1999 
Lines 23-36 Summary of direct beam shots taken on 30 March 2000 
 

Important:  If either X-beam or Y-beam position differ from IP1 or IP2, this will be corrected at the 
time of data collection using the values from the direct beam shots.  If the values of either X-beam 
position differs on the same IP between cycles, the adjustments may be needed for the IP belt itself 
 
 

PMTCheck Log 
 
A summary of the typical log file PMTCheck.log generated by the PMT check utility is shown below. 
 
1  PMT Check Utility Copyright (c) 1998,1999 Molecular Structure 

Corporation 
2  Date: Wed Apr 05 15:52:11 2000 
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3  Result of PMT Test: 
4                Average = 5.5770 
5                3*Sigma = 1.8184 
6     Number of 0 pixels = 0/252000 

 
Line 4:  The average background counts in the image. 
Line 5:   The 3σ level of the background. 
Line 6:  The number of pixels in the image with a value of 0. 
 
A summary of the typical log file PMTCheckSummary.log generated by the PMT check utility is 
shown below. 
 
1  PMT Check Utility  
2  Date: Wed Jan 05 12:21:51 2000 
 
3  Result of PMT Test: 
4                Average = 6.354 
5                3*Sigma = 1.623 
6     Number of 0 pixels = 0/252000 

 
 
7  PMT Check Utility  
8  Date: Wed Apr 05 15:52:11 2000 
 
9  Result of PMT Test: 
10                Average = 5.5770 
11                3*Sigma = 1.8184 
12     Number of 0 pixels = 0/252000 

 
Lines 1-6: Results of the PMT check run on 05 Jan 2000. 
Lines 7-12: Results of the PMT check run on 05 April 2000. 
 
 

Continuous IP Read Log 
 
A summary of the typical log file ContinuousIPRead.log generated by the PMT check utility is 
shown below. 
 
1  Continuous IP Read Utility Copyright (c) 1998 Molecular Structure 

Corporation 
2  Date: Thu Feb 10 12:19:01 2000 
 
3  Continuous IP Read test[1/100] => OK Error count = 0 
4  Continuous IP Read test[2/100] => OK Error count = 0 
5  Continuous IP Read test[3/100] => OK Error count = 0 
6  Continuous IP Read test[4/100] => OK Error count = 0 
 
… 
 
7  Continuous IP Read test[100/100] => OK Error count = 0 
 
8  Results of Continuous IP Read test: 
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9     Number of     Read      Write      Other      Total 
10      Cycles     Failures   Failures   Failures   Failures 
11        100           0          0          0          0 
 
Lines 3-7: Success/Failure results of the IP reads. 
Lines 8-11: Summary of the number of cycles performed and the number and types of errors 

encountered. 
 
A summary of the typical log file ContinuousIPReadSummary.log generated by the PMT check 
utility is shown below. 
 
1  Continuous IP Read Utility 
2  Date: Thu Oct 07 11:51:04 1999 
 
3  Results of Continuous IP Read test: 
4     Number of     Read      Write      Other      Total 
5      Cycles     Failures   Failures   Failures   Failures 
6          5           1          0          0          0 
 
 
7  Continuous IP Read Utility 
8  Date: Thu Feb 10 12:19:01 2000 
 
9  Results of Continuous IP Read test: 
10     Number of     Read      Write      Other      Total 
11      Cycles     Failures   Failures   Failures   Failures 
12        100           0          0          0          0 
 
Lines 1-6: Summary of the IP reads done on 07 October 1999. 
Lines 7-12: Summary of the IP reads done on 10 February 2000. 
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Appendix D:  Troubleshooting 
 
This section covers a few common problems that you may encounter in CrystalClear, how you can solve 
those problems. 
 

General CrystalClear Problems 

Problem Solution 
CrystalClear does not 
communicate correctly with the 
X-ray detector on a Windows 
95 machine.  

CrystalClear uses Windows Sockets to communicate with the X-ray 
detector and with compute server modules.  While Windows NT 
includes the Windows Sockets module, Windows 95 does not.  Install 
the Winsock module, WS295SDK.EXE, which is located in the 
CrystalClear directory. 

Make sure the detector is set up correctly.  

When I start CrystalClear, only 
the menus are displayed.  I do 
not see a full CrystalClear 
window – only the task bar. 

CrystalClear was closed while it was minimized.  After logging into 
CrystalClear and selecting the project/sample, right-click CrystalClear 
on the task bar and select Maximize .  Close CrystalClear while it is 
maximized.  Open CrystalClear and log in.  Now you can reshape the 
CrystalClear window. 

You attempt to select a 
processing algorithm, such as 
d*TREK, PROCESS, or 
TwinSolve, and you receive the 
following message: "You must 
have a sample open to set 
processing algorithms." 

You must have a sample open before you can select a processing 
algorithm.  Click File > Open Sample  from the menu to select a 
sample, or File > New Sample  to create a new sample.  

The TwinSolve button is grayed 
out on the Toolbar. 

TwinSolve is only available with the Mercury CCD. 

You wish to process data, but 
the selections on the flow bar do 
not include processing options.  

You have a Collection task selected. From the Task drop down, select 
a task that includes processing, such as the Process task.  

The settings shown in a dialog 
have reverted back to the 
defaults, instead of to settings 
you specified in a previous 
session.  

Your previous settings were not saved.  Specify the desired settings, 
then click the Save button on the dialog.  Specify the location to save 
the settings to, and click OK.  

CrystalClear takes a long time 
to respond, then an error 
message occurs saying that 
CrystalClear cannot get a 
response from the RAXIS.  

If you are not actually connected to an X-ray detector, you should 
make sure CrystalClear is set in Simulator mode.  Click Tools > 
Preferences, then click the Server tab.  Check the detector in the list to 
force CrystalClear to run in Simulator mode.  

When you attempt a step that 
requires communication with 
the CCD Camera, CrystalClear 

Open system.configuration, which is found in the CrystalClear 
directory, and change the value of "DaemonIP" to be the IP address of 
the computer on which the Rigaku Daemon is running. 9 This solution 
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hangs. applies if MSCServDetCCD.exe or MSCServDetCCD_Simulator.exe 
is started before the hang occurs.   

You installed CrystalClear 1.2 
over a 1.1 version, and now 
your user list is empty.  

Your data is not removed when you uninstall or reinstall, so you can 
just recreate the users in CrystalClear, making sure you use the same 
names as the previous version. 

In the User Settings screen for each user, specify the path to the user's 
directory in the Data field.  

You receive an error when 
attempting to run CrystalClear:  

"A required DLL file 
WS2_32.DLL was not found." 

This error will occur on Windows 95 machines if Winsock has not 
been installed. The Winsock installation file is included in this 
installation. To install Winsock2, go to the CrystalClear directory after 
this installation (usually c:\Program Files\Rigaku  MSC\CrystalClear) 
and run WS295SDK.EXE. This will copy the Winsock setup files to 
your hard drive.  

Next, run the Winsock setup by going to the Winsock directory 
(usually c:\ws295sdk\setup) and run Ws2setup.exe. 

 
 
 
Crypto-Box Messages 

Problem Solution 
Crypto-Box Error 8: no dongle 
found. 

The CrystalClear Crypto-Box dongle was not found.  Install the 
dongle and try again.  

Crypto-Box Error 30: Error, the 
attached Crypto-Box did not 
come from MSC. 

A Crypto-Box was found but it was not issued by MSC.  The dongle 
that came with CrystalClear should be installed on the PC on which 
CrystalClear is installed.  

Crypto-Box Error 31: Error, 
registration key in the registry 
and registration key in the 
Crypto-Box do not match. 

Normally this is caused when CrystalClear was installed with an 
incorrect license number. In this case, reinstall CrystalClear and input 
the correct license number during installation.  

This error can also occur if a non-CrystalClear Crypto-Box dongle is 
found on the PC, but the CrystalClear dongle was not.  In this case, 
install the CrystalClear Crypto-Box and Crypto-Serv software on the 
PC, then click the Check Again button.  
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Appendix E: Absorption in Scaling 
 
CrystalClear provides a number of options for the modeling of absorption, crystal decay and incident beam intensity 
drift. These are all modeled within the absorption correction algorithms provided in the Scaling and Averaging step. 

 
The goal of the absorption correction algorithm is to deduce an absorption surface associated with a 
crystal by requiring that this surface minimize the difference in intensities between symmetry related 
reflections.  In practice, this is done by minimizing the weighted differences between the right and left-
hand sides of the equation: 

        (1) 

 
where I’s are the intensities and A’s are the absorbances.  The right hand side represents a sum over the k 
symmetry related intensities in a group of equivalent reflections, and the subscript i represents any 
member in the group.  One seeks to find an absorbance Ai to minimize this difference and Aj

0 represents 
an initial estimate of the absorbance.  As implemented in the program the initial A0 values correspond to 
that of the spherical crystal; when a new absorption surface is obtained, these replace the original A0 
values and the process is repeated until convergence is obtained. 
 
The absorbance A consist of a product of the absorbance of the primary beam and the absorbance of the 
scattered beam, i.e. 
 

          (2)  
 
These absorbances could also be expanded in a Taylor series, 
 

          (3) 
 
If the usual approximation is made of assuming that the higher order contributions are negligible, then by 
a least squares approach, the ∆pj values can be calculated and the whole process repeated until 
convergence is obtained. We assume the absorption surface is smoothly varying in reciprocal space. In 
order to enforce this powerful constraint two sets of analytical functions are used. 
 
Spherical harmonics1 are one convenient set of analytic functions for As. The maximum order is 
limited to 8, four even term and four odd terms:  

          (4) 

                                                 
1 Blessing, R. H. (1995). Acta Cryst. A51, 33-38. 
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where alm represents the coefficients to be determined by refinement and ylm are the corresponding 
spherical harmonics, and ϕ and υ are the equatorial and azimuthal angles of the diffracted x-ray beam, 
respectively.  
 
An alternate analytic function employs a Fourier series to represent absorbance:2    

          (5)  
 
Here the coefficients Pnm and Qnm are fit via a least squares procedure. The maximum values of n and m 
are 8 and 4, respectively. In this case of the Fourier method both the primary (or incident) and scattered 
beams are modeled.  
 
In addition to absorption, the apparent intensity of the primary or incident beam may be affected by 
decay, beam in homogeneity and source instability.  CrystalClear provides two methods for modeling 
these effects, simple batch scaling, which is applicable to either the spherical harmonics and Fourier 
methods, and circular harmonics, which applicable to only with only the spherical harmonics.  
 
In the batch scaling method the data are first scanned to find the batch with the greatest overlap. This 
batch becomes the reference batch and the absorbances described in Equation 3 are allowed to vary with 
respect to the reference batch. That is, the derivatives ∂A/∂pj are zero unless j corresponds to a batch and 
the reference batch. 
 
Alternatively, if the azimuthal angle in equation 4 is fixed at 0, the spherical harmonics collapse into the 
equatorial plane becoming circular harmonics and the resulting function A(f,0) can be used to model 
incident beam absorption3.   
 
CrystalClear provides nine options for scaling and absorption correction. The options are found in the 

Scaling and Averaging Dialog and are described in Table 1. The option “4th 3D + 4th 2D” appears to be 
the most robust and effective for small molecule data. However, “Fourier and batch” is the best method 
for macromolecule data. The preceding statements are generalizations. If one method does not provide the 
results you were expecting try one of the other methods. You will find this useful in special cases. 
 
Fitting the absorption surface using spherical harmonic coefficients or Fourier coefficients  via singular 
value decomposition4 is very robust and, in most cases, will lead to a satisfactory result. However, there 
are some cases in which error messages are displayed. Use the troubleshooting tips in Table 2 to guide 
yourself through these problem cases. 

                                                 
2 Walker, N. & Stuart, D. (1983).  Acta Cryst. A39, 158.  
3 Jacobson, R. A., private communication. 
4 Press, W. H., Flannery, B. P., Teukolsky, S. A., Vetterling, W. T., Numerical Recipes in C: The Art of Scientific 
Computing, Cambridge University Press, Cambridge, 1991, pps. 60-72. 
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Table 1. Absorption options 
Fourier This option uses Fourier coefficients to model diffracted beam 

absorption and simple batch scaling to model incident beam absorption, 
decay, etc. 

4th 3D + 3rd 2D This option uses 4th order even and odd spherical harmonics to describe 
the diffracted beam absorption and 3rd order even and odd circular 
harmonics to model incident beam absorption. 

3rd 3D + 2nd 2D This option uses 3rd order even and odd spherical harmonics to describe 
the diffracted beam absorption and 2nd order even and odd circular 
harmonics to model incident beam absorption 

 
Table 2. Absorption correction trouble shooting guide. 
Error Message Cause and remedy 
Number of outliers exceeds 
2000 

1. The assumed symmetry is too high. Use “Data analysis -> 
Laue Group” to automatically determine the Laue group and 
rerun. 

2. The sample is a strong absorber, µR > 2. In the Advanced 
Menu set outlier rejection criterion to 500 or 1000. This will 
ensure reflections that are strongly affected by absorption will 
be used in the calculation of the surface improving the overall 
correction. 

3. The crystal is split and some reflections overlap and some do 
not. Try to find a better crystal. 

No convergence in SVDCMP 1. The redundancy is low. If the sample is triclinic try to collect 
at least one scan of 180º. If the sample is of higher symmetry 
collect more data in a different region of f  or ?.  

2. The diffraction data are poor. The algorithms significant data 
to calculate the absorption surface reliably and there are not 
enough to do this. Recollect the data with longer exposure 
times. 

Spherical harmonics methods 
do not complete 
S Del**2 > 106 
 
 

1. Multiple scans have different exposure times. You may be able 
to recover by repeated runs of “Fourier”.  

2. The crystal died or fell off, the generator went down, etc. 
Inspect your images to determine if diffraction stopped at 
some definite point in time and reintegrate up to that point. 

3. The assumed symmetry is too high. Change the putative space 
group. 

Fourier methods do not 
complete. 
 S Del**2 > 106 

1. Multiple scans have different exposure times. Recovery 
unlikely. 

2. The crystal died or fell off, the generator went down, etc. 
Inspect your images to determine if diffraction stopped at 
some definite point in time and reintegrate up to that point. 

3. The assumed symmetry is too high. Change the putative space 
group 
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Appendix F: Defaults in CrystalClear 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
New Sample Defaults 
 
When a new sample is created, the defaults are obtained from the project under which it is created. 
Example : When sample Zn_13 was created, a copy of the defaults from project Zn was made and 
assigned to Zn_13. 
 
Inherited Defaults 
 
When the user saves defaults at the project level, the changes are not automatically reflected in other, 
existing samples in the project.  However, any new samples created will reflect the changes. Example : If 
the user changes defaults in Zn_13 and then saves to the project level, Zn_cub will not be modified as a 
result.  Thus: Zn_13 = Zn ≠ Zn_cub.  If the user creates a new sample Zn_14, its defaults will be 
identical to Zn.  Thus: Zn_13 = Zn_14 = Zn ≠ Zn_cub. 
 
When the user saves defaults at all levels, the defaults are only immediately reflected in objects residing 
in a direct line from the sample currently open to the site level. Example : If the user changes defaults in 
May22a and then saves to all levels, the defaults will be reflected in the following databases: 
 

• May22a (Sample) 
• May22 (Project) 
• mdavis (User) 
• Site 

 
The new defaults are not immediately reflected in any other object.  May22b, Myo1, sgrapelli, 
… all remain the same.  If a new user cparker is then added it will receive its new user defaults from 

Site Level 

User Level 

Project Level 

Site 

pwoods mdavis sgrapelli 

Zn Myo1 May22 Cyt 

Zn_13 Zn_cub 

Myo1_3 

May22a May22b Cyt_try1 

Sample Level 
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the site level.  However, if pwoods adds a new project Abt it will not reflect the site-level changes 
because new projects obtain their defaults from the user level, and pwoods does not yet reflect the site-
level changes. 
 
Updating Defaults 
 
One difficulty is that the user may want changes to the site level reflected in all other users.  The way to 
do this is to have each user log in and open a sample.  They should then load the site-level defaults and 
save defaults to the user level. Example : mdavis changes May22b and saves defaults to all levels.  If 
pwoods then logs onto CrystalClear and opens sample Zn_13.  She then loads the site-level defaults 
into the sample, and then saves defaults to the project and user level.  Now any new project she makes 
will inherit the defaults she just saves at the user level.  In addition, any new sample she creates (unless it 
is created in some already existing project that isn’t Zn) will have these new defaults. 
 
Note: CrystalClear 1.2.x allows only the administrator to save defaults at the user and site levels.  
CrystalClear 1.3 allows any user to save up to the user level.  Administrator privileges are required only 
for saving at the site level. 
 
 
 
Dialog Defaults 
 

 RAXIS Jupiter Mercury 
Setup 
Crystal To Detector 
Distance 

120 80 50 

2-theta 0 0 0 
Crystal 1 unit cell 80 90 100 90 90 90 80 90 100 90 90 90 10 10 10 90 90 90 
Crystal size 0.2 0.2 0.2 0.2 0.2 0.2 0.2 0.2 0.2 
Mosaicity 0.6 0.6 0.6 
Color Colorless Colorless Colorless 
Mount Loop Loop Fiber 
Morphology Prism Prism Prism 
Crystal 2 Unknown Unknown Unknown 
Orientation 0 0 0 0 0 0 0 0 0 
Detector Translation 0 0 120 0 0 120 0 0 50 
Rotations 0 0 0 0 0 0 0 0 0 
X-ray Source 50kV 100mA 50kV 100mA 50mV 40mA 
 Copper 1.5418 Copper 1.5418 Molybdenum 

0.71073 
Source Rotating anode Rotating anode Sealed Tube 
Optics Confocal Confocal Graphite 

monochromator 
Focus 0.3 0.3 1.0 
Collimator 0.3 0.3 0.5 
Initial images 
Images 1 scan of 2 images at 1 scan of 2 images at 4 scans of 1 image at 
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0, 90 degrees 0, 90 degrees 0, 30, 60, 90 degrees 
Readout Full frames   
Exposure 2 min/image 2 min/image 5 sec/image 
Pixel resolution 100 um pixel 2x2 binned 2x2 binned 
Find 
Images First image of screen 1-2 of screen 1-4 of screen 
   1-100 if already 

collected 
I/sigma level 3 sigma 3 sigma 3 sigma 
Min pixel 50 50 20 
Peak filter 6 6 6 
Box 0 0 0 0 0 0 
2D/3D 2D 2D 3D 
Resolution 0 0  0 0 0 0 
Index 
Known cell?  Unknown Unknown Unknown 
User chooses solution Yes yes yes 
Reflection file  dtfind.ref dtfind.ref dtfind.ref 
Max residual 3 3 3 
Indexing method 1D FFT 1D FFT 1D FFT 
Refine 
Resolution limits 0 0 0 0 0 0 
Cycles 100 100 100 
 I/sig 0 0 4 
Rejection limits 1 1 2 1 1 2 1 1 2 
Macro All all All 
Predict 
Images First image of first 

scan, screen images 
unless collect images 
are available  

1-10 of collected 
images 

1-10 of collected 
images 

Mosaicity 0.6 unless refined 0.6 unless refined 0.6 unless refined 
Strategy 
Per cent 
completeness 

99   

Resolution 0 0   
Speed Very fast   
Result Limit 360   
Search Rotation 0 360   
Collect 
Exposure time 2 min RAXISIV++ 

4 min RAXIS IV 
8 min RAXIS II 

10-20 sec, sample 
dependant 

20-30 sec, sample 
dependant 

Pixel resolution 100 um pixel 2x2 binned 2x2 binned 
Readout Full   
Integration 
Images All collection images All collection images All collection images 
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Images per batch 4 4 10 
Padding 1 1 2 
Pre-refinement 5 5 5 
Resolution 0 0 0 0  0 0 
Box 0 0, user sets 0 0, user sets 0 0, user sets 
Refinement macro All All All 
Peak radius min/max 3/0 3/0 2/0 
Laue  
Reflection file  dtprofit.ref Dtprofit.ref dtintegrate.ref 
Residual 0.15 0.15 0.15 
Centricity 
Reflection file  dtprofit.ref Dtprofit.ref dtintegrate.ref 
Spacegroup    
Reflection file  dtprofit.ref Dtprofit.ref dtintegrate.ref 
I/sig 4 4 10 
Scale and Average 
Reflection file  dtprofit.ref dtprofit.ref dtintegrate.ref 
Algorithms Batch, absorption Batch, absorption Batch, absorption 
Absorption Spherical 4,3 Spherical 4,3 Spherical 4,3 
Exclude sigma 3 3 3 
Error model mul Auto-intelligent Auto-intelligent 2.5 
Addend Auto-Rmerge Auto-Rmerge Auto-Rmerge 
Rejection sigma 50 50 10 
Chi square Max fraction 0.0075 Max fraction 0.0075 Max fraction 0.0075 
Scale anomalous No No No 
Optional output Output anomalous Output anomalous Uncorrected, 

unaveraged 
Output name   F2plus.dat 
Resolution 0 0  0 0  0 0 
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Using the Default Manager 
 
The Default Manager dialog allows you to save at the User Level, Project Level, or Sample Level.  
Using Default Manager also allows you to make information available to other samples or all projects, in 
other projects and samples.  Site Level settings are inherited by all users for each project and sample, as 
they are created. Only users with “administrator”’ privileges are authorized to save at Site Levels .  For 
most users, this option is grayed-out.   
 

• To access “administrator” privileges, exit CrystalClear and log in as an administrator. 
• If a user wishes to access the Site Level, “administrator” privileges may be assigned” in the 

User Settings dialog .  
 
For more information, see Edit User Settings on page 145 of Appendix B:  Administration. 

 
1. When the Default Manager dialog appears, select the Current Levels  you wish to save by clicking 

the appropriate check box. 
 

• Alternatively, selections can be made by clicking the radio-button beside the appropriate Site, 
User, Project, or Sample names (on right side of dialog). 

 

  
 

2. Use the following buttons for assistance in setting defaults: 
 

• Set   Sets a default 
• Unset   Unsets a default 
• Set All Sets all Levels 
• Unset All   Unsets all Levels 
 

3. When appropriate Levels  are selected, click OK.  
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Appendix G: Crystallographic Troubleshooting 
 
 
This section covers a few common crystallographic problems that you may encounter in CrystalClear, 
and how you may solve those problems. 
 

Problem Solution 
The crystal to detector distance 
is not editable…it states “Per 
Scan” 

In this sample there are images with different crystal to detector 
distances.  Try looking in the Scan State Display for information 
relative to each scan. 

I started a sample as a Process 
task and the crystal to detector 
distance shows “0”. 

You collected the data without setting the crystal to detector distance 
in the software for addition into the header.  If you know what the 
distance is, edit the field in the Setup dialog and continue.  If you do 
not know what the true crystal to detector distance is, try: 
1.  In an image display window, turn on the arcs tool and play with the 
crystal to detector distance in the image information area.  The arcs 
will change size and shape relative to this (and the 2-theta angle).  See 
if you can line up a ring (ice, salt, etc.).  Then take these numbers to 
the Setup dialog and edit the fields. 
2.  Set a best guess in the crystal to detector distance field in Setup and 
try to index.  The closer you are to the read crystal to detector distance 
(or any geometric parameter), the lower the residual of the correct 
lattice.  This may be quite a bit of work.  If no solutions pop out after 
many attempts, Find Peaks off 2 (or more) images in the same scan 
separated by nearly 90 degrees and use difference vectors in indexing. 
3.  If the lattice is uncertain, but the detector parameters are 
remembered vaguely, try indexing and using the triclinic cell for 
refinement…then reindex to see if the higher symmetry cell is 
determined. 

How do I change the resolution 
ranges for all steps in 
processing 

Anywhere there are Resolution Limits fields and a “Set” box, select 
the box and choose the processing steps to use the resolution limits 
currently in the edit fields and press “OK”. 

You have no idea what the cell 
lengths may be. 

In an image display window zoom in on an area where spots are 
regularly spaced.  Turn on the measure tool by selecting the ruler icon. 
Touch on one spot and drag to an adjacent spot. The inter-spot distance 
will be displayed as you drag. 

The red plus sign is not in the 
beam stop shadow 

You are collecting images with an improper direct beam position and 
should contact your administrator to redo direct beam shots 

I got the “Find Spots Failed” 
message and the log file shows 
“...reading image lys0001.osc... 
Error opening file lys0001.osc 
Error is: -2” 

The image is not there or is corrupted.  Wait for the image read to 
finish. 

Find only found a few spots. 1. Decrease the I/sigma 
2. Widen the resolution range 
3. Decrease the minimum pixel value 
4. Decrease the peak filter. 

Find Spots found too many 
reflections. 

1. Slide the number of spots slide in the image information window 
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reflections. 2. Use the delete spots icon to delete spots. 
3. Set the I/sigma higher in Find Spots 

There are lots of spots very 
close to each other. 

Increase the box size.  

Indexing is incorrect based on 
the measure tool distances. 

1. Check that the crystal to detector distance, X and Y beam positions, 
wavelength, and 2-theta angle are correct. 
2. Indexing may be correct if there is additional symmetry…continue 
on to prediction for varification. 
3. If the peak shapes are poor, then try raising the I/sigma level to 
avoid the weaker peaks.  Additionally, this will likely force the larger 
twin portion to index. 
4. If the cells are all much too large, including the triclinic, set the 
maximum cell in the indexing to a smaller value (about 2x that of the 
closest spot separation for starters). 

I don’t see all the crystal lattices 
in the table of indexed lattices 

Set the maximum residual in the advanced tab of index to 100. 

The software keeps choosing 
the wrong lattice in indexing 

Use the “User Chooses Solution” option in index.  Upon completion, 
choose the lattice from the list.  If all the lattices are not displayed, 
increase the maximum residual. 

Few of the reflections are 
included during refine. 

Adjust the resolution limits, I/sigma, and rejection limits. 

The “test mosaicity” is greyed 
out 

You are using “Reflection List” to “Refine on”.  Set this to “Images” 
and edit the “To Use” field.  A range of images must be used for this 
refinement. 

There is no reflection file list in 
the refine dialog 

You are using “images” to “Refine on”.  Set this to “Reflection List” 

All of the option boxes are 
greyed out in the refine dialog 

You are using the “All” macro.  Select “Single Step Refine” to toggle 
on/off individual parameters. 

There are more/less spots than 
prediction circles on my 
predicted image. 

In the Predict Spots dialog increase/decrease the mosaicity and predict 
again.  Or, you may have the wrong cell and need to reindex. 

The predictions are terribly 
wrong and I wish to start from 
scratch with the images again 

Open the Processing State Display, go to the State History, press the 
down arrow, scroll to the bottom, select one of the earlier states (like 
“1. Setup” or “2. Find Run”) and “Set as current” 

Refinement seems to have 
stopped during integration. 

Try increasing the number of images per batch.  

I don’t want to refine mosaicity 
during integration. 

Return to the refine dialog, set a value in the mosaicity field, and un-
check the mosaicity box.  Go back to integration and restart. 

Can I get rid of ice rings during 
integration? 

Sure.  Go to the advanced tab of Integrate Reflections and Add/Delete 
rings to the list (avoided area in integration). 

Integration keeps stopping 
when it finishes all the images 
on disk at the time and I want it 
to wait for the images to appear. 

Adjust the wait limit in the Advanced tab of Integrate Reflections.  If 
an image is not on disk when integration gets to that image, it will 
query the disk every 15 seconds until it either finds the image 
(integrates and looks for the next image) or reaches the end of the wait 
limit (completes integration with the reflections it has to that point) 

What should I do if Laue shows 
that I integrated the data in the 
wrong crystal system. 

Here you will need to think about what it is showing you.  In general, 
if the symmetry during integration is higher than merited by Laue, then 
you should consider reintegrating.  If the symmetry is higher than that 
for integration, it is recommended that you reintegrate, but you may 
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still have good data which is usable for a first reflection file. 
I need to have a different format 
for my reflection file. 

In the CCP4 suite there is a conversion program to convert to mtz 
format from the d*TREK format. 
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